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1 Introduction

 

Welcome to the DESS Help System

 

This help system is designed to help you understand the basics of using DESS.

This manual contains 6 different sections, each of which contains a particular type of information:

The Introduction -This section. This section contains information about how to get started in DESS,
and an overview of the program. We strongly suggest that if you have not used DESS before you
read through the two articles in this section first, (The Big Picture and Getting Started).

DESS and Essex Energy - This contains information on DESS, its new features as well as registration
directions and contact information for Essex Energy.

Quick Reference - This section describes important terms and definitions in DESS and describes the
DESS interface.

User's Guide - This describes the basic concepts behind DESS so you have a better understanding of
how to use the software.

How To - This section contains a series of tutorials designed to assist in completing various common
tasks.

Reference Guide - The reference guide describes each menu and toolbar command and provides
detailed help for each dialogue you will find in DESS.

 

Hint:
Whenever you see the friendly electron in an orange box, like this one, it is either a useful
comment or a time saving hint. It is usually a good idea to read these notices.

1.1 What is DESS?

What is DESS?

DESS (Distribution Engineering Simulation Software) is an integrated software package for the design,
analysis and management of electrical distribution systems. A full complement of analysis modules
provide the capability to analyze load flows, perform switching optimization, load balancing,
transformer loading and size optimization, and short circuit analyses.

DESS allows you to create a detailed computer model of your distribution system which can be used
for design and analysis. Given the configuration and loading for your system, you can use DESS to
optimize your system, determine structural weaknesses, and test the effects of new configurations and
system additions.

DESS is designed to allow open access to data and easy integration with your existing systems. If you
have relevant data in a database, CAD system, GIS system or SCADA system, it can be integrated with
DESS to provide automatic data entry/updating or real time information for analyses.
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DESS is extendable. The software exposes an open architecture that allows you to add or modify
functionality to meet your own specific needs.  With limited additional development you can add
functionality as varied as automatic data updating, trouble-call and outage reporting, and linked display
of CAD drawings and customer info.

1.2 Why Use DESS?

DESS can be used in a wide variety of engineering tasks ranging from planning to operations. It can be
used to solve problems for individual projects or can be integrated into the planning and operating
process. There are a number of primary goals for using DESS:

Understand Your System Better

By modeling your entire distribution system, you can gain a better understanding of the conditions
throughout the system and how your electrical system will respond to unexpected conditions.

Normally you have periodic information (often monthly) about the loads on a system, and regular
information about SCADA-enabled points, typically at substations. DESS can help fill in the rest of the
picture. The load flow analysis provides current flows at every branch, and voltages at every point in
the system.

You can also determine the state of protection coordination on your system; a job which is often left
until after bad coordination has triggered unexpected outages.

You can use DESS to simulate unusual conditions. Use the load flow to model what happens under
very high system loads. Simulate the loss of a feeder or of an entire station. Try different restoration
options and check for voltage problems or overloaded lines.

Reduce Losses

Increasingly, it's becoming important to consider not only the most reliable way to supply a system, but
also the most economic way. DESS allows you to calculate losses for different system configurations.
You can also use the Yearly Load Flow to calculate loss energy throughout a year.

The basic load flow allows you to compare system losses with different loading conditions, different
conductors, etc. DESS also includes a set of automatic tools to help you reduce losses. These include
Configuration Optimization, Capacitor Optimization, and Phase Balancing.

Plan for the Future

Use DESS to model future growth on your system. You can use the editing tools in DESS to add in new
loads, and use the Load Scaling tools to model changes in existing loads by feeder, by area or by
category of load. Once the projected changes have been made, use the load flow analysis to
determine the effect on feeder loading, voltages and losses.

You can also use DESS to plan major changes to your system. The addition of a new substation or a
new feeder is a very expensive project. DESS can give you detailed system information and system
losses for different possible options.

1.3 The Big Picture

DESS
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DESS (Distribution Engineering Simulation Software) is an integrated software package for the design,
analysis and management of electrical distribution systems.

Mathematical Model

Basically put, DESS is a mathematical representation of an electrical system. Each symbol and line
represents a wire or electrical item in a system. It is a computer managed model designed to be user-
friendly, yet as powerful as possible. It has all of the features required to accurately reflect any
distribution system which you would like to model.

DESS represents a system through points, or symbols, connected by lines. These points are called 
nodes. A node is a point of importance, usually an electrical item such as a switch, load or another
item, while a line is a single-line representation of a set of electrical conductors. A set of this data is
called a system. You can have as many of systems as you want, although the number of nodes
permitted in a single system is typically limited by the particular license for your copy of DESS.

A Simple Concept

Despite its complicated appearance, DESS is remarkably simple to use. You can make your system as
complicated or simple as you want, DESS simply provides the means to do so.

How Does DESS Represent A System?

Nodes Lines and Layers

Nodes are any points of importance in DESS such as a junction, a line end, or a piece of electrical
equipment. Electrical items such as switches, loads or transformers are called Elements and are listed
below, under Elements. Each node and line is contained on a particular electrical layer. All lines and
nodes on that layer have the same nominal voltage specified by that particular electrical layer.

A layer can be visualized as a flat two dimensional plane with a series of nodes on it. These points are
connected by lines. Different layers can be connected together electrically by power transformers. In
this way layers allow a system to represent the different voltages in a system, and at the same time
group all of the nodes and lines particular to one voltage. This allows DESS to implement many useful
functions and features regarding layers as groups of nodes and lines.
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Figure 1: Systems in DESS can be virtually represented by a series of connected two dimensional planes.
These flat planes are connected by power transformers. Power transformers are represented in this

picture by a dotted line connecting two different nodes. Each of these nodes exists on a different layer.

 

Connecting Nodes and Lines

DESS has several built in protections against making errors in your system. Many of these concern the
placement of nodes and lines. Nodes can be placed anywhere, but lines can only connect two different
nodes. Lines can have multiple vertices, and 'bend' at points but they can still only begin or end on a
node. This prevents your system from having any lines without an ending node, called hanging lines.

Elements

In DESS you can add elements to nodes. These represent important items in an electrical system. It is
through a use of these, combined with a knowledge of what nodes and lines are, and layers, that you
can create a model of an electrical system.

There are a few different Elements in DESS. A list is provided here, while a much more detailed
description of each element is provided in the User's Guide, under the Elements category.

The Elements available in DESS are:

Capacitor

Distribution Transformer

Load

Meter

Motor Generator

Power Transformer

Protection
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Reactor

Regulator

Source

Switch

These elements provide a wide range of options for system modeling, as each element added to a
system has its own parameters, with settings and properties appropriate to that particular element.

Summary

DESS is a computer created mathematical model of a system. This system is composed of nodes,
which can have elements added to them, all connected by lines. These nodes and lines are contained
on layers which are based on voltage. You can connect these layers together using power
transformers.

1.4 Registering & Updating DESS7

To use DESS you must have a valid license. The license determines how long you can use DESS for,
which analysis modules you can use, and the maximum size of system model you can edit.

When you first start DESS on a computer where DESS has never been installed you will be presented
with the licensing dialogue.

Upon first launching DESS you will be asked what configuration the program should be.

Standalone program will ask you for your single-use product key, which is generated by Essex
Energy.  This will license DESS with the purchased system limit and analysis modules.

A trial license will give you limited access to the program for a trial period. Please contact Essex
Energy to obtain a product key before the trial period runs out to continue using DESS.

Network clients will have a CopyMinder Network Server set up, which is monitored by the network



SmartMap14

© 2019 Essex Energy

administrator. Please contact Essex Energy if you have any issues.

 
 

UPDATES

Check for the latest DESS updates at: http://www.essexenergy.ca/dess/support.downloads.cfm

 

Hint:
It's easiest to copy and paste site codes and site keys between the dialogue and email. This
helps to avoid errors copying the codes. If you need to manually copy the codes remember
that the only characters that are used are the numbers 0-9 and letters A-F (there is no
letter 'o').

1.5 Getting Started

Loading the Sample System

Now that you know how DESS works, this section will provide directions on how to get a system of
your own up and running. A standard installation of DESS comes with a sample data system. You can
open this system using the File > Open System command. This system is called  'Sample
System.dss.xml', and is located in a Sample Data folder in your DESS install directory. Your DESS 7
install directory is by default located under C:\Program Files\DESS 7, however it may be located
elsewhere depending on what you selected when installing DESS 7.

You can use this sample system to learn how to use DESS. It is suggested however, that you make
copies of the sample system if you intend to save any changes that you might make.

 

Importing A Pre-Existing System From Another Format

If you already have data for your electrical system in another electronic format, it is usually possible
(and certainly desirable) to import this data directly into DESS rather than manually creating it using
the editing tools in DESS. Tools for converting data from other GIS, CAD and mapping systems are
available from Essex Energy, and some GIS vendors and third parties. There is often an additional cost
for these tools. Some examples of other systems which have been used to populate DESS models
includes GIS systems from ESRI, Intergraph and CableCAD and data from AutoCAD and Bentley CAD
systems. Please contact Essex Energy if you have data you would like to transfer to DESS. Our contact
information can be found under About Essex Energy in the help system.

 

Creating A Completely New System

Creating a new system is quite easy. Actually populating all of the nodes and lines in a system by
manual editing is typically quite painstaking and awkward, especially for large systems. Nevertheless,
this section will walk you through the steps required to create a system from scratch in order to give
you a better understanding of the data requirements and dependencies in DESS.

To create a new system simply select File > New System. Once you have done this a dialogue will
appear called System Properties. This dialogue (shown below) allows you to set the labels for different
phases, and the units of measurement to use for x and y coordinates on your system. These
coordinates do not represent the preferred unit for entering line lengths, but instead represent the

http://www.essexenergy.ca/dess/support.downloads.cfm
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actual units used for map coordinates. The choice of coordinate is usually dictated by the units used in
any street or background maps being used. Note that you can change these at any time by going to 
Edit > System Properties which opens the same dialogue, and allows you to edit those properties.

The System Properties Dialog

 

Electrical Layers

Once you have chosen these values, you can proceed to actually start modeling a system. In order to
do this you will first need to set up some layers. You cannot create nodes or lines unless they have an
electrical layer to be added to, so you must create at least one. To do this click on the lightning bolt
icon on the top of the docking window, in the layers tab. This will bring up a window where you can
set the properties of the electrical layer you have just created.

You must set the type of layer (three or four wire) and the nominal voltage. The nominal voltage is
important because all nodes created while that layer is the active layer will be created with that
voltage.

Before you can do anything in your new system you must make sure that a layer is your active layer.
The very first time that you create a layer in DESS, it does not select an active layer. You must do this
manually. To do this either use drop down list box in the far right of the toolbar, or right click on a
layer and select 'Set as Active Layer'. Any new nodes and lines which are created will be created on
that layer, with that voltage.
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Electrical Layer Properties

To learn more about layers and their properties you may want to reference the Layers section in Users
Guide > Layers, and How To > Layer Properties in this manual.

 

Background Layers

Once you have created an electrical layer, you may wish to add a background layer. Background layers
are 'dumb' maps, which merely provide a reference point for creating a system. Background layers are
not essential, or necessary, but without a background layer you have no reference point with which to
work.

Typical background layers are used to display street maps or land parcels. In some cases a
background map may be used to display a CAD picture of an electrical network so it can be manually
over-traced to create a system in DESS.

Background Layer Properties Dialog

To add a background layer click the 'world' icon in the docking window. This will create a new
background layer. A dialogue will appear where you can browse for a background file. DESS supports
the following types of map files:

TAB - MapInfo TAB format files

DXF - AutoCAD text interchange format

SHP - ESRI shape file

Reference Data
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Reference Data is required for many basic items in DESS such as lines and loads. You can create your
own reference data or import it from another system. This is covered in more detail in How To >
Tools > Modifying References, and in Users Guide > Reference Data. Once you have created or
imported some reference data, you can start to model your system.

Finished!

You are finished preparing your system! You can now start to actually place nodes, lines and elements
onto your new system. The tutorials in the How to section of this help system will help you with any
further concerns about basic usage of DESS.

 

1.6 What's New in DESS 7

For users of previous versions of DESS, version 7 introduces a number of changes which will make
your life easier and help make you more productive. The most important changes are described
below:

Interface Changes
DESS 7 has a new and improved user interface and a whole new look. Among the most prevalent
changes, DESS 7 uses a file ribbon instead of the traditional file drop drop downs present in DESS 6.
The ribbon is split into three different tabs, File, Editing and Analysis.  There is a globe button above
the ribbon for updating options, checking licensing and about the product, and exiting.

A new universal search tool has been created. This allows users to search all nodes or a category of
elements using almost any filter criteria. 

Data Changes
After running an analysis on the system,  the user may choose to save the results of the analysis to a
file or copy the information to the clipboard. The file types supported are XML, CSV, TXT, and HTML.
The user may choose to save the results for the whole system or the currently selected items.

DESS 7 allows users to model low voltage layers. With the addition of a Meter element, users can now
add meter layers and connect meters to distribution transformers to model actual loading conditions.

Reports
Reports in DESS 7 are displayed in a pop up window instead of the default browser as in DESS 6.
There are more graphical capabilities with these reports, and all of the information can be exported to
a .CSV file.

Single Line Diagrams
DESS 7 has the ability to produce single line diagrams from the system model. Users can choose which
items to include in the single line diagram, and then DESS 7 uses the system model to produce a
diagram. The single line can be manipulated by the user or left in its original configuration without
concern for items being pulled out of order as DESS 7 ensures that things are connected properly.
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1.7 About Essex Energy

Essex Energy is a dynamic company focused on spearheading a vast array of energy related initiatives.
With the passing of the Green Energy Act, Essex Energy is primed to move these initiatives forward by
offering a full suite of Energy Related products and services including renewable energy systems,
distributed generation opportunities and a variety of software and consulting solutions.

 

Generation Connection Consulting

Essex Energy has more than 50 MW of generation connection experience across a broad range of
technological sources.

 

Generation Economic Analysis

Essex Energy has the expertise and databases in place to provide detailed economic analysis of any
type of generator in the Ontario market; both wholesale and retail.

 

Energy Service Consulting

Essex Energy has a broad, innovative and knowledgeable staff that is able to bring unique energy
related solutions to all participants of the energy market whether it be standby, peak-saving
generation, demand response opportunities and more.

DESS

DESS is a suite of software analysis tools to help you design and run your electrical distribution system
more effectively.

Conservation

Conservation is a key factor in securing our future for a reliable, sustainable, and affordable energy
supply. At Essex Energy we are proud to help deliver several programs that are geared towards
helping our customers to make a difference from their homes, offices, and schools.

 
 
Essex Energy Corporation
2199 Blackacre, Suite 2
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Oldcastle, Ontario
N0R 1L0

Phone:
(519) 946-2000
Toll Free: 
1-888-66-Essex
Fax: 
(519) 776-9888
Email: 
info@essexenergy.ca
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2 Quick Reference

This chapter provides a quick reference to using DESS, including key definitions and parts of the DESS
application.

Concepts and Definitions - A table of important terms and definitions used by DESS.

Windows Components - Illustrates the various components of the DESS interface.

2.1 Concepts and Definitions

The following terms have a specific meaning in DESS. Understanding these terms will make it easier to
use DESS and understand all of the information in this help system.

Term Description

System A system is the entity in DESS that contains a set of data for a distribution system.
Every node, line, and element in DESS is a part of a system.
Each system is stored in a separate file (usually with a .dss.xml extension).

Layers Every system contains one or more layers. There are two types of layers in DESS:
background layers and electrical layers

Background
Layers

Background layers are 'dumb' maps that may contain land parcels, roads, poles,
customer information, annotations or any other information which might be useful for
helping to locate or clarify your electrical system. They are displayed behind the
electrical layers.

Electrical
Layers

Electrical layers contain data for all equipment at a particular voltage level (e.g.
12.47kV). An electrical data contain nodes, lines and elements representing facilities
at that voltage.

Node A node is a point of interest on an electrical network which belongs to a particular
electrical layer. Nodes must be defined:

At the end of a line
At line junctions
When a conductor changes (e.g. underground - overhead)
Wherever elements (e.g. transformers, loads, and switches) are defined

Nodes and lines (in conjunction with switches) define the connectivity of a system. All
electrical equipment and loads on the system are modeled as elements attached to
nodes.

Line Lines are representations of the physical conductors that make up a distribution
network, i.e. feeders, branches and spurs.
Lines:

Begin and end at nodes
Cannot have nodes attached to them except at end points
Have a consistent conductor type and phasing
Belong to a particular electrical layer



Quick Reference 21

© 2019 Essex Energy

Term Description

Load
Modeling

Load modeling describes the data used to represent load changes under different
conditions. The load modeling in DESS allows you to model changes over the course
of a day, a week and a season. It also allows you to model sub-components of a load
and model load changes with changing temperatures.

Element Elements represent the electrical equipment (switches, capacitors, etc) and loading
(loads, motors) on a network. Elements are always attached to nodes. In some cases,
more than one element can exist on a node. The following types of elements are
defined in DESS.

Source
Source elements represent points of external supply to an electrical system. To be
valid, a system must have at least one source. Typically a source is defined at each
transmission substation or external feeder supplying the system.

Capacitor
This element represents a single capacitor or a bank of capacitors. You can define
fixed, time-switched or automatically regulated capacitors.

Distribution Transformer
This type of transformer represents the typical pad-mount or pole mounted
transformer found throughout a distribution system. It is similar to a power
transformer but is not modeled in as much detail. Use this type of element when you
are attaching a load, but do not want to model the secondary in detail.

Load
An element representing a load on the system. This is probably the most common
type of element used throughout a distribution system model.

Meter
The meter is used to represent an actual customer. It can have all of a customer's
information on it, and be used to track actual loading conditions on transformers.

Motor/Generator
This type of element is used to represent the following: 

a synchronous generator
a synchronous motor
an induction generator
an induction motor

Regulator
A voltage regulator. Regulation is based on the voltage at the node and can be set to
manual or automatic regulation.

Switch
This element represents anything than can be opened and closed to change the flow
of electricity. This can include a wide range of devices such as switches, elbows,
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Term Description

jumpers and fuses.

Power Transformer
A transformer that transforms power between two different electrical layers. This
element spans  nodes (each on a different layer) and is used to provide electrical
connectivity between higher and lower voltage layers. These are used at substations
or when modeling the secondary supply to individual customers in detail. They can
model either step-up or step-down transformers.

Protection
These elements represent any type of protective device that has a time-current
characteristic, such as a fuse, relay or recloser. Many devices such as a breaker
would be represented by a switch element and a protection element.

Region The section of a system supplied from a single source is referred to as a region.  A
region will contain nodes and lines at one or more voltage levels. As you open and
close switches between sources the boundaries of the neighboring regions will
change.

Reference
Data

Frequently used data, such as conductor types or load types, are stored as reference
data items so that you do not have to re-enter all the properties each time you use
this data. This data forms a library of standard types that you can use in your system.
The following types of data are stored in reference data files:

Protection Types
This represents the base definitions for the time-current curves for protective devices
such as relays, fuses, etc.

Conductors
A conductor reference item contains information about the electrical characteristics of
a conductor such as impedance, capacitance, ampacity, etc. It also allows you to
describe the material and usage.

Transformers
A transformer reference defines the impedances and losses for transformers used in
distribution transformer elements.

Week Types
This defines parts of a week. Usually used to define reference items for weekday and
weekend. This is used as part of the load modeling definitions. Load categories use
week types to define the effective period for load curves, etc.

Season Types
This type of reference data item defines parts of a year, such as spring or summer.
This is used to define the period for a load element and as part of the load modeling
definitions used by load categories.

Load Components
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Term Description

Components are used to represent a sub-definition of a type of load, such as cooking,
air conditioning, incandescent lighting, etc.

Load Categories
This type of reference data item represents a specific type of load (such as
residential, commercial, etc.). Load categories are referenced by load elements.

Theme A set of rules defining the appearance of nodes and/or lines in the system. There is a
default theme defining the appearance of nodes and lines. Most results have one or
more themes available to help display result values.

2.2 Window Components

The following diagram shows the DESS interface and its main components:

Globe
The globe contains information about the program and options to control the program. Each of these is
described thoroughly in the Reference Guide.
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Ribbon

All the essential commands are on this bar and are described thoroughly in the Reference Guide. 

Map View

The map view pane is the focus of your work. It includes background layers containing streets, land
base, etc., and electrical layers which contain all the nodes, lines and elements that are in your
system.

Docking Windows

The docking window allows the user to quickly access specific types of data. Standard dock windows
include Layers (for managing/editing layers), References (for managing/editing Reference Data Items),
and  Selected(for showing a list of selected nodes and lines). The top right corner of the docking
window contains an auto-hide button, enabling it to either stay open or to automatically retract to the
side of the window unless the mouse stays over the window.
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Legend

The legend only ever appears after you have applied a theme to your results. It helps you to
understand the results of an Analysis. You can toggle the appearance of the legend in the Themes
Menu. 

Status Bar

The status bar displays a more detailed description of commands, position information for the mouse
pointer on the map (in x and y coordinates, or latitude / longitude), the current zoom level (displayed
as Width), and a progress bar during long operations.
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2.3 User's Guide

The User's Guide describes how to use DESS, including entering data, running queries and using
analyses and viewing and understanding the results. The User's Guide contains the following sections:

Systems

This section describes DESS system data and explains how to open and save data and how to view
system properties.

Electrical Layers and Background Layers

Describes the difference between electrical and background layers. How to create and delete layers
and set layer properties.

Lines and Nodes

This section explains node and line data and describes how to create and edit nodes and lines. It also
describes how to control the default appearance of nodes and lines by setting style rules

Elements

This section describes different types of node elements defined in DESS, such as loads, transformers,
switches, etc, and how to create, edit and delete elements.

Reference Data

This section explains what reference data is, the different types of reference data, and how to create,
import, edit and delete reference data items.

Load Modeling

This describes how DESS represents customer loads and explains how you can use this to accurately
represent how your loads respond under different times and conditions.

Analysis

This section explains the different types of analysis available in DESS and how to use them.

2.3.1 Systems

This Section contains all of the information pertaining to a system model in DESS, including:

System Basics

Where to Start HV Modeling

Where to Stop LV Modeling

System Data Storage

2.3.1.1 System Basics

A DESS system represents a complete model of an electrical distribution system and is stored as a
single file (usually with a .dss.xml extension). A typical DESS system represents all the medium and
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low voltage supplies, lines, transformers and equipment for a complete distribution system and may
include equipment at one or more voltages. Before entering data for a system it's wise to decide
where you will start and stop modeling your system.

Basic properties of a system include display names for the phases and the internal coordinate system
used for mapping. The System Properties dialogue contains these settings.

2.3.1.2 Where to Start HV Modeling

Your DESS model begins at a node with a source element. This represents a 3-phase constant voltage
supply for your electrical system, sometimes called an infinite bus or swing bus. You must have at
least one source element in your system model. You will need to decide at which point to start
modeling your system. The best choice is to model only as much as is necessary in order to let you
perform the analysis you need.

In many cases, you can start modeling by creating a source representing the low voltage busbar of a
transmission substation. You then only need to model the feeders coming out of the station and the
rest of the distribution system. For example, consider a DESN substation with two 110kV/27kV
transformers and 8 feeders. As long as all feeders were supplied at the same bus voltage you could
create a single source at 27kV and connect all 8 feeders to it. You model would only contain electrical
layers for 27kV and lower.

In some cases you may wish to model the transmission substation. You would normally only do this if
you are interested in the details of the transformer operation (such as substation transformer losses or
tap changing voltage regulation). Using the example above  of the 110kV/27kV substation, you would
now need to add an extra electrical layer at 110kV containing two nodes (one for each transformer)
and add two power transformers and the extra nodes and lines required to represent the busbar
connections on the transformer secondaries.

In rare cases you may wish to model part of the supplying transmission system. You might do this if
the transmission supply voltage cannot be considered constant and fluctuates due to load conditions on
the distribution system. In this case, you would model a few extra lines on the transmission system
and put the source element at the end of these.

2.3.1.3 Where to Stop LV Modeling

Your model will contain equipment for all primary distribution voltages using an electrical layer in DESS
for each voltage. Your system may represent the low voltage network (i.e. 110V or 220V), but it is not
always necessary to go to this detail. 

Distribution transformer elements are used to provide a simplified transformer model when the
secondary network is not modeled. If a node contains a distribution transformer and one or more load
elements, the loads are assumed to be connected to the transformer secondary. You can aggregate all
loads from the secondary (e.g. all residential customers attached to a single distribution transformer)
to a single load element. This lets you model load and transformer operation without explicitly having
to create another low voltage electrical layer and populate data for the low-voltage part of the
system. 

In some cases you may want to model the secondary network. This is beneficial when the secondary
network is extensive or interconnected (e.g. for 'European' designs of systems, or for city center
meshed networks). To do this you will need to create an extra electrical layer, marked as a meter
layer, for the secondary voltage. Instead of aggregating all secondary loads at the transformer, you
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can now model the actual loads spread throughout the secondary network by adding meter elements
to the secondary meter voltage layer.

2.3.1.4 System Data Storage

When you save a DESS system to a file it is stored in XML (usually with a .dss.xml extension). XML is
an open structured text format that uses tags (much like HTML) to identify the meaning of the data.
Because the data is in a text format and is more or less human-readable, it is possible to open an XML
file in Internet Explorer or Notepad and see the data.

The structure and tags used to define the XML data is specific to DESS . However, XML data can be
easily read by software and can be converted to other structures. This makes it easier to exchange
DESS data with other software and systems, such as GIS and SCADA.

Documentation for the structure of the DESS XML file is available from Essex Energy.

2.3.2 Nodes and Lines

Nodes and lines are the primary items of data in a DESS system network. In this section each is
described in detail.

If you understand the concept of nodes and lines, you will have a very good base of understanding to
work off of when using DESS.

2.3.2.1 Nodes

An electrical network in DESS is composed of lines and nodes. Nodes are sometimes called buses.
Nodes are points in the system, displayed in the map view, which are connected to each other with
lines. These points can be used merely to model junctions, or line ends, or can represent electrical
equipment or electrical loads. This equipment, and electrical loads, are represented by what is called 
elements which are data items attached to a node.  Nodes appear as point symbols in the system.
Nodes change their appearance according to a set of rules called Style Rules.

You must create a node for the following cases:

At the end of a line
At junctions where three or more lines meet
Whenever the type of line conductor changes
Wherever there are elements, such as loads, transformers, switches, etc.
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You need to create nodes in the correct locations before you can create any lines because lines can
only be created between two nodes. Likewise, if you delete a node, all lines attached to it will be
deleted. This prevents problems with connectivity by having 'hanging' lines. You can move nodes after
they are created to put them into the correct location.

If you try to create a new node on top of an existing line you will be given the option to split the line so
that the new node will end one of the lines and start the other.

If you add an element to a node it changes the symbol of the node to one corresponding to the
element added. The symbols associated with a node can be edited in Themes > Node Style Rules.

2.3.2.2 Lines

Lines in DESS represent a branch or section of the electrical network such as a feeder or spur. Each
line must start and end at a node and cannot be attached to nodes except at the ends. Each line has
properties for length, phasing and conductor type.

DESS uses a single-line representation so a line in DESS can represent either a 3-phase branch (with
or without a neutral) or a single phase section. The actual electrical characteristics of the conductor
are determined by the conductor used for the line.
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DESS automatically determines the direction of connectivity (i.e. which way to the source). It doesn't
matter whether you draw a line from node A to B or from B to A. As you change the status of switches
and make other changes, the connectivity of the DESS system will automatically be updated.

By default, the length of a new line is set to the measured distance on the map. This assumes you are
using a geographic land base for your mapping. You can check which coordinate system you are using
for you map in the system properties dialogue.

To create a schematic view of an electrical system you can override the default line length by using the
length property in the line properties dialogue.

2.3.2.3 Connectivity

Basic Network

The primary network connectivity in DESS consists of node points, which are connected by lines. The
electricity is supplied by a source element and flow on the lines is controlled by switch elements.
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Direction of Flow

The direction of flow on the system is determined dynamically by the arrangement of nodes, lines,
sources and switches. There is no need to explicitly specify the direction of flow. For this reason you
don't have to specify how lines are oriented, and you can create a line by drawing from node A to
node B or from B to A, it doesn't matter. Likewise, when you change the status of a switch (open to
closed or vice versa), no other actions are required because the software automatically retraces and
determines the new configuration.

Connectivity Across Layers

The basic network described above covers connectivity on a single electrical layer. To create
connectivity across voltages, a power transformer element is used. This represents a substation
transformer, or any transformer where the electrical layers on both sides of the transformer are
explicitly modeled.

Loops

DESS allows you to model networks with closed loops. Closing any open switch on a radial network
will create a closed loop. DESS takes account of these loops when computing analysis solutions for
short circuits and load flow based analyses.

Most distribution systems are fed radially, so it is a good idea to check for closed loops after entering
new system data. If closed loops exist in a system an informational warning will be generated before
analysis so you can be aware of any loop(s) and confirm that they should exist.

If a closed loop exists, the concept of upstream and downstream becomes ambiguous. so in a closed
loop DESS will arbitrarily break the loop at the furthest point from the source for purposes of tracing.

Complicated Connectivity Cases

Systems are normally arranged so that for a multiphase line power flows in the same direction in all
phases. However, it is possible to use single-phase switching, or partial-phase switch of a switch
element so that power on different phases ends up flowing in different directions within a single line
section. DESS will handle this case correctly, although tracing on such an arrangement can be
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confusing unless single-phase traces are used.

It is also possible to create a system where a 3-phase line breaks into 3 single-phase lines, which each
follow a separate path and then rejoin into a single 3-phase line again. Again, DESS handles the
performance of this case correctly.

2.3.2.4 Appearance

Appearance     

Under the broad title of Themes there are two concepts involved, Styles and Themes. Both of these
topics involve the appearance of your system, more specifically the appearance of lines, labels and
nodes.

Styles and Style Rules

The node style of a particular node refers to it's appearance (e.g. a black triangle or a red circle).
Likewise, the line style of a line refers to its color, thickness and whether it is solid, dashed, etc.

 

A style rule is a set of conditions which determine the specific appearance of a node or a line. These
rules can be either very simple or more complicated. eg. all distribution transformers are red triangles,
or all 27kV single phase pad mount 50kVA distribution transformers are large black stars. You can
change these rules and add your own from the Default View sub-menu in the Analysis Tab of the
Ribbon.

The Line Styles Dialog. From this you can set the order of your styles as
well as create or delete styles.
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This is the dialog which appears after
the add button is clicked.

There are three different sets of Style Rules, those for nodes, those for lines, and those for text labels
(for either nodes or lines).

Styles for nodes and lines can each be set in the ribbon under Analysis > Views > Settings > Node
Style Rules or Analysis > Views > Settings > Line Style Rules. Styles for labels can  be set in Analysis
> Views > Settings > Label Style Rules. Each of these opens their respective styles dialogue. These
dialogs contain the settings for the basic themes and define how your system will appear.

Styles are evaluated in DESS in the order that they appear in the Styles dialogue, top to bottom. If a
node or line meets the criteria on the top of the list, then any further styles will not apply to it. In this
way you can make your own styles and rules and set their priority relative to the rest of the style rules.
You have complete control over the appearance of your system using the styles you set in the Node
Style Rules dialogue, Label Style Rules dialogue or the Line Style Rules dialogue.

Node Visibility can be set in the Layer Docking Window. Style rules set this way will override the
visibility rules set up in the Node Style Rules dialogue (size, zoom level, etc). To add a new rule, right
click on Node Types, and then click on Edit Types. A dialogue very similar to the Node Style Rules will
appear where visibilities can be manipulated.

Hint:

You can create rules which you do not always want to apply to a system. To activate them,
move them to the top of the style list, and move them down the list to the bottom when
you do not want them to show. Using this you can quickly identify certain groups of nodes
or lines with similar properties.

Warning:

After making changes to a set of style rules, once you click OK you can no longer undo
these changes using the Undo tool, so be careful.

Themes

Themes are simply a collection of node or line styles. Most themes are associated with the results of
an analysis which has just been run. These are accessed under the Globe menu. A different selection
of themes is available depending on which analysis has been run. DESS automatically comes with a set
of predefined themes for nodes and lines as well as preset themes for analyses which have been run.

These themes change the entire appearance, or a large portion of your system. Typically each of
these themes affects a particular type of information. eg. the Node Voltages and Line Loading each
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affect nodes and lines respectively.

You can set your options for the appearance of analysis from the Options dialogue. This can be
accessed from Globe > Options (dialogue appears) > Results > Themes.

This dialogue allows you to add, edit or remove styles from a particular theme. With this tool you can
get more out of your analysis results by setting the styles to levels, colors or symbols which are
meaningful to  you.

At any time you can select the Default Theme under the Themes menu to restore the system to its
default theme. This restores the appearance of the system to the values that have been set in the 
Node Styles or Line Styles dialogs, rather than a theme associated with analysis results.

 

After running a Annual Load Flow
analysis, the user has chosen to

change the theme to 'average node
voltages'
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This is the default DESS theme. It is
designed for general use. 'Default

Theme' restores your theme to this
one.

2.3.3 Layers

This section contains information regarding the Background Layers and Electrical Layers of the map. It
also contains information about the Active Layer and how to control Layer Visibility.

2.3.3.1 Electrical Layers

An electrical layer represents all the equipment in a distribution system at a given voltage level. An
electrical layer provides a home for nodes, lines and the elements attached to the nodes. You use
power transformer elements to connect electrical layers together so that the electrical connectivity
contains from higher voltages down to lower voltages (see Connecting Layers).

You need one electrical layer for each separate nominal voltage on your system. For example, if you
have a distribution system that is fed from a 110kV transmission system which contains equipment at
27kV and 8kV, you would have one electrical layer for the 27kV equipment and one for the 8kV
equipment. You may also have one more for the 110kV equipment, if you choose to model it, and
another for 220V LV equipment if need choose to model the LV.

You must create an electrical layer before you can add any nodes, lines or elements. Note that the
voltage of an electrical layer is the nominal voltage and not the actual supply voltage. You can set the
actual supply voltage using the source element.

Use the Layers tab of the docking window to add, delete and edit properties for electrical layers and to
change the layer visibility. More information regarding electrical layer properties is available in Layer
Properties in the How To Section of this help system.

One of the electrical layers is always set as the active layer for adding new nodes, new lines and
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region selections.

Hint:
All voltages in DESS are phase-phase voltages. So a 22kV electrical layer would contain
both 22kV (phase-phase) equipment and 12.7kV (phase-ground) single-phase equipment.

2.3.3.2 Meter Layer

A meter layer is a specialized electrical layer. When creating an electrical layer there is a check-box in
the upper right hand corner of the dialogue window which indicates that the electrical layer should be
designated as a meter layer.

Meter layers indicate to DESS that this electrical layer may be connected to the secondary side of a 
distribution transformer.

2.3.3.3 Background Layers

Background layers in DESS are used to represent 'dumb' maps such as street maps, land parcels or
text and annotations. These layers do not contain any DESS data but they are useful for showing
context for the electrical data. When viewing and editing your data it can be helpful to see streets and
landmarks. Background maps are always shown behind (or underneath) electrical layers.

Another use of background layers is during data entry. When entering data manually you can display a
dumb map of your electrical system (maybe created by a CAD system) as a background layer and then
trace over it to create data on electrical layers.

Use the Layers tab of the docking window to add, delete and edit properties for background layers and
to change the layer visibility. This is done using the Background Layers dialogue.

Map Data Formats

DESS can view maps stored in 3 common formats:
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TAB - MapInfo TAB format files

DXF - AutoCAD text interchange format

SHP - ESRI shape file

If you have maps in other formats (ie. AutoDesk DWG, Bentley, Intergraph, etc), it is usually possible to
convert this data to one of the listed formats. Please contact Essex Energy if you require assistance.

Hint:
If you are having trouble displaying a background map (in one of the listed formats), or the
map appears in a different location than your system data or another map layer, the
problem may be that the map is stored in a different coordinate system. Some examples of
coordinate systems are latitude/longitude (WGS 84), NAD83 (UTM), etc.

Open Street Map Backgrounds

DESS has the ability to use Open Street Maps as the background layer. This background map is
automatically updated with changing landscape and roads, and is maintained over the internet. To
enable it, open the Open Street Map Background dialogue.

2.3.3.4 Active Layer

In order to edit data, and to add nodes or lines, you must set the Active Layer. This layer is the
electrical layer where new nodes and new lines are added. It is also the layer used for rectangle and
polygon selections. The current active layer is the layer with the bold text on the Layers docking
window. Select a layer to make it the Active Layer.
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Hint:
If you are trying to create new nodes and lines, and you cannot connect the lines to the
existing system, the problem may be that you are actually creating the new items on the
wrong electrical layer. Check that the active layer is the same as for the nodes you are
trying to connect to.

2.3.3.5 Layer Visibility

You can adjust the properties of layers so that the visibility of each layer is controlled separately.
There are two different ways to control the visibility: the visibility setting and translucency.

Visibility

There are three settings for the visibility:

On - layer is always visible

Off - layer is never visible

Zoom - layer is visible when the width of the screen is within the desired range

You can use this setting to turn off electrical layers you are not currently interested in, and to make
background layers that only appear when the map is zoomed in. This can help improve redraw
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performance.

A common use of the Zoom settings is to adjust background layers so that detailed data (residential
streets, land parcels, etc) only appears when you are zoomed in and looking at a small section of
system, and that large-scale data (town boundaries, etc) only appear when you are zoomed out and
looking and the entire system.

Transparency

The properties for each layer also let you set the transparency of each layer. You can choose from a
continuous range from solid to invisible. Setting non-critical layers to be partially transparent can help
make key information stand out.

2.3.4 Elements

Elements in DESS represent electrical items located at a point. All plant items except nodes and lines
are represented as elements. All elements are attached to a single node (except for a power
transformer which is associated with 2 or 3 nodes).

Only certain types of element can coexist together on a single node. Sources, motor generators,
reactors and regulators must all be the only element on a node. Loads, distribution transformers and
capacitors can all exist together on a node. Switches and protective devices can also coexist.

Elements are usually added, edited and deleted from the Node dialogue.
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To add an element, you generally use the node dialog

The different types of elements are:

Capacitor - capacitor bank
Distribution Transformer - low

voltage transformer
Load - customer load, can be

detailed or simple
Meter - customer meters
Motor Generator - motor or

generator
Power Transformer - substation

transformer
Protection - protection device
Reactor - series reactor
Regulator - voltage regulator
Source - supply point (swing bus)
Switch - sectioning point

2.3.4.1 Capacitor Element

A capacitor element represents a capacitor bank and is attached to a node. You can specify the size of
the capacitors in kVAr for each phase and whether the bank is fixed or switched. If it is switched you
can specify how the bank is controlled (e.g. VAr control, voltage control, power factor control).

Capacitors are used to reduce the reactive load on the system. Reactive loads are created by customer
load at a low power factor and by the impedances of transformers and lines, which are primarily
reactive.

High reactive loads cause increased line losses (due to higher current flows) and reduced voltages at
the ends of feeders. They also cause a low system power factor which may not be acceptable to the
transmission system operator. Adding capacitors can help to reduce losses by reducing current flow,
and generally improves the voltage on a feeder. Too much capacitance can cause a leading power
factor (increasing losses) and unacceptably high voltages.

Creating in DESS
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You create capacitor elements from the Node dialogue. This will bring up the Capacitor Element
dialogue, described in the Reference Guide. A capacitor element can be put on the same node as a
distribution transformer or a load.

Controls

There are three basic ways to control when a capacitor bank is switched in. These are:

Fixed - the capacitor is always on
Time Switched - the capacitor is turned on at a specified hour, and off at another specified
hour. This assumes that the switch on/off time is the same every day.
Reactive Controlled - the capacitor is turned on or off depending on the reactive current (or it's
effect on voltage). This includes controlling by power factor, by absolute kVAr flow, or by
voltage.

2.3.4.2 Distribution Transformer Element

A distribution transformer represents a typical transformer used to supply customers and is used in
DESS where you do not have to model the lines and connections on the secondary side of the
transformer or would like to you can add a meter layer. The only information required for a
distribution transformer element is the type of transformer. Most of the technical parameters are
defined in the associated transformer reference data.

Most distribution systems contain a large number of distribution transformers to supply customers. In
North American designed systems, the number of transformers can be as high as one per 4 customers
(6-10 typical). In European systems, less transformers are used because of the more extensive and
higher voltage secondaries.

Distribution transformers contribute to the total system losses in two ways. First, series losses are
caused by losses in the windings and increase as the loading  of the transformer increases. Secondly,
magnetizing losses (sometimes called no-load or shunt losses) are caused by losses in the transformer
core and are virtually constant (they do vary slightly with voltage). You can use DESS to identify these
losses and try options for reducing them.

Creating in DESS

You create distribution transformers from the Node dialogue. This will bring up the Distribution
Transformer Element dialogue, described in the Reference Guide.  A distribution transformer element
can be put on the same node as load elements or capacitor elements. Before you create a distribution
transformer, the type of transformer you want to create must already exist in the reference data.

If you put a distribution transformer on the same node as a load element, the load is assumed to be
connected to the low voltage side of the transformer.

2.3.4.3 Load Element

Load elements in DESS represent customer loads. A load element lets you specify the magnitude of
the load for one or more periods of the year along with the load category. The load category (e.g.
residential,  commercial) contains the key parameters and curves which determine the electrical
characteristics of the load and how the load varies over the year.

A load on a node may represent the aggregation of multiple loads of a given type (e.g. the total load
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from a number of residential customers connected to the same transformer). If a distribution
transformer is defined on the same node as the load, the load element represents the aggregated load
from all customers (and secondary losses) attached to the low voltage side of the transformer.

You can have more than one load element on a node. Typically you would do this to represent
different types of load (such as residential and commercial) that might be connected to the same
transformer.

Creating in DESS

You create load elements from the Node dialogue. There can be simple or detailed loads, which are
slightly different and are described in the Reference Guide. A load can be put on the same node as
distribution transformer elements or capacitor elements. Before you create a load the appropriate data
for load modeling must be set up in the reference data.

If you put a distribution transformer on the same node as a load element, the load element is assumed
to be connected to the low voltage side of the transformer. If there is no transformer, the load is
connected at the line voltage.

2.3.4.4 Meter

The meter element represents a customer meter, which may or may not be downstream of a distribution
transformer. Meters and loads can be placed on the same node, so known load values can aggregate to
their respective transformers. Modeling meter elements enables a better secondary analysis, where
voltages can be looked at on each meter taking into account distances from the transformer, instead of
just the secondary side of a transformer. 

If the meter is not placed on an electrical layer designated a meter layer, it will not be able to be
connected to a distribution transformer.

Creating in DESS

You create distribution transformers from the Node dialogue. This will bring up the Meter Node Dialogue,
described in the Reference Guide.

2.3.4.5 Motor Generator Element

This type of element is used to represent 3-phase motors and generators. You can represent either
synchronous or induction machines.

Synchronous machines rotate at a speed determined by the system frequency. These machines tend
to be larger, such as generators used in hydro-electric or thermal generation plants or hooked up to
gas turbines. Synchronous machines can vary both the real power they output and the reactive power.
The VAr output of a synchronous generator can be used to support reactive loads and to support
voltage. Synchronous machines as modeled in DESS are assumed to have automatic voltage regulation
that adjusts the VAr output within machine limits to support a specified voltage setting at the generator
terminals.

Induction machines are generally smaller. Induction motors are the most common type of motor.
Induction generators are generally used for smaller installations and where there is no constant prime
driver, such as wind turbines. Induction machines consume reactive power (like most loads) whether
they are used as motors or generators.
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By carefully settings the parameters of generators in DESS you can also represent a range of non-
standard generators (such as wind turbines, photovoltaic, and other inverter based generation
technologies).

Creating in DESS

You create motor generator elements from the Node dialogue. This will bring up the Motor Generator
Element dialogue, described in the Reference Guide. They cannot be combined with any other type of
element.

2.3.4.6 Power Transformer Element

Power transformer elements represent transformers that connect a low and a high voltage network
two different electrical layers in DESS. If you don't need to explicitly represent the details of the
transformer use a distribution transformer element instead. A power transformer element typically
represents a substation transformer.

Power transformers are modeled in detail, including impedances, grounding, no-load losses and the
capability to model on-load voltage regulating tap changers.

You can model both two-winding transformers (e.g. 110kV / 13.8kV) and three-winding transformers
(e.g. 3 terminals such as 110kV / 66kV / 66kV) using this type of element.

Power transformers are used to connect layers in DESS so there is connectivity from one voltage to
another.

Creating in DESS

Power transformer elements can be created by first selecting the terminal nodes (2 nodes on different
layers for a normal two-winding transformer, or 3 nodes on 2 or 3 different layers for a three-winding
transformer). You can select more than one node at a time by holding down the CTRL key while you
click on a node. Then click on the Add Power Transformer button in the Editing tab of the ribbon to
create the new transformer. To edit the transformer data, bring up the Node dialogue for the high
voltage node of the transformer. This will bring up the Power Transformer Element dialogue,
described in detail in the Reference Guide.

2.3.4.7 Protection Element

Protection elements are used to represent devices that have time-current curves and are used for
protection. This includes fuses, relays, reclosers, etc. Protection elements are often associated with a 
switch element so that the device can be represented as openable.

Protection elements allow you to specify settings on protection devices defined in the protection
reference data. For example a protection element representing a relay would let you choose which
curve elements to use (e.g. extremely inverse and instantaneous) and set the CT ratio, tap and time
dial settings.

Creating in DESS

You create protection elements from the Node dialogue. This will bring up the Protection Element
dialogue, described in the Reference Guide. This is the only element that can exist on the same node
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as a switch.

2.3.4.8 Reactor Element

This type of DESS element represents a series reactor. These somewhat uncommon items are used to
add an impedance to a line, either to reduce voltage problems associated with high capacitances and
light loading (more typically at transmission level voltages), or to reduce fault levels.

Creating in DESS

You create reactor elements from the Node dialogue. This will bring up the Reactor Element dialogue,
described in the Reference Guide. Reactor elements cannot be combined with any other types of
element on a node. Because a reactor represent a series device, it can only be placed on a node
attached to exactly two lines. Putting it at a node with 3 or more lines would be ambiguous, and
putting it on a node with one line attached (i.e. end of a line) would be meaningless.

2.3.4.9 Regulator Element

Regulator elements are used to model voltage regulators (sometimes called line regulators). You can
model both manual regulation with a fixed tap setting, or automatic voltage regulation where the
regulator tap is automatically changed to maintain the desired voltage on the regulator secondary.

Creating in DESS

You create regulator elements from the Node dialogue. This will bring up the Regulator Element
dialogue, described in the Reference Guide. Regulator elements cannot be combined with any other
types of element on a node. A regulator represents a series device, it can only be placed on a node
attached to exactly two lines. Putting it at a node with 3 or more lines would be ambiguous, and
putting it on a node with one line attached (i.e. end of a line) would be meaningless.

2.3.4.10 Source Element

A source element represents a 3-phase supply to the system modeled in DESS. It is set as a constant
voltage source, which means that it supplies a specified voltage regardless of the load being fed from
it. In classical analysis, it would be a called a swing bus or an infinite bus.

Where you create a source element depends on where you want to start modeling a system. You
would  normally avoid modeling parts of the transmission supply system unless you have a specific
requirement to do so.

You must have at least one source element in your system. A typical distribution network contains
multiple supplies (either transmission substations or feeders fed from outside the network). For this
reason, most networks will contain more than one source. Sources can be created on more than one 
electrical layer.

Source elements let you specify the voltage, source impedances (representing impedance of the
transmission system) and voltage angle of the supply.

You can specify both upper and lower values of source impedances, which would represent the range
of impedances you could encounter depending on different supply conditions on the transmission
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system. The impedance information is used by the short circuit analysis.

Creating in DESS

You create source elements from the Node dialogue. This will bring up the Source Element dialogue,
described in the Reference Guide. Source elements cannot be combined with any other types of
element on a node. You may also want to see Converting Source Impedances, directly following this
article.

2.3.4.10.1  Converting Source Impedances

Source impedances can be stated in many different ways, but DESS requires that the values be input
as p.u. on 100 MVA base. You can use the following calculations to convert the values you have. A
number of common conversions are described below.

Note that when you are calculating an impedance from a fault current or a fault MVA you can only
compute a total impedance value. You do not have enough information to determine the X:R ratio for
the impedance. For this reason, it is preferable if the actual R and X values for the source impedances
can be obtained.

Converting from a Different MVA Base:

You can convert impedances from one base to another using the ratio of the MVA bases.

Example:

You have an impedance of .025 p.u. on a 10 MVA base.

Solution:

Z = .025 * 100 / 10 = .25 p.u. on 100 MVA base

 

Converting from Ohms:

You can convert from units of Ohms to per unit as follows:

Example:

You have an impedance of 0.5 + 3.1j Ohms on a 27600V system.

Solution:

Zbase = 27.6 * 27.6 / 100 = 7.6176 Ohms

Z = (0.5 + 3.1j) / Zbase = 0.0656 + 0.4069j p.u. on 100 MVA
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Calculating Z1  from a 3-phase Fault MVA:

You can calculate the positive sequence impedance of a source from the 3-phase fault MVA at the
source.

Example:

At the source location you have a fault level of 2400MVA

Solution:

Z1 = 100 / 2400 = .0417 p.u. on 100 MVA base

You can assume that resistances are much smaller than reactances (estimate 20:1 ratio) so:

X1~Z1 = .0417 p.u. on 100 MVA base, R1 = X1/20 = .002 p.u. on 100 MVA base

 

Calculating Z1  from 3 Phase Fault Current:

You can calculate the positive sequence impedance from the 3-phase fault current at the source. In the
following equation Sbase is in units of MVA, Vpp is in kV and Ifault is in units of kA.

Example:

At the source of a system, the voltage is 45100V and the 3-phase fault current is 8400A

Solution:

Z1 = 100 / 1.732 / 45.1 / 8.4 = .1524 p.u. on 100 MVA base

 

Calculating Z0  from Phase-Ground Fault Current:

You can calculate the zero sequence impedance from the phase-ground fault current at the source. In
the following equation Sbase in in units of MVA, Vpp is in kV, and Ifault is in units of kA.

Example:
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At the source the voltage is 45100V, the phase-ground current of a solidly grounded fault is 2900A,
and the positive sequence impedance is .1524 p.u. on 100 MVA.

Solution:

Z0 = 1.732 * 100 / 45.1 / 2.9 - .1524 - .1524 - 0 = 1.025 p.u. on 100 MVA base

2.3.4.11 Switch Element

A switch element is used to model a device which can be opened or closed and thus affect the 
connectivity of the system. Switch elements can be used to model lots of different types of real-world
equipment including:

fuses
reclosers
breakers
line switches
transformer elbows
disconnects
jumpers
anything else that can be opened or closed

Switches are typically fully open or fully closed. However, it is possible to partially open a switch to
model operations where only one or two phases of a three phase switch are operated.

Creating in DESS

You create switch elements from the Node dialogue. This will bring up the Switch Element dialogue,
described in the Reference Guide. The only element that can exist on the same node is a protection
element (if the switch is for a fuse, recloser, breaker, etc). Because a switch represent a series
device, it can only be placed on a node attached to exactly two lines. Putting it at a node with 3 or
more lines would be ambiguous. Putting it on a node with one line attached (i.e. end of a line) is
meaningless, but will not cause an error.

Cubicles, Vaults, Complicated Switching

A real electrical system may contain a single physical device which contains a number of
interconnected switches. In DESS you will need to decompose the compound device into an equivalent
circuit of simple nodes, switches and lines. For example a device containing four connections, each of
which can be attached or disconnected would be represented in DESS as a single central node
representing the bus attached to four surrounding nodes, each with a switch element.

2.3.5 Reference Data

Reference data items in DESS are used to create a 'library' containing the technical details of
commonly used items. These items represent both common plant items and items used for load
modeling.

You can view and edit reference data items from the reference docking panel. 
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Plant Items

Conductors
Transformers
Protection Types

Load Modeling Data

Week Types
Season Types
Load Components
Load Categories

2.3.5.1 Conductor Reference Data

Conductor data defines the electrical parameters and physical properties for a set of conductors.
Electrical parameters include sequence impedances, capacitive charging and ampacity. Physical
properties include material, description, location and cross-section.

The key parameters of a conductor are the positive and zero sequence impedances. These values
represent the self and mutual impedances for a group of conductors, whether is be a 3-phase 3-wire
bundle, a 3-phase 4-wire bundle or a single-phase 2-wire set of conductors.

The effect of a neutral conductor, whether the same size or different from the phase conductors, is
implicitly included in the sequence impedance values.

The Conductor Data dialogue is available in the Reference Guide section of this help manual.

2.3.5.2 Transformer Reference Data

This type of reference data describes a transformer used in a distribution transformer element.
Normally the bulk of transformers on a distribution system will be defined using this data.

This data contains descriptive parameters (such as location and description) and electrical parameters
such as impedance, connection type and taps.

The Transformer Reference Data dialogue is available in the Reference Guide section of this help
manual.

2.3.5.3 Week Type Reference Data

Week types are used to define a portion of a week for analysis purposes. Week types are part of the 
load modeling in DESS.

The only data for a week type is the days of the week it covers.

A typical system will define week types for full week (all days), weekend (Saturday, Sunday), and
weekday (Monday-Friday).

You can add more detailed types if you want to represent different load curves, components, or
characteristics in your load category data for a specific data. For example, an industrial customer who
shuts down on the weekend may have a different load profile on Monday and Friday to account for
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start up and shutdown. In this case, you could create 4 types: Weekend, Monday, Tuesday-Thursday,
and Friday.

The Week Type Reference Data dialogue is available in the Reference Guide section of this help
manual.

2.3.5.4 Season Type Reference Data

Season types are used to define a portion of a year for analysis purposes. Season types are part of
the load modeling in DESS.

Data for a season include the months of the year included in the season, plus values for average day
and night temperatures. The temperature values are used to compute the difference between normal
and actual temperatures for analysis, and affect the scaling of load categories which contain
temperature sensitive scaling factors.

A typical system will define season types for full year (all months) and for the four seasons (Spring,
Summer, Fall and Winter). This lets you define different load element data for each of the four
seasons. This data frequently comes as kWh values from a customer billing system.

If you have loads that vary distinctly on a monthly basis, you could potentially define season types for
each of the 12 months, and enter load data specifically for each of these months.

The Season Type Reference Data dialogue is available in the Reference Guide section of this help
manual.

2.3.5.5 Load Component Reference Data

Load components are a portion of a load represented by a load category. Load components have 
specific electrical characteristics and a defined load curve shape. They let you define a part of a load
category in more detail if you have available information. Typical load components for a residential
load category might represent items like lighting load, heating load, refrigeration load, etc. Load
components are part of the load modeling used in DESS.

Data for a load component includes the 24-hour load curve, along with the electrical characteristics of
the load, such as power factor, response to voltage, and cold load pickup characteristics.

The Load Component Reference Data dialogue is used to edit this data.

2.3.5.6 Load Category Reference Data

Load categories define the characteristics of a type of load in DESS, and contain the core data for load
modeling. Each load element in DESS references a load category. Typical load categories include
residential, commercial, and categories for specific industrial customers.

Load categories let you define different properties for loads for any combination of week types and
season types. This lets you define load variation over the course of a week and over the course of a
year. There are three types of properties you can define in a load category:

Load Curves

These are the 24 hour curves which show how load varies over a day. You can define just a real
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power curve, or both real and reactive power curves if you want to model variations in power factor
over a day.

Load Components

This optional data lets you specify sub-components of a load. For each period of interest you can
specify a set of components that are active. This can help to better specify certain load characteristics
and lets you model a load without that component active.

Load Characteristics

These items define the electrical characteristics of the load including power factor (if not defined by
real/reactive curves mentioned above), power response to voltage and re-energization factors.

The Load Category Reference Data dialogue is available in the Reference Guide section of this help
manual.

2.3.5.7 Protection Reference Data

This type of reference data is used to model the basic characteristics of types of protective devices.
For fixed non-settable devices such as fuses, this data defines the actual device characteristics. For
more complex devices such as relays and reclosers, the settings defined in the protection element
work in combination with this reference data to define the characteristics of a specific device on the
system.

The primary data for this element are the time-current curves of the device.

For fuses, there are two curves. One for the melt curve, and one for the clear curve.

For relays and reclosers, you can enter data for each protective curve element. For each of these, you
can enter either a series of curves for different settings or equations which define the set of curves.

The Protection Type Reference Data dialogue is available in the Reference Guide section of this help
manual.

2.3.6 Load Modeling

The actual behavior of a real customer load is very complex. Load modeling is the method used to
represent a customer load for analysis so that the real load variation can be approximated.

Without any load modeling, load values would need to be represented purely by kW and kVAr (and the
power-voltage relationship). These values would represent a single set of conditions of the system
(such as annual peak). Furthermore, these values would be difficult to obtain as they don't relate to
data that a distribution utility usually gathers.

DESS models loads by using load categories and load elements. Load elements contain data for the
magnitude of the load. The load category contains detailed information relating to electrical
characteristics and variation over time for the type of load.

For example a load for a transformer supplying houses in a subdivision could be represented by a load
element containing the kWh billing values for all attached customers for each season (the load
magnitude), and a 'Residential' load category which defines the load curves, power factor etc for
typical residential customers.
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Customizing Load Categories

By default, DESS is pre-programed with load categories that represent residential, commercial and
industrial customers. However, the default categories may not accurately represent conditions in your
system. This is especially true of industrial loads, which vary considerably depending on the type of
industry, the number of shifts worked, etc.

You can create your own load categories by collecting load curves for common types of customer. This
can come from a number of sources such as SCADA data (if you have a feeder supplying a
homogenous type of load), hand held digital meters, and 15-minute metered data for larger (typically
industrial) customers. The data you collect may also contain power factor information. Please contact
support at Essex Energy if you have questions about how to make use of different load data sources.

Simple vs Detailed Modeling

DESS allows you to model loads in great detail. For example, you can represent load changes from 
month to month, variations across every day of the week, consider both real and reactive load curves,
and use detailed modeling of load components. However, you do not have to model at this level of
detail. It is usually sufficient to model differences across four seasons, only consider weekday and
weekend differences, and load components can be ignored completely if you don't have the required
information.

2.3.7 Analysis

DESS provides a series of different types of analysis which can be used to help you plan and operate
your system.

The following Analysis can be run on your system and belong to the modules listed (each module is
available separately from Essex Energy).

 

Basic DESS Editor

Protection Coordination

Load Flow Module

Load Flow

Motor Starting

Annual Load Flow

Load Loss

SCADA Load Flow

Feeder Analysis Module

Capacitor Optimization.

Phase Balancing

Optimization Module

Open Point Optimization
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Short Circuit Module

General Short Circuit

Specific Short Circuit

2.3.7.1 Annual Load Flow

The annual load flow calculates the total energy provided and consumed (including losses) on a
system throughout the year. It works by calculating a series of load flows for each hour of the day for
each distinct type of week and season defined in the load modeling.

The results of the annual load flow give the total energy provided by the system (GWh), as well as
energy lost on lines and in transformers. For each node in the system it calculates the maximum,
minimum and average voltage, and for each line it calculates the maximum, minimum and average
current, loading and losses.

Voltage Ranges

The annual load flow can be useful in evaluating the voltage range (under high and light loading) you
can expect to see on different parts of the system. Large voltage changes under different loading
conditions can represent a weakness in the system, and is often associated with power quality issues
and difficulty backing up affected feeders in the event of an outage.

2.3.7.2 Arc Flash

The arc flash analysis is the a powerful tool for determining potential hazards in the field. Given the
system configuration and protection elements, it determines the fault and arc current, working distance,
incident energy, protection level and zone of protection.

When you run a load flow, you choose the node(s), voltage, maximum and minimum fault conditions, or
import these from the system directly. You can update the values for the equipment type and conductor
gap, and even select whether it is an open air or arc in a box situation. Keeping the model up to date with
the latest configuration and settings will ensure that the most accurate values are being calculated at all
times. It is simple to run an arc flash quickly before sending a crew out, so the crew can be constantly
informed of the current danger level.

2.3.7.3 Capacitor Optimization

The capacitor optimization helps you determine where to place capacitors on your system in order to
reduce losses and improve the voltage and power factor of specific feeders.

As parameters for the analysis, you specify the size of the banks you want to use and the maximum
number of banks you want to place.

You can choose to find the best location for banks across the entire system, or only on selected parts
of the system. Use the node selection tools in DESS to select either a feeder, a complete voltage layer,
or any area you want to limit capacitors placement to.

You can also choose whether you want to optimize capacitor placement for a specific condition (i.e.
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peak load), or to run a series of load flows representing loading throughout a full year and optimize
capacitors for energy savings throughout the seasons.

Switched Capacitors

If you choose to optimize capacitors for a full year, you have the choice of whether to use switched
capacitors. Switched capacitors are useful for two reasons. First, they can help improve the power
factor under heavy load conditions while avoiding a leading power factor under light conditions.
Secondly, they can help improve voltages under heavy loading while avoiding over-voltage conditions
under light loading. In practice, switched capacitors are usually most useful for controlling voltage
concerns.

Leading Power Factor

Load on a power system usually has a lagging power factor, meaning that loads require reactive
power support from the source (the exceptions being synchronous motors and generators). Adding
capacitors will reduce the amount of reactive power required from the source. If larger capacitors are
added, it may create a leading power factor in the area just upstream of the capacitor bank. For
example, a capacitor bank which is adequately sized to correct reactive flow at peak load, may
generate enough VArs to create a leading power factor under light load conditions. Generally this is
not a problem, as the reduced reactive flow will still be a net benefit due to higher reactive flows
further up the feeder.

Voltage Problems

When using capacitor banks it is important to be aware of the effect on system voltages. Capacitor
banks tend to increase voltages along a feeder. For long, weak feeders this voltage rise may be
unacceptable under light load conditions. A strong compact system (typical urban system) can more
easily accommodate capacitors without introducing voltage problems.

2.3.7.4 Load Flow

The load flow analysis is the most basic analysis for a power system. Given the system configuration
and the loading, it 'solves' the system and outputs the current flows and voltages at every point in the
system.

When you run a load flow, you choose the hour, day, month, temperature and scaling factor to use.
These  load modeling parameters affect the magnitude of the individual loads on the nodes. The effect
of changing hour and day type is dependent on the load curves defined in the load categories. The
effect of changing the month or season is affected both by the load curves defined for load categories
and for the season defined for the load elements.

The results include voltages at all nodes, current flow and loading on all lines, and losses and loads on
the system as a whole and on each region of the system.

Planning Comparison

A primary use of the load flow is to compare different options on your system. For example, consider if
you are planning to add a new customer to your system and there are two possible ways to supply the
load. You can run a load flow for each option and compare losses, voltages and feeder loading.
Likewise, you can evaluate potential system changes such as conductor sizing, the addition of
capacitors, etc.
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Load Forecasting

You can also use the load flow for forecasting. The best was to do this is to extend the current system
to represent predicted new loads and changes in existing loads. Expected new loads can be
represented as point loads (no need to model transformers or to represent each customer exactly).
Changes in existing customer loading can be modeled by using load scaling to change loads on each
category of load (e.g. increase residential load by 2%, reduce commercial load by 1%) or in specific
areas (e.g. increase load in new areas by 2%, keep older parts of a town the same).

2.3.7.5 Load Loss

The load loss analysis calculates the increased loss due to an incremental increase of load at a
specified node. You can use this analysis by selecting a particular node and choosing the Analysis >
Load Loss command.

The effect of adding additional load on the system depends not only on the size and location of the
load, but on how heavily the supply feeder is loaded. Additional load added to the end of an already
heavily loaded line will have a much larger effect on losses than load added near a substation to a
lightly loaded line.

The results of this analysis report incremental losses as a percentage, which represents the additional
real losses as a ratio of the load added. For example, a 3% incremental real loss represents increased
losses of 30W for every 1kW of additional load.

Cost Of Losses

In some regulatory environments it is possible to pass along the cost of losses to new customers
requesting connection to the grid. This analysis can help determine these costs, and the areas most
sensitive to adding new loads.

2.3.7.6 Motor Starting

The motor starting analysis shows the effect of starting a large motor on a system. The analysis works
by running two loads flows, one modeling the system without the motor operating, and the other
modeling the motor element under starting conditions (i.e. high starting current and low starting
power factor).

The results shows the voltage difference between the two conditions. This can help you determine if
voltage flicker will be a problem during motor starting. A voltage drop of more than about 3% will
create noticeable flicker in lighting.

In the analysis results you can also see the feeder currents and voltages under starting conditions.
Checking the currents can help you make sure that protection won't trip when starting a large motor.
Checking voltages will make sure that the voltages in the area of the motor are not reduced to such a
degree that the motor cannot start, or that other nearby equipment may be affected by the low
voltages.

2.3.7.7 Open Point Optimization

The optimization analysis finds changes to the system configuration in order to reduce losses. By
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changing the location of open points between feeders or between supplies, it is usually possible to
reduce line losses, sometimes significantly so. On a typical distribution system, series losses are
around 1-4% of the total power supplied to the system.

The analysis lets you choose whether to optimize existing switch locations only, or whether to perform
a complete optimization regardless of existing switches. If you choose a complete optimization, new
open points may be placed at locations where there is not currently a switch. This can provide slightly
improved loss reduction but at the cost of installing new switches.

Algorithms

There are two choices for optimization algorithm. The default hill climbing algorithm runs substantially
faster and in practice provides good results. It also allows you to specify a limited number of switch
changes to make. It will recommend the most important potential changes.

The simulated annealing algorithm runs substantially more slowly (may take hours on a large system),
but given a sufficiently high accuracy parameter it should theoretically provide the best overall
configuration. The drawback (besides the speed) is that this version of the analysis cannot prioritize
switch changes. It may recommend changes that have only a very small effect in practice.

Effects

Besides reducing losses, the optimization algorithm tends to flatten the voltage profile of a system, so
that the range of voltages along a feeder is reduced. For this reason, the optimization analysis is best
used before considering the use of capacitor banks.

2.3.7.8 Phase Balancing

The phase balancing analysis is designed to balance the load on parts of the system that contain
substantial numbers of single-phase loads and single-phase spurs. It works by finding the best
changes that can be made to a selected part of the system in order to reduce losses. Changes
considered include single phase transformers on three-phase lines and single-phase spurs attached to
two or three-phase lines.

Selected Items

You can choose which part of the system you want to consider changes to. If you are interested in
general system improvements, you may wish to find the best changes anywhere in the system.
Alternately, you can select a feeder and then find changes to just the loads and spurs on that feeder.

Spurs Between Feeders

Sometimes a single-phase spur will connect to more than one three-phase feeder and will contain one
or more open points so that part of the spur is supplied from one feeder while other parts are supplied
from one or more other feeders. The phase balancing analysis gives you the option of specifying
whether to allow the analysis to change one part of a spur without changing the phasing of the whole
spur. Allowing the analysis to do this gives the most flexibility but may result in a situation where
different phases are supplying each side of an open switch (an undesirable situation for operations/
safety).
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2.3.7.9 Protection Coordination

The protection coordination function of DESS is included as part of the basic package and allows you to
show coordination time-current curves for devices in the system. It lets you visually compare curves
for protective devices and to measure the time difference between them.

First, select a node and then click on the Analysis > Protection Coordination command. A time-current
graph will be displayed showing all upstream protective devices and their respective protective
response.

See information on Protection Element and Protection Reference Data for information on how to create
protective devices in your model.

To import protection items from another system, you can use the Tools > Import References tool.
DESS ships with a large set of curves defined for common fuses, reclosers and relays.

See the Protection Coordination dialogue for detailed information on viewing protective curves on a
light table using this analysis.

2.3.7.10 SCADA Load Flow

The SCADA load flow is a variation of a standard load flow which uses real measured data to improve
the accuracy of the load flow for individual feeders. A set of real measurement data, such as could be
obtained from a SCADA system, is used to dynamically scale loads on a feeder so that the resulting
current flows produced by the load flow match the values from the measured data.

For example, the standard load modeling used in DESS might calculate that the flow on a given feeder
is 160 amps. Real data might indicate that the flow is actually 175 amps. The SCADA load flow uses
the measured values to scale all the loads on the feeder until the resulting load flow results match the
measured data (175 amps).

The results of a SCADA load flow include all the normal results for a load flow, plus a report of the
size of the scaling factors used to modify the loads in DESS. When running the analysis you can set a
threshold value for load scaling. If a larger scaling factor is required than this threshold value, then the
measured data is ignored and only the standard DESS load data is used. This can help you identify
unrealistic data (either load data or measurement data).

The Tools > SCADA Measurement Data dialogue is used to enter or edit data for this analysis.

SCADA Data

Data for use in this analysis can be obtained as an export from a SCADA system, and is typically
available for substation feeders and sometimes from automated switches throughout the system. The
SCADA load flow can use all of this information, even where measurements are cascaded (i.e. one
measurement area includes another measurement area) or when measurement data is available in
mixed units (e.g. Amps, kW and kVAr, kVA).

Configuration

As with any analysis where you are comparing real and modeled data, it is important to ensure that
the system configuration used in DESS when running this analysis matches the configuration on the
system when the measured values were obtained. If this is not the case, erroneous scaling and results
will occur.
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2.3.7.11 Specific Short Circuit

The specific short circuit analysis is used to analyse a single fault condition on a specific node in detail.
The results include fault currents and voltages on the lines and nodes leading from the fault to all
sources of fault current.

This analysis is useful in determining how much fault current is contributed from different sources (i.e.
from looped supplies or from generators or motors on the system). The results for fault voltages due
to the fault also provide information to help determine whether undervoltage protection will trip due to
the fault.

The parameters for the analysis include:

phase - ground faults
phase - phase faults
phase - phase - ground faults
three phase faults
the phasing of the fault
any additional fault resistance (to simulate non-bolted faults)

2.3.7.11.1  General Short Circuit

The short circuit analysis helps you determine the system response to faults. This type of analysis is
required in order to ensure that equipment such as breakers and switches are rated for the maximum
fault current that may occur and that protective devices will operate for all fault conditions.

It will provide information for fault currents and fault impedances for a complete section of the system.
Results are provided for either the entire system or all nodes selected when the analysis is run.

Types of faults considered are:

phase - ground faults
phase - phase faults
phase - phase - ground faults
three phase faults

For each type of fault the results specify the expected current flows for a solidly grounded (worst-
case) fault.

2.3.7.12 Reports

In DESS, after you have run an analysis you have the option to view several reports. These reports
show data related to the analysis that has just most recently been run.

Each report is available through the Reports section on the Analysis tab in the ribbon. There is a
different set of reports available to view depending on which analysis was just run.

The reports are very intuitive and easy to use. Reports can be limited to the currently selected portion
of the system, or the whole. Most reports will have a summary of the analysis properties in a drop
down at the top of the report. This will summarize the analysis parameters and give a general
overview of the results.  Some reports will have graphics, while others will be a table of information.
The information tables have the ability to filter the information displayed by almost any criteria.

All reports have the ability to be exported to CSV.
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This is a power transformer results page after running a Load Flow analysis.

2.3.7.13 Results

After you have run an analysis in DESS, you have a set of results which contains the analysis output.
You can explore these results by using the tool tips on the nodes or lines, visually using node and line
themes and as text by using reports. You can save results in a variety of formats, and close them
when they are no longer needed.

Saving Results

The results can be saved for future reference, for export to a database or spreadsheet, or use in a
report. To save the results simple select Save Results from the File menu. This will bring up a dialogue
where you can select more specifically what you want to save the results as.
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You can select what information you need to save using this
dialog and what format to save it in.

The left list pane contains a list of formats which the results can be saved to. You can only select one
of these options. You can also select whether you want the information copied to file or to the
clipboard.

XML data is a popular format for exchange with other software. Tab and comma delimited text are
also useful for export to a database or spreadsheet. The HTML web page useful for viewing. If you
wish to copy result data to a spreadsheet, the easiest way to do so is to save the result data as Tab
Separated Text and Copy to Clipboard. You can then use the Paste function in your favorite
spreadsheet (e.g. Excel or Open Office).

If you currently have a section of your system selected before you use this tool, and you choose to
export line or node data then the bottom options will become available. You can have all of the nodes
or lines information exported or you could have only the area which is currently selected.

Close a Result

If you no longer need the result which is currently open in your system then you can close it, returning
your system to its normal state by using the command Analysis > Close Result. This will remove any
themes associated with the results and remove any extra tool tip information on the nodes and lines.
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3 How to

This section of the help manual is designed to help you perform common tasks related to DESS. The
articles are organized from basic features to more advanced. eg. zooming and panning will come
before checking for errors. In order, this section contains:

1. Zooming and Panning
2. Selecting
3. Tracing
4. Creating a Node
5. Creating a Line
6. Deleting Nodes and Lines
7. Moving a Node
8. Editing Node and Line Properties
9. Creating and Modifying Elements
10.Creating and Deleting Layers
11.Using Layer Properties
12.Moving Between Layers
13.Creating a Power Transformer
14.Undo and Redo
15.Using Tool Tips, Labels and the Legend
16.Editing Themes and Styles
17.Moving the Docking Window
18.Changing Switches
19.Finding Nodes
20.Editing Reference Data
21.Modifying References
22.Checking Your System For Errors

VIDEOS

How-to Videos are available online at: http://www.essexenergy.ca/dess/support.videos.cfm

3.1 Zooming and Panning

There are two primary tools which are used to change the map view. The first is Zooming and the
second is Panning.

At any time, you can fit the entire system back into your map view by going to File > View All.

Zooming

You can zoom in or out by either using a scroll wheel on your mouse, or by using the magnifying glass
icons on the Editing Tab.

When you Zoom In, the system will expand centered on where your mouse pointer is. This is useful if
you wish to look with more detail at a particular feature. When you Zoom Out, you will zoom out based

http://www.essexenergy.ca/dess/support.videos.cfm
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on the position of your mouse pointer, and the system will decrease in size.

As you experiment with these features you will find that you can also use the zoom tools to view a
different area of the map by zooming out from one area and then zooming in to another.

Panning

Panning is the movement of the entire system in a particular direction. If you select the select tool on
the toolbar, you can then click, hold, and drag the map around. If you drag the mouse to the right, the
entire map view will move right. When you release the mouse button the map will redraw, allowing
you to see a new section of the system. The same thing can be achieved when using a different tool
on the toolbar by clicking and holding the scroll wheel on the mouse. 

This does not re-size the map in any way, and does not modify any information. It only adjusts your
view so that it is easier to see your system.

 

Hint:
You can pan around the screen without the pan tool if your mouse has a middle button or a
scroll wheel. Simply click and hold the middle mouse button to pan around the screen as
per the pan tool.

3.2 Selecting

In DESS, selecting items is a critical skill. Selecting refers to using one of a variety of tools to cause a 
node or a line to be highlighted in red. These selected items are then available for certain utilities and
analyses to be used or run. Many items on the Tools menu are set to become operable when
something is selected. Nodes or lines can be only modified or analyzed using those commands when
they are selected. 

Nodes or lines highlighted in red are selected.

There are three general ways of selecting, but these are not the only ways to select. You can also
select through many other methods like tracing, finding nodes and custom selection, and many other
methods. This section is specifically dedicated to explaining how to use the three basic methods of
selection. These three tools are the Select tool, the Rectangle Select tool, and the Polygon Select tool.
These tools can be found on the tools section of the Editing tab.

Two other selection methods, Inverting selection and Custom selection are listed below the three basic
methods. These are slightly more complicated than the basic three selection tools. They are very
useful for a few specific jobs, and they are worth learning how to use because they can select things
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which would be otherwise impossible or very difficult with normal selection methods.

 

Overall Selection and Removing a Selection

Apart from the tools listed below, to select everything in a system you can use Editing > Query >
Select All from the ribbon.

To deselect anything that is currently selected, use any one of the three basic selection tools listed
below and click (or double-click) on a blank section of map.

 

Select Tool

This is the most common tool that is used in DESS, and this is always the tool which is selected by
default whenever you start DESS.

In order to use this tool it must be activated by clicking on the icon on the toolbar. By clicking on a
single node or line you can select it.

Note that if you select another node or line the original node or line will become unselected. This
means that normally, only one node or line can be selected at a time with this tool.

However, by holding the Ctrl key you can select multiple nodes and lines together. As soon as you push
the Ctrl key a small black '+' sign will appear. When this '+' sign is visible, all nodes or lines that you
select will be selected in addition to any currently selected nodes or lines.

Like the '+' sign, there is also a '-' sign which appears when you hold the Shift key. When you click on
a selected node or line while holding Shift the node or line will become unselected.

This Select tool can select any node or line, regardless of which layer the item which is being selected
is located on.

You can select more than one node or line at a time
with the Select tool by holding the Ctrl key.

 

Rectangle Select Tool
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The Rectangle Select Tool acts much like the Select Tool, except that instead of clicking on a node or
line to select it, you draw a rectangle around any items you want selected. The Rectangle Select tool
only selects items which are on the current layer.

To use the Rectangle Select tool simply click and hold the left mouse button where you want one of
the corners of the rectangle to be.

While still holding the mouse button, move your pointer to where you want the opposite corner of the
rectangle to be located (click and drag). As you do this a dotted line rectangle will be drawn from the
location where you first clicked to the current position of your pointer.

When your mouse is in the location where you want the rectangle to end, release the mouse button.

The rectangle will disappear and all nodes and lines which are completely inside the rectangle will be
selected. 

Anything completely inside the rectangle will be selected.

Polygon Select Tool

This tool is the most versatile of the three toolbar selection tools. Basically what you do with this tool is
draw a polygon around the area containing the items which you want to select. Each click of your
mouse is a vertex of the polygon, with the first click as your first vertex.

To end your shape you double click. When you do this DESS draws a line from where you double
clicked to your initial vertex, selecting anything inside the newly created polygon. Like the rectangle
select tool, this tool only selects items on the current layer which are completely inside the polygon
area.
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The polygon selection tool allows you to make very customizable and flexible
selections.

 

Inverting Selection

Inverting your current selection is a very useful and time saving task. You can access this tool from
the Editing tab via Query  > Invert Selection. When you activate this tool anything which is currently
selected becomes unselected, and anything which was unselected is now selected. This is useful if you
wish to select everything except a few specific nodes or lines. In order to do this you would select the
nodes or lines which you do not wish selected. Then you select Invert Selection from the Query menu.
Everything in the entire system will be selected except those specific nodes.

Selection before inverting
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Selection after inverting

 

Although the selection in this is large, it illustrates the principle of inverting selections. Inverting can be
done any number of times in a row. You could run an Invert Selection on the system shown after
inverting, above, and you would end up with the original selection.

Custom Selection

The Custom Selection dialogue allows you to specify specific criteria which are used to select nodes
and lines in the current system. To use this you begin by specifying whether you want to select nodes
or lines, and whether you wish to select them from the active layer, currently selected items, or the
complete system. 

You can also select whether or not you want these nodes to be added to the current selection. If do
not want these to be added to the current selection and you have a current selection, it will become
unselected and the nodes or lines designated in the dialogue will replace them. Note that you cannot
select both nodes and lines at the same time using this dialogue.
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This is the custom selection dialog. Using this
you can select very specific items throughout

your system.

Once you have selected the general parameters on the upper half of the dialogue, you can specify
more specific properties below, listed under 'Properties To Match'. To add a criteria you can either
select a topic and press the yellow plus, or right click on one of the topics already in the dialogue.
Either way a list will appear which has a list of available topics which can be selected. Each of these is
now a criteria for the selection. You can right click on any criteria to bring up a further list of options.
In this manner you can set the query as detailed or as specific as necessary.

ex. As shown in the image above:

1. You select Nodes in the select topic box in the top left. This means that the dialogue will only select
nodes.

2. You set the 'Select From' category to only select from the active layer.

3. You want the items which are to be selected by this dialogue to be added to the nodes and lines
which are already selected and so you enable the check-box which says 'Add to currently selected
items'.

4. Now to add a criteria right click on the word node below and select the criteria which you want, in
this case a switch switch element.

5. You can add more detailed criteria if you need to (not shown in this example).

6. Click the Select button, the dialogue will close. All nodes with switch elements, located on the
current layer, will be added to your selection.
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This is a very useful and powerful selection method once you understand how to use it. While it is not
effective to use for common selection it can perform tasks which are almost impossible, or incredibly
time consuming to perform with normal selection methods. Some examples of the types of selection
possible using this tool are:

select all nodes with open switches

select all nodes with 50kVA transformers on the 22kV layer

select all r phase single-phase lines containing 1/0 CU conductors

3.3 Tracing

The trace commands allow the user to trace along all connected lines and nodes in one of several
ways. Primarily the Upstream Trace and Downstream Trace commands are used, although the Custom
Trace feature allows you to select the specific type of trace needed. Trace Secondary is used to trace
the meter layer downstream of the selected distribution transformer. The Network Trace is also useful
in some circumstances. These commands are available in the Query menu in the Editing tab and some
are available through right-clicking on a node or line.

To perform a trace you must first select a node or line you wish to trace from, and then select the
trace which you want to perform.

Following are descriptions of each of the five types of tracing.

Trace Downstream

This tool works when a node or line is selected. The selected node or line will be the reference point
for the trace. From the selected node or line, DESS selects any lines or nodes connected to that line,
but only away from the source. The trace stops at open switches.

From the initially selected node, all nodes and lines which are downstream
(away from the source), and connected to the original node are selected.

Hint:
If a node or line is de-energized (not connected to a supply), you cannot trace from it.
Also, if your system contains closed loops (networked as opposed to radial), up and
downstream traces become ambiguous so you may not get the results you expect. Use the 
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Editing > Query > Find Disconnected and Editing > Query > Find Loops to identify these
conditions

Trace Upstream

Tracing upstream is the opposite of tracing downstream. As with the downstream trace you must
select a node or line in order to use this tool. All the nodes or lines in a direct line between the
selected item and the supply point will be selected. The trace will stop at either the power transformer
LV supplying the selected node, or at the node containing the source element.

Unlike trace downstream, no branches are selected as part of the upstream trace.

Tracing upstream is the opposite of tracing downstream.

Custom Trace

Custom Trace contains options from both upstream and downstream traces, as well as a few which
are not contained in either of the two basic traces.

Custom Trace allows you to set whether you wish to trace upstream or downstream. It also allows you
to select whether or not you want to trace connectivity over all layers, or by default only the layer
where the currently selected node is. The custom trace also allows you to trace connectivity on lines
using specific phasing.

The Custom Trace feature also allows you to either select only nodes, only lines or both. The trace will
still be performed as normal, it is only the specified parts that are selected, whether it be only nodes,
only lines or both nodes and lines.
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The Custom Trace Dialog is useful for setting specific tracing settings.

Finally, if you select two or more nodes, the Custom Trace allows you to select all items between the
selected items. This is a trace from the node closest to the supply, and stopping at the other selected
nodes. You can only use this feature when all the selected nodes are part of the same connected
section of system.

Secondary Trace

The Secondary Trace can be very useful for quickly finding all meters attached to a distribution
transformer. 

Network Trace

The Network Trace selects all nodes and lines connected to the selected node, stopping only at open
switches and at power transformers. You can select more than one node or line before using this trace
method. This tool is useful for selecting a disconnected section of system which cannot be selected
using the normal tracing tools because it is not energized.
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Network trace selects an entire network.

3.4 Creating a node

Creating a node is an easy, and yet very fundamental task. To create a new node in your system:

1. Select the new node tool on the Editing tab. Alternatively, you can right click anywhere on the
system.

 The new node tool 

2. Click on the location in the map view where you want the new node to be placed. If you don't get it 
just right, you can always move the node later.

3. If you placed the node near a line a pop-up will appear and ask you if you want to insert the node
into  the line (this splits the line and use the newly created to node to connect the two halves).

4. The Node dialogue will appear and you will have the option to enter information about the node.
You do not need to fill in any information immediately if you do not want to, the node will still be
created, and this dialogue can be accessed later so you can edit the data by double-clicking on the
node with the select tool.
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3.5 Creating a line

Creating a line     

To create a new line in your system:

1. Select the create new line button on the Editing tab.

 The new line tool 

2. Click on a node in the map view to start the line (all lines must be connected at both ends to nodes).

3. You can click at any point where you want to make a vertex in the line. When you do click to make a
'bend', a dotted line will be drawn from the point where you just clicked to the last place where you
clicked, or the node if you haven't clicked yet. In other words, the location where you clicked will act
as an anchor for where you click next.

Creating a new line. You can click
to make a bend or vertice in the

line.

4. When you want to end your new line, double click on the end node.

Hint:

If nothing happens when you click on a start node or double-click on an end node, the
problem may be that the nodes are not on the active layer (i.e. - you're drawing a line on
the 4kV layer but trying to attached the ends to nodes on the 27kV layer).

5. The Line Properties dialogue will appear. You can type in information here about the line you just
created, or you can close it and fill it in later. If you are extending an existing line, the default for
phasing and conductor type will be set the same as the adjacent line. Unlike nodes, you cannot
move lines. You can only move the nodes attached to them.

Hint:

Note that if you have multiple nodes, you cannot draw a line through multiple nodes and
have them inserted. If you do this they will not be inserted into the line. You must draw a
line from each node to the next one in the sequence.
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3.6 Deleting Nodes and Lines

To remove a node or line you must first select it. Once you have it selected you can remove it either by
pressing the delete button on your keyboard or pressing the delete button on the Editing tab. Both
methods accomplish the same thing. If you remove a node, all lines attached to that node will also be
removed. This prevents hanging lines. When you remove a node you also remove all elements on that
node. You can Undo a delete action if necessary using the Undo/Redo commands.

3.7 Moving a node

To move a node use click and drag:

1. Select the move node tool on the Editing tab.

2. Click and hold the left mouse button over the node you want to move.

3. Still holding the left mouse button, move your cursor to where you want the new node to go.

Click and drag to set the new position

All lines connected to it will
automatically redraw.

4. Now release your mouse button and the node will be where you released the button.

5. All of the lines attached to the node will redraw themselves automatically, and the node will keep all
of the same properties that it had before (except for length which will be modified).
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You can move line vertices as easily as nodes by using the Move Node tool.

Moving Lines

The Move Node tool is also able to move line vertices. This acts exactly like moving a node, except that
you click and hold on a vertex of a line to move, instead of a node.

 

3.8 Editing Node and Line Properties

To edit a node's or a line's properties you must first bring up its respective Properties dialogue. This is
called Node Data for nodes and Line Data for lines. You can bring up these dialogs in several ways.
The simplest method is to double click on the node or line that is to be edited while the select tool is
active. Alternately these dialogs can be brought up by selecting a node or line and then selecting the
edit tool on the Editing tab.

 The Edit Tool

Despite the fact that the pencil has no eraser, you can Undo any changes you might make.

Nodes

Once you have activated the edit function for a node, the Node Data dialogue appears. In this dialogue
you can view and edit the elements on that node, the name and description of that node, as well as
view the lines connected to that node.
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You can double click on any element or line in the node properties dialogue to bring up that line's or
element's properties dialogue. You can see each of these element dialogs in the Reference Guide.

In this dialogue you can also type in the nodes name or a brief description to help identify it. Typically
the Name field is used for key IDs, such as transformer ID or switch ID. The Description field can be
used for anything else, such as address, customer name, etc.

Lines

The line properties dialogue can be accessed in the same ways as that for the node. You can double
click on a line with the select tool or select the line and press the edit button. The dialogue can also be
accessed through the Node Data dialogue.



How to 75

© 2019 Essex Energy

The Line Data dialogue contains the name of its two nodes, its length, ID, phasing, conductor and
name. You can edit the Name and Length by simply typing in the desired content. The Phasing and
Conductor are easily changed with a drop down menu. The find icon to the right of the Conductor
allows you to search for the conductor that you want using the Find Conductor dialogue.

 

3.9 Creating and Modifying Elements

Most elements are created from the node dialogue, although power transformers are created by other
means. Some elements cannot be added to the same node together. A list of these is available in the 
elements section of the Users Guide. A description of each element is also available in the same
location.

 

Creating a New Element

To create a new element, merely bring up a Node Properties dialogue, either by adding a new node or
by double-clicking on an already existing node. Select the 'Add' button in the Attached Elements section
of the dialogue.
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A drop down list of available options will appear. You can then choose the type of element which you
want to add. A dialogue will appear asking you to enter information about the element which you
created.

 

Modifying Pre-Existing Elements

All existing elements are shown in the Attached Elements list. By double clicking on any one of these
you can bring up its properties dialogue and edit any information related to that element. You can also
select an already existing element and press the edit button to bring up that element's dialogue box.
Each of the respective property dialogs are covered in Reference Guide > Element Data Dialogs. You
can remove an element by selecting the element which you wish to remove and pressing the Delete
button on the dialogue, located under the list of elements, and to the right of the edit button.



How to 77

© 2019 Essex Energy

 

3.10 Creating and Deleting Layers

Background and Electrical Layers are the two different kinds of layers that can be created in DESS.
They are both primarily accessed from the docking window to the left of the Map View. They are
available under the 'Layers' tab.

Creating Electrical or Background Layers

To create a new electrical or background layer you can either use the buttons at the top of the Docking
Windows or you can right click on the appropriate type of layer.

There is a button to add an electrical layer and a button to add a background layer. The button with a
lightning bolt with a yellow star is the 'Add New Electrical Layer' tool. The button that looks like a world
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is the 'Add Background Layer' tool. Alternately you can right click on either of the headings: 'Electrical
Layers' or 'Background Layers'. This brings up a menu where you can select to add the layer
respective to the heading.

Once you have selected the add layer button in one of the above listed methods a dialogue will appear
with all of the applicable properties of that type of layer. These properties are covered in much more
detail in the Layer Properties section of the How to section.

 

Deleting Layers

Deleting Electrical Layers is very simple. you select the layer which you want to remove, and remove it
through one of two different methods. You can either click on the red X on the top of the docking
window, or right click on the layer to be removed, and select Delete Layer from the menu which
appears. Note that if you remove a layer all nodes and lines which are on that layer will be removed.
This is an action which you can always Undo if needed.

Deleting a Background Layer is much like deleting an electrical layer. you select the layer you wish to
remove and press the red X on the top of the Layers tab. You could also right click on the Background
Layer and select Delete Layer. Deleting a background layer does not delete the file which you imported
the background layer from. You can Undo this delete action.

 

 

3.11 Using Layer Properties

Layers have a number of key properties. An understanding of them is fundamental to using DESS
effectively.

 

The Layer Properties dialogue and Context Menu

This dialogue can be accessed by right clicking on the layer in the layer list and selecting the 'Edit
Layer Properties' option. You can also open this dialogue by selecting the layer to edit, and then
clicking on the Edit Layer Properties button on the top of the Layer Docking Window. This dialogue
contains all of the settings that are available for a layer in DESS. Some of the layer properties
(selectable, visibility) can also be set directly from the pop-up menu.



How to 79

© 2019 Essex Energy

Right clicking on a layer brings up a list of
editable options

Background Layer Properties Dialog
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Electrical Layer Properties Dialog

 

Selectable

A layer can be set to Selectable or non selectable, which controls whether you can select the nodes
and lines on that layer or not. This option can be accessed either by right clicking on the layer and
selecting whether or not it is selectable. This property can be set either from the pop-up menu or from
the checkbox in the properties dialogue.

This only affects whether a line or node is selectable or not with the basic selection tools. You can still
double click on any node to bring up its properties dialogue and edit its information.

 

Active

There can only be one active layer at any given time. This layer is identified in the docking window as
the layer with blue text. This layer is the one at which all new nodes and lines are created at. You can
only have one active layer at any given time. You can change which layer is currently the active layer
by right clicking on the layer and selecting 'Set As Active Layer'. You cannot edit this property in the 
Layer Properties dialogue.

 

Transparency

You can set a layer to be partially transparent. This option is especially useful if you want to be able to
distinguish easily between layers, while having all of the layers remain visible. The transparency option
is only available from the Properties dialogue. It is shown as a slider in the bottom right corner of the
dialogue. The farther to the right that the slider is, the more visible a layer is, with a default of fully
visible. The further to the left that the slider is, the less visible the layer is. This allows you to easily
distinguish between layers. Any layer with transparency is as fully functional as if it had no
transparency option set.
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With transparency it is easy to distinguish between
layers. In this example, the 4.16 kV layer is partially

transparent.

 

Visibility

Visibility is simply whether or not a layer is visible or not. This can be set both by right clicking on a
layer, and through the properties dialogue. Visibility Off makes the layer invisible. You cannot edit the
layer when it is set to this. Visibility On is the default and has the layer shown normally. Zoom Visibility
is a special case of visibility, it is discussed below.

 

Zoom

Zoom Visibility (sometimes called 'de-cluttering') is the ability to set a layer to be visible only when you
are zoomed into or out to a certain range. The levels can be set in the properties dialogue using two
options. Basically the layer will be visible between the two listed values. for the sake of example, say
that minimum zoom level is set to 0m (or left blank) and the maximum zoom level is set to 10000m. If
your screen width is between those two numbers then the layer is visible. Once you have zoomed out
far enough, and your screen width is greater than 10000m, the layer disappears.

This allows for several different possibilities. You can have your layer disappear once you zoom out,
appear when you zoom out, or only appear within a specific range. All of these possibilities can be set
by adjusting the minimum and maximum values. Any zoom level which is higher than the minimum will
be visible, while any zoom level which is lower than the maximum will be visible. You can see what the
current zoom level or width is by looking at the status bar below the map on the far right. The width
on the map is shown in whatever units you are using in your system. You can use this as a reference
when setting the zoom settings for a layer.

Typically the zoom feature is used to remove clutter in your system. By setting the lower voltage layers
or detailed street maps to disappear when you zoom out, you can see the overall shape of your
system, without all of the clutter which is normally caused when you zoom out to a substantial
distance.
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Background File

This is the file from which the background layer draws its image. This is not available for electrical
layers because only background layers require a file. You can click on the button with three dots, to the
right of the file path, to bring up a dialogue which allows you to select an image for the background
layer. The current file path is displayed in the text box at the top of the dialogue. When choosing a
new file, you can choose from any of the map formats supported by DESS (.shp, .tab, .dxf). The map
must already be stored in the correct coordinate system. Unlike some GIS software, DESS does not
convert between projections on the fly.

 

Labels

You can specify whether you want to see labels for nodes on electrical layers. you can set this from
the electrical layer's properties dialogue. You can activate or deactivate this ability by clicking on the
bottom left-most check-box in the properties dialogue which is labeled as 'show labels'. This can make
identifying nodes and lines significantly easier to handle. Creating and editing rules for labels is
handled using the commands on the main menu Analysis tab.

 

Voltage

For Electrical layers only, you must set the nominal voltage. This is the phase-phase voltage at which
all nodes and lines created on this layer will be set to. You can change this value later, however it
cause cause some problems with your system (i.e. wrong transformer, source and conductor data),
which would have to be fixed.

3.12 Moving Items Between Layers

The move between layers tool allows you to change a series of nodes and lines from one layer all to a
different layer. This tool is accessible from the Editing tab as Change Layer.

In order to use this tool you must have a group of nodes and lines selected. Once you have a selection,
access this tool from the Tools Menu. A dialogue will appear where you can select which electrical
layer you want to move the selected nodes and lines to.

Note that this tool could easily cause errors in your system, particularly when moving a large number
of nodes or lines at once. Also, this operation cannot be undone. This should be a significant source of
caution and it is recommended you make extra backup copies of your data before performing this type
of task.
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This is an easy tool to use. Simply select the electrical layer you wish to
move the selected items to.

The number of nodes and lines to move are listed at the very top of the tool, as well as the total
number of items which is being moved. Underneath this is the current electrical layer of the selected
nodes and lines. You will never have more than one layer selected at a given time because only one
layer can be active at a time.

Another set of statistics which are included are orphaned lines. As the dialogue explains, orphan lines
are those which will no longer have both end nodes on the same layer after all the nodes have been
moved to a new layer. The number listed includes normal lines in addition to power transformers. If
you go ahead and click OK to move the items between layers, the orphaned lines will be irreversibly
deleted from the system.

You should also see Checking for Errors in the How To section of the Help System due to the chance of
 causing errors in your system when moving nodes and lines.

3.13 Connecting Layers

Connect Layers with a Power Transformer

Power transformers connect two different electrical layers by connecting a primary (high voltage) and
one or two secondary nodes (low voltage) from different layers.

Creating a power transformer is very easy. You select the primary node from the high voltage layer,
and the secondary node(s) from other lower voltage electrical layer(s). It does not matter what order
you select the nodes in. You must, however, ensure that only those nodes are selected.

If you are creating a normal two-winding transformer you would select exactly two nodes (one for the
HV terminal and one for the LV terminal)
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If you are creating a three-winding transformer with double secondaries, you would select exactly
three nodes (one for the HV terminal and one for each low voltage terminal). The low voltage
terminals can be either the same voltage or different voltages.

Use the standard Select Tool with the Ctrl button held down to select multiple individual nodes.

This shows how to create a typical two-winding transformer. Select the HV and the LV terminal nodes
(must not have any other elements on them). Then create the power transformer as follows:

You can then either select the Create Power Transformer tool from the Editing tab > Add Power
Transformer.

 Add Power Transformer

Once you do this the Power Transformer dialogue will appear and you can enter the information
pertaining to the Power Transformer which was just created.

Finished power transformer. Symbols associated with power transformers are shown on the HV node
of the transformer.
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3.14 Undo and Redo

DESS comes with undo and redo functionality. Both the Undo and Redo buttons are located on the
DESS Editing tab.

Undo/Redo functionality is actually very simple to use. You can press the undo button to undo a change
which you have just made, or you can press Ctrl+Z. Similarly you can press the Redo button to re-
apply an action which you have undone, or you can press Ctrl+Y. This means that you can undo any
mistakes that you might make.

The Undo/Redo functionality applies to most actions performed in DESS with a few specific cases as
exceptions. If an action is not undo-able then you will often be warned on the dialogue or with a pop-
up before you can complete. that action.

  The Undo Button

  The Redo Button

 
 

Hint:
You can use undo/redo functionality to make changes and then run analyses and observe
the results of those changes, while not making any permanent change to the data file.

3.15 Using Tooltips, Labels and the Legend

When viewing your system there are several things which make it easier to identify and understand
your system. Three things are covered in this section. The first of these is Tooltips, second is Labels,
and finally Legends are covered. Tooltips are text bubbles which appear when your cursor hovers over
a node or line. Labels are text names next to nodes and lines giving information about their properties.
The Legend is a guide on your screen which helps to identify different nodes and lines during analyses.

Tooltips

Tooltips appear when you hover your mouse over a node or line. These contain information such as a
nodes ID, Description, Name and any elements currently on that node. This allows you to easily identify
nodes without having to open up their properties dialogue. Tooltips only appear if your mouse pointer
is over top of a node or line, for a short period of time (up to 20 seconds). There are no options that
you need to set for tooltips.

After running an analysis, extra result information may also be shown on the tooltips.
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Tooltips appear when you hover your mouse over a node or line
for a short period of time.

 

Labels

This section will be much easier to understand if you have read Editing Themes and Styles, in the How
To section and/or Themes in the User's Guide. Similar principles apply to labels as to node and line
styles.

Labels are text titles which appear near a node or line, and like tool-tips, contain information about
that node or line. Unlike tool-tips however, labels do not require you to hover your mouse over top of a
node or line.

In order to enable or disable Labels, you go to the layers tab on the Docking window, and enable/
disable the layers which you want labels to appear on. You do this by bringing up each layer's
properties dialogue and checking 'Show Labels'. You can also right click on a layer and select 'Labels'
from there. When this item is checked or selected any labels which apply to nodes or lines on that
layer appear.

Labels can be set in the Themes menu by going to Analysis > Settings > Label Style Rules. This brings
up a dialogue much like those of Edit Node Style Rules and Edit Line Style Rules. This dialogue works
slightly differently than those however.
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In order to create a new style rule for labels, first you must select whether you want to add a line label
or a node label. Select the appropriate button at the bottom of the list pane on the left. A new style
rule will appear at the bottom of the list of styles on the left. You can move this style up and down like
style for nodes and lines, by using the up and down buttons in the top center of the dialogue. You can
add more specific criteria by using the yellow plus sign at the bottom of the list on the right. When a
node meets that criteria it will follow the label directions provided in the bottom right of the dialogue.

Each style has its own label directions, this helps to keep the system clear, and not cluttered. The
directions for labels are quite simple. To add something to a label simply select the item to add from
the 'Available Fields' section, and press the right arrow in between the two fields. That item will be
added to the bottom of the Selected Fields list. To add a new line to your label, there is a 'new line'
field which can be added to the selected fields. This will move all items following it onto the next line
down. This prevents long strings of labels, and allows greater visibility of the labels.
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Labels are very effective at providing information quickly.

Like node and line themes, label themes are also available after running an analysis. These themes
overrides your current labels and replaces them with a series of labels which provide information
corresponding to the theme and analysis. You can restore your default labels as well as your default
node and line styles, by using Themes > Default Theme.

 

Legend

The legend is a box containing information about what each symbol or color represents after applying
a theme. The legend appears when you apply a theme to DESS, generally after just running an
analysis. You can set the options for the legend in Tools > Options, under the legend tool. The legend
is considered not to exist for purposes of manipulating the map view in any way.
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The legend makes it easier to use themes.

3.16 Editing Themes and Styles

This topic describes adding and removing node and line styles, and modifying or changing themes.

This section assumes that you have read over the section under User's Guide > Nodes and Lines >
Appearance in the help system. If you have not read this we suggest that you do so. It will help you 
understand the following discussion.

Styles

Styles are edited in one of two different places, depending on the type of theme.

Firstly, basic default styles are edited in the themes styles menu, under Default Appearance > Node
Style Rules or Line Style Rules. This is where the appearance of nodes and lines for the default DESS
theme are edited. Anything that you edit in this area will affect how DESS appears when no other
themes are applied to the system.

Secondly, the appearance of nodes and lines in the various analysis result themes are modified in the
Options menu. In this menu, which is accessed via Globe > Options, you can change the styles of the
nodes or lines for each analysis.

 

Creating a New Style

To create a new style you click on the 'Add' button underneath the list of styles. After you do this a
new style will appear at the bottom of the list of style rules. Currently this newly created style has no
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properties or settings.

To set a requirement you must click on the the drop down arrow beside the yellow plus sign. A list of 
elements and properties will appear. Choose the property that you want to have associated with this
particular style and set the options for it in the dialogue box which appears.

This is a continuous process. If you wish to add a more detailed or specific property requirement,
merely select the property in the right hand box, and then use the drop down arrow by the yellow plus
to choose more specific properties to add. You can do this process several times for the specific
elements and properties available.

Removing a Style

To remove a style which you no longer need, select the style which you no longer need and use the
delete button. This will remove the style permanently. You cannot undo this action once you have
clicked on the OK button.

 

Moving a Style

The position of a style determines when and if it will appear. As such, it is very important to put the
style in the correct position in the list. As the styles are evaluated in order, if a higher item in the list is
found to be applicable, the lower items will never be evaluated or used. Therefore, more specific or
detailed items should be higher in the list, and more general items should be lower in the list.

Initially a newly created style appears at the bottom of the list. You can change its position by first of
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all selecting the style to move by single clicking on it. Then you can then use the 'up' and 'down'
buttons to shift the position of the style one position in its respective position. If you push the up
button, the style will switch places with the style above it, and likewise if you push the down button the
style will switch places with the style below it.

Hint:
Because you cannot undo styles (after you have clicked OK), the only way of changing back
to a previous arrangement is to change it back manually. Because of this it is generally
wiser to create a new style and place its priority higher, rather than change the values of
an original style. It is much easier to remove a new style which you have created, than to
try and change several styles back to how they were.

 

Changing the Appearance of Styles

You can change the appearance of styles by first selecting a style in the left-hand list of styles. Then
click the change button. A dialogue like the ones below will appear.

For nodes you can set the symbol for the node by picking one of the listed symbols. DESS uses a
special font for these characters, and it is used by default. However, if you wish you can choose a
different font to use by using the font name drop down menu to select the font you wish to use. You
can use several different fonts. Each style can use a font independent of all other styles.

This is the dialog for editing the appearance of a line style.

   

This dialog is used to edit the appearance of a node style.
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When you are finished making changes you can select OK to return to the styles page.

 

Changing the Appearance of Analysis Result Themes

In the Globe > Options dialogue you can set the visual appearance of nodes and lines for the themes
that can be shown after an analysis is run. Each analysis may have a number of different themes for
nodes and lines. This is shown from the labels to the left of each style. Unlike the normal DESS theme,
you cannot add styles or delete styles in this mode, only change the values at which a particular style
is shown or the appearance of the style.

The Options Dialog

To change the appearance of a node or a line in this dialogue, double click on the button to the right of
the style shown. Once you do this the dialogue used to modify the appearance of a node or line
(shown above) will appear.

 

3.17 Moving the Docking Window

The docking window is a useful addition to the DESS interface which contains three separate sections.
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These sections are each explained in the Reference Guide section of this help system. This section
concerns the use of the docking window. The Docking window is very easy to move and adjust
according to your preferences.
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Width

The width of the docking window can be adjusted by clicking and dragging the blue bar on the right of
the docking window. This will adjust the width of the docking window according to which direction you
drag it. It will apply to each of the tabs, the setting is for the entire docking window. If the width
becomes small enough to obscure some of the content in the window it will create a scroll bar on the
bottom of the window so that you can still see everything (albeit with scrolling).

Tabs

There are three different tabs on the side of the docking window. These correspond to three different
sets of functions inside the window. By clicking on any one of them the corresponding docking window
view will appear. Each of these three views has its own content, and with each one the buttons on the
top of the docking window change. You can switch between these tabs at will. By switching between
the three different views you do not affect anything inside them, or anything outside of them. Changing
these tabs is the equivalent of changing active windows on a desktop, it is merely for convenience
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when viewing.

Pinning

Another feature of the docking window is the pin button. This button looks like a thumbtack and is
shown in the upper right hand corner of the docking window. This button is a toggle and when the pin
is upright the window will always appear on the side of the DESS map view. This is the default setting
for it.

The other toggle sets the window to minimize to the side of the screen when it is not being used. This
turns the icon to a sideways thumbtack. By placing your pointer over the labeled tabs on the left of the
screen, the window corresponding to that tab will pop out. When you move the mouse off of the
window it will minimize again. This is useful if you only use the docking window occasionally. You can
toggle between the two modes at will by pressing the thumbtack button in the upper right hand corner
of the screen.

Hint:

Note that while the docking window is set to minimize while not in use, you only need to
place your cursor over the tab which you want to view, you don't have to click on the tabs.

 

 

3.18 Changing Switches

The status of switches can easily be changed in DESS. Simply select the nodes containing the switches
which you want changed and then press the change switch tool. The Change Switch tool causes the
switch to change status. If any phase of the switch was open, it is now closed and if it was closed, it
will be fully opened. This tool is available on the Editing tab, or by right clicking on a switch. You can
only have switch nodes selected to use this tool. You cannot switch any nodes unless every selected
item is a switch. The can change a mixture of open and closed switches together in a single operation.

You can also change switch status from the switch element property dialogue by double-clicking a
node containing a switch and then double-clicking on the switch element. You can then manually set
the switch status, including opening only partial phases to simulate emergency or maintenance switch
operations.

3.19 Finding Nodes

One frequently used tool in DESS is the Find Asset dialogue. This tool allows you to find any node that
currently exists in the system.

The Find Node dialogue can be accessed from the main menu by clicking on Editing > Find Asset.

To use this dialogue you use one of three different tabs on the top of the dialogue to select which
method you wish to use to locate a node.
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Hint:

In certain cases a fourth tab becomes available, the map tab. This allows you to pan and
zoom on a representation of the map view so that you can locate the node which you wish
to find.

Finding Nodes

Nodes can be found by entering search criteria into the Filter By text box. All visible columns will be
automatically filtered by the criteria. All of the nodes in the system whose name or description field
contain the criteria will appear in the list box below the search fields. For example, if you entered "St"
for Name, all nodes containing "St" anywhere in the visible information columns would be listed. You
can click on the column header to sort the entire list by that column. You can click on a column heading
again to reverse the sorting order, eg, ascending to descending. Clicking on the funnel icon next to a
column header will allow you to filter only that column by any criteria.

Finding a single node or a series of nodes using ID numbers.

Use the drop-down to select the asset type, then press GO. The visible columns may be updated with
new relevant data for the chosen asset type. Enter any part of the node's information which would be
in one of the columns into the Filter By text box.

You can double click, or click OK, on any asset in the list box to close the Find Asset dialogue and
center the map view on that node, which will be selected.

3.20 Creating Reference Data

We suggest that you read about Reference Data in the User's Guide before editing any reference data
items.
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Reference Data is modified, edited and managed through the docking window on the left of the map
view. In the docking window, reference data is managed in the Reference tab. When you first open the
reference tab, you are presented with a series of expandable item types. In a brand new system you
will have no reference data, and there are two different ways to get some. You can make it yourself,
or you can copy it from another system. Importing your reference data is covered in Import and
Change References.

 

Creating Reference Data

In the docking window there are four buttons on the top of the window. The first, on the far left, called
'Add Item', adds a new item to your collection of reference data. When you click it it brings up a list of
items which can be added to the list. When you select one of these items it brings up the appropriate
dialogue for editing the data for that specific reference data item.

 

The second button, to the right of the 'Add Item' button, is called create copy. This button creates an
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exact duplicate of an already existing item of reference data. This becomes useful when making a
number of similar items.

The third button, the red 'X', is the delete button. Its function will be left up to your imagination.

The fourth button is the Edit Properties Button. This brings up the properties dialogue of the selected
reference data item. This is the dialogue where you edit all of the information for that item of
reference data.

Each of the property dialogs for reference data items is covered independently in the reference guide
section of this manual at Reference Guide > Dialogs > Reference Data Dialogs

3.21 Modifying References

Reference data is essential to your system. Many items such as lines, loads and transformers cannot
be created without using reference data. There are two primary ways to get reference data. You can
create them from scratch, or you can import them from a pre-existing system.

 

Importing References

By far, the easiest method to populate the reference data in your system is to import reference data
items from another system. You can import reference data from one system to another using the
Import References Tool. To do this you select Import References from the tools menu. A dialogue will
appear prompting for a file. Navigate to the system which you want to import reference data from, and
then select Open. Another dialogue will appear, and in this dialogue you can select which Reference
Data items you want to import.
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Select the reference data you want from the left and move it to
the right.

Select which reference data items you wish to import on the left and click the right arrow to add it to
the  list of items to be added to your system. Nothing is added until you have pressed the OK button so
you are able to remove items which you do not want. You remove items by selecting them on the right
and pressing the left arrow. None of the reference data which is currently in your system is shown on
the right, only the reference data to import.

You can import entire categories by importing their heading. eg. by selecting 'Week' and pressing the
right arrow, all three of its items would be added. Likewise you can remove entire categories by
selecting the category title on the right and pressing the left button. You can add all reference data by
selecting the 'External System' title and pressing the right arrow. You can remove all reference data by
selecting 'Items to Import' and pressing the left arrow.

This dialogue does not only import reference data. At the bottom of the list you can also select node,
line and label styles to import. This allows you to easily keep all your systems looking the same.
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When you are finished, select the OK button to import the items you've selected or Cancel to quit
without making changes.

Hint:

When DESS is installed it creates a a folder in the DESS install directory called Reference
Data. This contains a number of files containing protective device reference data items
which can be imported into your system.

 

Creating Reference Data

Sometimes the data you need isn't part of an existing DESS system and you must create your own
reference data from scratch. This is a straight forward using the property dialogs for each item. To
create reference data, right-click on the heading of the data type which you wish to create and select
the add option. This will bring up the properties dialogue for that particular type of reference data.
From there you fill in the required information and click OK.

The Copy tool makes this process much quicker. To use this tool, select the reference data item to
copy, and then click on the Copy button on the docking window toolbar. An exact copy of that item will
be created. This is extremely useful when you want a large number of similar items of reference data.
You can create a template and make copies of it.

Each type of reference data has a different properties dialogue and so each of these is covered in
detail in the reference data section of this guide, under Dialogs > Reference Data Dialogs.

 

Changing References

The Change References tool in the Tools menu allows you to change the reference items associated
with  multiple nodes and lines at the same time. First select all of the lines and nodes which are to be
changed. Then select Change References from the Tools menu.
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The Change References dialog allows you to change a large number of references at once, saving a lot of
time.

Once this dialogue appears you can start to change reference data. First, select the type of reference
data to be changed. After you do this a list of the reference data being used by the current system will
appear. Select the item to change and select its replacement from the large list of reference data on
the right. Repeat this process for all of the reference data which you want to change, and then select
OK to make the change.

Warning:

You cannot Undo a change in reference data. However, if you use the Selected tab on the
docking window you can 'remember' which nodes and lines were changed, and if you want
to you can change them back through this.

3.22 Checking Your System For Errors

When editing your system you will occasionally use tools in such a way that errors are created in your
system. An error in DESS is anything which puts the system data in an inconsistent state or any data
items that contains questionable values. If you want examples, try making errors.

There are three different levels of an error:
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Info - This refers to a piece of information which may not be an error but which the user should be
aware of. The problem is unlikely to cause a problem for analysis.  This includes closed loops or de-
energized (disconnected) nodes and lines.

Warning - This means that the item may or may not be an error, but that questionable values or
situations may causes problems for analysis. This includes very high transformer losses, bad phasing
across a switch, etc.

Error - This means your system currently does not operate correctly because of a specific modeling
problem and that the problem must be corrected before you can successfully run an analysis. This
includes bad connectivity, bad phasing (e.g. red phase load on a single phase blue phase line), bad
transformer data (3 phase transformer on a single phase line, etc).

Here are some deliberately created errors as an example.

You can display all of the errors, warnings and info in your system by using Editing > Query > Check
for Errors. This will display a window on the bottom of the DESS window. This window can be re-sized
by dragging the thin blue bar at the very top of the errors window. The errors window displays the
number of errors in the title bar.

If you double click on any error the map view will center on that (now selected) node or line. You can
still use DESS normally while this window is open. This allows you to find and fix these errors while
they are right in front of you, saving time and effort.

While this window shows all the errors so that you can work on them while seeing them all, it does not
automatically refresh. In order to refresh you must access the tool again from the Query menu.

You can close this errors window when you are finished with it by simply clicking on the x in the top
right corner of the errors window.

 

Show Disconnected

This tool, available from the Editing tab as Query > Show Disconnected, shows you all of the nodes
and lines which are currently in your system, which are not connected to a source through lines. When
you click on Show Disconnected, a pop-up will appear listing how many nodes and lines are
disconnected.
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DESS will show you all of those nodes and lines which are not connected to a source.

DESS will also select all those nodes and lines which are disconnected. Note that this will deselect any
previously selected nodes or lines.

 

Show Loops

This tool, available as Query > Show Loops, shows all of the current closed loops in your system.
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This tool constantly updates, and you can edit the map view with the dialogue open. More information
on this tool is available in Reference Guide > Editing Dialogs > Show Loops dialogue.

 

3.23 Multiple System Views

DESS has the ability to show a single system using tab options. At the top of the map view there is an 
Add Tab command, which will open the same system but allow you to be in a different area at a
different zoom level.
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Tabs can be clicked and dragged to re-position the viewing pane in the main window. Clicking the X in
the upper right hand corner of the unpinned window will close the tab. Clicking the docking icon next to
the X will move the tab back to the main position. You can also click and drag it back into place.

While clicking and dragging a tab around, the docking pop-up will appear in the center of the map view.
This will automatically snap the tab to the left, right, top, bottom, or re-dock the tab. Simply drag the top
of the unpinned tab to whichever arrow you would like, or over the center to re-pin the window.
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Once a tab has been pinned to the left, right, top or bottom of the map view, you can adjust the size of
the panes by hovering over the dividing line and then clicking and dragging the edge of the pane to grow
one and shrink another.

3.24 Update Current System Model

To update the current system model, first open it using File > Open > Open Current System Model.

Next, enable editing by clicking on Globe > Analysis > Update System Model.

The program will prompt you for your credentials. If another user is currently updating the model, the
program will notify you with the other person's login. More than one person updating the model at a time
can cause change conflicts.

Perform the edits, and then use File > Save > Save As System Model to update the file on the server.
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4 Reference Guide

The reference guide provides detailed information on using DESS. It includes:

Globe
Ribbon
Docking Windows

Dialogs

Element Data Dialogs
Reference Data Dialogs
Editing Dialogs
Analysis Dialogs
Other Dialogs

4.1 Globe

The Globe contains options and information pertaining to the entire program. Each of the options in the
menu are explained below.

Options

This dialogue allows you to update analysis result themes. See the options dialogue for more
information.

Logout

Logs the current user out of the program and re-launches the login window.

4.2 Ribbon

Most commands in DESS are available from the Ribbon.

Each of the ribbon tabs contain commands which are related in one way or another.

File - for opening and saving system data and results

Edit - for editing and deleting data

Analysis - shows all of the available analyses
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Double clicking on the tab will collapse or expand the ribbon. 

Ribbon items with a down arrow have more than one option. Clicking on it will expand the menu and
show all of the options.

4.2.1 File Tab

The File tab is used for opening, closing and saving system data. It contains the following commands:

File Control

New

Opens a new empty DESS system. When you open a new system the System Properties dialogue
will be displayed which lets you specify properties such as coordinate systems, phasing
preferences, etc. Note that a new system will not initially contain any reference data or theme
definitions for nodes or lines, although these can be imported from other data using the Analysis >
References > Import References command.

Open

Open Model opens an existing DESS system using a standard file dialogue. Most DESS system data
files end with a .dss.xml extension (note the double extension). Note that you can open a read-
only file even though you cannot save to it. Backup files can also be opened and have a .bak
extension. Backup files are created using the Auto Save functionality in DESS. 

Open Last Model opens the most recently accessed local DESS file.

Open Recent contains the most recent system files that have been opened. Click on a sub-menu
item to open that data.

Close

Closes the currently open system. If the system has not been saved, you will be asked whether
you want to save the data first.

Save

Saves the current system. If the open system has not previously been saved you will be prompted
for a location to save it. When you make edit the data in a DESS system, the changes will not be
saved until you choose to Save System. Note however that if you have enabled the Auto Save
feature, DESS will automatically save a backup copy of your system data regularly (by default
every 15 minutes). These files have the same name and are stored in the same folder as your
data, but have a .bak file extension.

Save As

Save the current system to a new file location. You can use this function to make a copy of your
data. DESS system files are typically saved with a .dss.xml file extension.
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System Settings

Import Data

This lets you import data in the DESS v6 XML format. Data imported this way must be structured
much like actual DESS system data but is allowed to be more flexible for identifying nodes, lines
and references. Import data can have, but typically does not have, any reference data. This
function can also be used to import data from one DESS system into another (.e.g if you wanted to
combine two systems).

System Properties

This command brings up the System Properties dialogue where you can view and edit system
properties and statistics. This command lets you set names for the phases (e.g. 'abc' or 'rwb').
You can also choose the coordinates to use for the map. The statistics tab shows how many
objects (such as nodes, lines, switches, etc) you currently have in your system.

View

View All

This command sets the map view to encompass the whole system. It does not matter what the
current zoom level or viewing area is, the program will center the system and zoom to have the
whole system in the view.

Set View

This brings up the Set View dialogue so you can choose the coordinates of the map center and the
current zoom. This can be useful if you know the coordinates of a point you want to view or want
to display a specific view for print purposes, etc.

Export

Page Setup

Set up options for printing the map currently displayed on the screen, including paper size and
margins.

Print Preview

Preview how the printed output for the currently displayed map will appear.

Print

Print the currently displayed view of the system.

Save Map To File

This brings up the Save Map dialogue which lets you save a specified section of the map to a
graphics file. This can be useful for use in reports or if you wish to annotate a map in external
graphics software.

Export as MultiSpeak 3

This command allows you to export the model in a MultiSpeak V3 XML file which can then be
consumed by another program which is MultiSpeak V3 interoperable.
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4.2.2 Editing Tab

The edit menu is used for editing data and contains the command listed below. Most of these
commands can also be accessed from the toolbar.

System Manipulation

Edit

You can use this command to bring up the Node dialogue or Line dialogue for the currently
selected node or line on the current layer. This is equivalent to double-clicking on a node or line
with the mouse. 

Delete

This command will delete all currently selected nodes and/or lines. Note that because of
connectivity rules, deleting a node will delete all attached lines. 

Undo

This command undoes recent changes to the system. There is no limit to how many actions you
can undo, however, some commands which make extensive changes to the data (especially some
of the actions on the Tools menu) cannot be undone. 

Redo

This command re-does the most recent Undo command. 

Add Node

This command will allow you to add a node to the currently selected electrical layer. Once a node
is added, you may add an element to the node.

Add Line

Using this tool will allow you to add a line between two nodes on the same layer. The exception to
this rule is if one node is on a meter layer and the other node has a distribution transformer. To
make a curve or bend in the line simply click where you would like the bend to be and then
continue on to the next node. To terminate a line double click on the destination node. A line must
always begin and end at a node. Once a line is created you can update its electrical properties by
setting the appropriate conductor reference.

Move Node

This command allows you to move a node on the currently selected layer from one position to
another.

Add Power Transformer...

This command is used to add a power transformer to the system. A power transformer creates a
connection between electrical layers. To use this command you must first select two nodes on
different layers (you can select multiple nodes by holding down the CTRL key as you click on



Reference Guide 111

© 2019 Essex Energy

nodes). These nodes will become the high and low voltage terminals of the power transformer.  

If you are creating a 3-winding transformer you must select 3 nodes on at least two different
layers. One node will become the HV terminal of the transformer, and the other nodes will
become the secondary and tertiary terminals.

Once you have selected nodes, you can use this command and it will bring up the Power
Transformer dialogue.

Change Switch Position

Use this command to change the status of one or more switches. Select one or more switches you
want to change and then choose this command.

Change Phasing

This command will allow you to update the phasing of all selected switches.

Change Layer

Use this command to change the layer for all selected items from one electrical layer to another.
Note that if you are trying to move something from a meter layer, you must move it to another
meter layer to retain connectivity to a distribution transformer.

Find Asset

This command brings up the universal search window. This window can also be accessed by
typing Ctrl + F.

Extra Tools

Extra tools is a sub-menu containing several useful commands.

Cut Elements From Node allows the user to cut all elements and the name from one node and
paste them onto another node of the same electrical layer. Note that this does not cut the unique
ID from the original node and paste it into the new node.

Copy Elements From Node allows the user to copy all elements and the name from one node and
past them onto another node of the same electrical layer.

Paste Elements must be used in conjunction with one of the above commands. It allows the user
to take the latest cut or copied elements and paste them onto the selected node.

Reset Line Lengths updates the length of lines through the whole system with the geographic
length calculated by the distance between the two nodes on a line.

Set Feeder Names allows you to set up a naming condition for lines, either for the whole system
or currently selected lines. This is explained in more detail in the Set Feeder Names Dialogue.

Affine Transform Map can be used to rotate and shift a system model to better fit it to actual
conditions.

Affine Translate System allows the user to convert a system model from XY to latitude and
longitude. 

Cursor Tools

Select
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The Select tool allows you to choose a single node or line by clicking on it. To select multiple items
hold down Ctrl while clicking, to deselect an item hold Shift.

Rectangle Select

This tool will select any nodes or lines within the drawn rectangle which is on the currently
selected electrical layer.

Polygon Select

Polygon Select allows you to draw an abnormal shape to select any number of lines or nodes on
the current electrical layer. To finish drawing the shape double click where the last corner should
be.

Zoom Out

This tool lets you zoom out and view a larger area of the map. Click on a point to zoom out around
that point.

Zoom In

Use this tool to zoom in on an area of interest on the map. You can either click once to zoom in by
50%, or you can click and drag a rectangle to zoom in on a specified area. You can also use the
scroll wheel on a mouse to zoom in and out.

Trace Options

Trace Up

This traces upstream (i.e. back towards the supply) from the currently selected node or line. All
nodes and lines on the same electrical layer and which supply the start point will be selected. You
can use the Custom Trace... command for more complicated queries. 

Note that if you have a networked system (with closed loops in the circuit), the nature of up and
downstream are no longer unique and an upstream trace may not give the expected results. Also,
this command will not work on a circuit if there is no connectivity at the point where you start the
trace. If you have no connectivity you can still use the Network Trace command.

Trace Down

This traces downstream (i.e. away from the supply) from the currently selected node or line. All
nodes and lines on the same electrical layer and which are supplied by the start point will be
selected. You can use the Custom Trace... command for more complicated queries. 

Note that if you have a networked system (with closed loops in the circuit), the nature of up and
downstream are no longer unique and a downstream trace may not give the expected results.
Also, this command will not work on a circuit if there is no connectivity at the point where you start
the trace. If you have no connectivity you can still use the Network Trace command.

Custom Trace...

This command opens the Custom Trace dialogue which lets you trace according to the system
connectivity, either upstream, downstream, across layers or even between a set of selected
nodes. You will need to first select one or more nodes in order to use this command. You can also
use this command to trace individual phases, which can be useful for diagnosing connectivity
errors. 
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Note that if you have a networked system (with closed loops in the circuit), the nature of up and
downstream are no longer unique and a custom trace may not give the expected results. Also, this
command will not work on a circuit if there is no connectivity at the point where you start the
trace. If you have no connectivity you can still use the Network Trace command.

Network Trace

This command traces all nodes and lines which are physically connected to the currently selected
node or line on the same electrical layer. For example, you can use this command to select all
feeders supplied from a given substation transformer, or you can use it to select a contiguous
group of disconnected nodes.

Query

Custom Select

This command opens the Custom Select dialogue which allows you to query the nodes and lines in
the model in order to select items which have specified characteristics. This can be very powerful
if you want to select nodes with specific elements, phasing, or element properties. For example,
you could use this command to select all nodes which contain overhead distribution transformers
less than 100 kVA.

Query Property

This command opens the Query Property dialogue which allows you to query all (or a specified
group of) objects of a specific type in order to find the count, average and total of a specific
property of the object. For example you could query for total length of single-phase lines on a
feeder.

Select All

This selects all nodes and lines in the entire system.

Invert Selection

This inverts the currently selected nodes and lines. All items which are currently shown selected
are deselected, and all unselected items become selected. This tool can be useful in conjunction
with other select tools to select  items which do NOT have a specific characteristic (e.g. - use in
conjunction with a Trace Down to select all nodes and lines not on a given feeder).

Show Disconnected

This command will select all disconnected nodes or lines in the system. Disconnected nodes and
lines are cut off from any power supply and are not energized. This is a useful tool to use after
making a number of edits in order to check the system is correctly configured. Note that if you
have disconnected items you will be given a warning when you run an analysis. This warning can
be ignored if you disconnected part of the system on purpose (e.g. to represent de-energized lines
or feeders).

Show Loops

This command will select all closed loops in the system. Closed loops may be the result of errors
in configuration or accidentally leaving a switch closed that should be open. Note that if you have a
closed loop you will be given a warning when you run an analysis. This warning can be ignored if
you created the loop on purpose (e.g. you are paralleling a transformer or modeling a switching
operation).
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Show Errors

This command performs a full check on the current system to check for errors, inconsistencies or
warnings. This is the same check which is automatically performed before any analysis is run.
Note that this function returns different levels of messages, including Info, Warning, and Error.

Info items represent situations which are unusual, such as disconnected nodes or loops, but which
may not be an error. If you see this type of message, make sure you understand why and where
these issues come from.

Warning items represent situations which are most likely in error, but which will not prevent an
analysis being run. This includes items like overloaded distribution transformers. If you see this
type of message, you should address the issue or at least understand the ramifications of the
error.

Error items represent problems which will prevent the running of an analysis, such as incorrect
phasing on elements, too many lines attached to a a switch, etc. This type of problem must be
corrected before attempting to run an analysis.

Find Loop Points

This command returns a list of nodes which are contained in a loop, if one exists.

Modules

Import ESRI GIS

This module allows you to import data from an ESRI GIS file into your model. This is quite useful if
your company already maintains a GIS connectivity model, since it can be re-used to produce the
engineering model as well. This is explained more in the Import ESRI GIS Dialogue.

Switching Order

Switching Order allows you to choose a switch, from the model or a list, and then "operate" that
switch. The details of what the effects of the change are will be outlined, and any switches which
can be operated to restore power or break the created loop will appear in the list. This is
explained in greater detail in the Switching Order Dialogue.

4.2.3 Analysis Tab

This tab gives you access to all the analysis tools in DESS. Note that the selection of tools will depend
on those licenses purchased for DESS. If you need access to a certain function and see it listed here
but it doesn't appear on the menu for your copy of DESS, please contact Essex Energy regarding the
license.
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Analysis

Load Flow

Run the load flow analysis. Show system voltages, currents, power and losses for a given set of
loading conditions.

General Short Circuit

Runs the general short circuit analysis. Shows fault levels for a set of points on the system.

More

Annual Load Flow

Run the annual load flow analysis. Show range of voltages, currents, power and losses throughout
the year plus energy.

Arc Flash

Arc Flash runs the arc flash analysis. It shows the incident energy, fault protection level and
protection zone for the selected assets.

Capacitor Optimization

Run the capacitor optimization analysis. Show optimal location of capacitor banks.

Load Loss

Runs the load loss analysis. Shows incremental losses due to load at a specific location.

Motor Starting

Runs the motor starting analysis. Shows voltage drops and conditions due to starting a motor.

Open Point Optimization

Runs the open point optimization analysis. Show optimal switching configuration for minimum
losses.

Phase Balancing

Runs the phase balancing analysis to find phase changes for spurs and loads.

Protection Assistance

Protection Assistance has two different actions. 

Select Protection Zone will select all nodes and lines in a protection zone when a protection
element is selected. 

Fault Range On Selected Nodes will give the calculated maximum and minimum fault values (using
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the same parameters as General Short Circuit) for the specified nodes.

Protection Coordination

Show device coordination upstream of a selected node.

SCADA Load Flow

Runs the SCADA load flow analysis. This combines a standard load flow with real measurement
information in order to dynamically scale modeled data to match real data.

Specific Short Circuit

Runs the short circuit analysis. Shows fault levels for a set of points on the system.

Reports

Meter Data

Meter Data is a CSV exportable report containing information about selected meters or all meters
in the system. The report includes: Node ID, Meter Number, Phasing, Voltage, Current, Customer
Name, Address, and Transformer. Each of the columns can be shown or hidden, as well as
filtered.

Show SLD

This command executes a trace though the system, either the whole or the currently selected
portion, and creates a single line diagram from nodes with have "Include in SLD" checked off in
the node dialogue. Note that you must include a source or the program will not be able to trace
the connectivity properly.

More

After any of the above analyses are performed, an analysis-specific set of reports will be
generated and listed under More. This button will be hidden unless an analysis has been
performed.

Views

Items on the Views menu are used to control how nodes and lines are displayed on the map.

When you are editing a system, a default theme is used for nodes and lines. For example, you may
have one symbol for transformers, and others for closed and open switches. Likewise, you may have
different line styles for different voltages, different phasing and overhead vs. underground.

After running an analysis there may be additional items added to the Themes menu which provide
additional views of map items depending on results from the analysis.

Settings

This command brings up a list of different sub areas where you can edit the default appearance of
your system. There are three different items which you can select from this menu: Line Style
Rules, Node Style Rules and Label Style Rules.

Node Style Rules

This command helps you to set up the default theme for nodes. This includes the styles to use
for nodes depending on the properties of the nodes and the properties of any attached
elements. This command brings up the Node Style dialogue.

Line Style Rules
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This command helps you to set up the default theme for lines. This includes the styles to use
for lines depending on the properties of the lines and the properties of the conductors. This
command brings up the Line Style dialogue.

Label Style Rules

This brings up a the Label Style dialogue where you can edit the settings for the display of
labels. Within this dialogue you can edit what labels are displayed on, what information is on
the label and in what order the information is displayed. You can also change the font size,
font and other factors in this dialogue.

Default

Clicking either on Default View or on the icon above Default will return the model to the default
theme settings.

Additional items on the Default menu will be added depending on the type of analysis and results
available, such as Node Voltages after running a Load Flow analysis.

Show Legend

This option toggles whether or not the legend will show when showing themes from results. More
information on Legend is available in the how to section under Using Tooltips, Labels and the
Legend.

Loads

Import Loads

This command lets you import load data from an external database (typically exported from a
billing system). It works by matching up data in the external database with loads in DESS, and
importing the defined values. You do not need the external data to be in a predefined format, as
long as the data is present. See the Import Loads dialogue.

Create Loads

Use this command to create new load elements in DESS whose size is proportional to a
distribution transformer present on the same node. This is useful for setting default loading on
new transformers or those where exact load data is unavailable. See the Create Loads dialogue.

Load Scaling

The Load Scaling dialogue lets you modify the size of the loads within load elements on a selected
set of nodes. You can choose to either modify the actual load values or just to modify the scaling
factor within the element. You can scale selected loads by season and by load category.

Combine Seasonal Loads 

This command takes all seasonal loads on a single node and combines them to create a new
single seasonal load.

SCADA Measurement Data

Use this dialogue to manage and edit data files which are used to store SCADA measurement data
for use with the SCADA load flow analysis. See the Edit SCADA Measurement dialogue for more
details.
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Data

Simplify Data

Simplify data will allow you to simplify your system by eliminating unnecessary spurs, nodes, and
lines. See the Simplify Data dialogue for more details.

Reset Line Properties

This tool updates phasing and conductor type for selected lines. See Set Line Properties dialogue
for more details.

Fix Switches With More Than Two Lines

This tool will automatically take switches with three or more lines and move the switch slightly
upstream to a new node to fix the issue.

Open Short Loops

This tool will automatically open loops which have no loads or elements between loop points. Upon
completion the number of loops opened will be displayed.

Copy Source and Power Transformer Info

This allows you to copy source and power transformer information from one system to another.
Please see the Copy Source and Power Transformer Info dialogue for more details.

Reset Line Lengths

Reset Line Lengths updates the length of lines through the whole system with the geographic
length calculated by the distance between the two nodes on a line.

Copy Conductor Info

This allows you to update any selected conductor's properties by copying the type or phasing from
a different system. See Copy Conductor Data From Similar System dialogue for more instructions.

Create Node Data

This tool allows you to create multiple nodes from an external file, such as Access, Excel, CSV or
DBase IV. See Create Node Data dialogue for more information.

Banked Transformers

Select Banks will select all banked transformers within the system.

Remove Empty Loads will remove loads on banked transformers which are 0kVA.

Spread Load on Bank will spread the load on a banked transformer equally among the phases.

Show Lines Missing Conductor References

This command assists you in identifying issues with the model by returning a list of lines missing
references. Conductors not having references can be detrimental to analysis, since losses and
loading will not be able to be calculated. 

References

Change References
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This very powerful and useful command allows you to make changes to the reference data for
selected nodes or lines. For example, you can use it to change the conductor type for a set of
lines, or to change one type of distribution transformer to another within a selected set of data. It
also allows you to see how frequently different types of reference data are used in selected parts
of your system. The following reference data can be affected: conductor types, transformer types,
load seasons, load categories, protection types. See Change References.

Create References

Creating references through this dialogue gives you much more control over the different
configurations and parameters for the reference. It can be used to create overhead line and
transformer references. See the Create Reference dialogue for more details.

Import References

This command lets you copy reference data items from another DESS system into the current
DESS system. You may want to do this when creating a new system from scratch, or to import
predefined items such as protection data into your system. See the Import References dialogue.

Organize References

This dialogue lets you change the order of a reference list. See Organize References dialogue for
more details. 

Results

Save Result

When a result is open (after running an analysis) you can save the raw result data to a number of
different formats (including text, html and xml) so it can be accessed and manipulated by other
software. You can also copy result data to the clipboard so that it can be pasted into other
programs (e.g. spreadsheets or databases). The Save Result dialogue lets you specify what data
to save and the format to use.

Close Result

Closes the results for an analysis. Once you close a result or run another analysis, results from an
analysis will no longer be available and are not automatically saved. If you want to save result
data, either save the reports which are of interest to you, or use the Analysis > Save Result
command to save the data of interest.

4.3 Docking Windows

There are three different docking windows in DESS. These items appear on the left side of the map
and pop out as the mouse hovers over the items. They can also be pinned (fixed in place) using the
thumbtack icon on the top right of the windows or clicked and dragged to anywhere on the screen.
The windows are:

Layer Docking Window

Reference Data Docking Window
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Select Docking Window

4.3.1 Layer Docking Window

Layer Docking Window     

The Layer Docking Window allows you to set the current active electrical layer, add electrical layers,
remove electrical layers, modify the visibility of layers and to add or modify background layers.

There are two different types of layers that can be modified in this window. Electrical Layers and
Background Layers.

 

Electrical Layers

Underneath 'Electrical Layers', all of the current electrical layers are listed along
with images denoting their current visibility. By double clicking on a layer you can
view the electrical layer properties dialogue. This dialogue contains all of the
properties that you can set for a layer. Many of these can also be set by right
clicking on the layer in the docking window.

Background Layers

Background layers can be easily modified, like electrical layers. All the background
layers that are currently in this system are listed underneath 'Background Layers'.

Node Types

Using Node Types can set the visibility for specific types of nodes. For example, if
you would like elbows (which are usually switches) to only show when meters are
shown instead of when most switches are shown you can set that rule here. Rules
are evaluated in order, from top to bottom. See the node visibility dialogue for
more information.

Visibility

Visibility designates whether or not you can see any nodes and lines which are on a
particular layer. If this option is turned off, you cannot see anything on that layer. If
it is set to 'on', you can see all the nodes and lines on this layer if it is electrical, or
the map image if it is a background layer. The last setting (Zoom) helps clear up
your working space. This feature makes the layer visible only when zoomed in to a
specific width. This range can be adjusted by using the minimum and maximum
zoom text boxes on the right of the Layer Properties dialogue (whether electrical or
background).

Selectable

You can toggle whether a particular electrical layer is selectable or not. If a layer is
designated as not selectable, you cannot select any of the nodes or lines that are
on the layer. You can still bring up the node dialogue box however, by double-
clicking on the node, and edit the information associated with that node or line. You
cannot select those nodes or lines, and consequently cannot move them, run
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certain analyses on them, track them upstream or downstream, etc.

Active Layer

This is the electrical layer where all of the lines and nodes that are added to the
system are currently added to. You can only have one active layer at a time. This
active layer is shown by having bold text as the title of the active layer.

Edit Layer Properties

This brings up either the Electrical Layer Properties dialogue or the Background
Layer Properties dialogue.

4.3.2 Reference Data Docking Window

The Reference Data docking window contains links to all of the reference data dialogs required to
change your reference data items.



SmartMap122

© 2019 Essex Energy

The reference data is organized according to type
and then according to the order in which the items
were created.

You can add new reference data by using the button
that resembles a series of folders. This control is
located at the top left of the docking window.

You can make a copy of a currently selected
reference item using the icon one to the right of the
add new reference data button.

You can delete a currently selected item by selecting
it and pressing the red 'X'.

You can bring up an item's properties by selecting it
and pressing the far right button. You can also
double-click on an item to bring up its properties
dialogue.

 

4.3.3 Select Docking Window

Select Docking Window     

The Select Docking Window contains information about every node or line that is currently selected.
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You can refresh the selected list at any time by clicking on the
green refresh sign in the top left of the docking window.

This contains the ID's of all of the currently selected nodes and
lines. By double-clicking on any of these ID's your screen will
automatically center on the selected node or line. All of the
currently selected lines will be displayed underneath the 'lines'
heading. Note that the sidebar will not refresh until the green
refresh button if the top left is clicked, so you can keep a selection
of node ID's in the sidebar.

An equally important function of the select docking window is its
ability to copy its currently selected list to the clipboard as simple
text. From this you can save it, allowing you to save your
selections for future reference.

 

4.4 Dialogs

The following sections describe specific details of dialogs in DESS.

Element Dialogs - These are dialogues which appear when creating or editing the properties of
elements.

Capacitor dialogue
Distribution Transformer dialogue
Load Element dialogue
Motor Generator dialogue
Power Transformer dialogue
Protection dialogue
Reactor dialogue
Regulator dialogue
Source dialogue
Switch dialogue

Reference Data Dialogs - These dialogues appear when editing the reference data in the reference
data docking window

Conductor dialogue
Transformer Reference dialogue
Week Type dialogue
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Season dialogue
Load Component dialogue
Load Category dialogue
Protection Type dialogue

Editing Dialogues - These dialogues are accessed through the Editing tab

Change Phasing dialogue
Move Between Layers dialogue
Find Asset dialogue
Set Feeder Names dialogue
Affine Transform Map dialogue
Affine Translate System dialogue
Custom Trace dialogue
Show Loops dialogue
Custom Query dialogue
Query Property dialogue
Import GIS dialogue
Switching Order Dialogue

Analysis Dialogs - These dialogues appear when running an analyses

Arc Flash dialogue

Capacitor Optimization dialogue

Create Loads dialogue

General Short Circuit dialogue

Import Loads dialogue

Label Style dialogue

Line Style dialogue

Load Flow dialogue

Load Loss dialogue

Load Scaling dialogue

Meter Data dialogue

Motor Starting dialogue

Node Style dialogue

Open Point Optimization dialogue

Phase Balancing dialogue

Protection Coordination dialogue

SCADA Load Flow dialogue

SCADA Measurement Data dialogue

Specific Short Circuit dialogue

Change References dialogue

Create References dialogue

Import References dialogue



Reference Guide 125

© 2019 Essex Energy

Organize References dialogue

Simplify Data dialogue

Reset Line Properties dialogue

Copy Substation Info dialogue

Copy Conductor Info dialogue

Create Node Data dialogue

Save Result dialogue

Other Dialogs - These dialogues appear in various areas of the program. Each one explains where it
is accessed.

Options dialogue
System Properties dialogue
Set View dialogue
Save Map dialogue
Electrical Layer dialogue
Background Layer dialogue
Node Visibility dialogue
Node dialogue
Line dialogue

4.4.1 Element Data Dialogues

Information is available for editing each type of element in DESS as follows:

Capacitor dialogue
Distribution Transformer dialogue
Load Element dialogue
Meter dialogue
Motor Generator dialogue
Power Transformer dialogue
Protection dialogue
Reactor dialogue
Regulator dialogue
Source dialogue
Switch dialogue

4.4.1.1 Capacitor Element Dialogue

Description

This dialogue is used for entering data for a capacitor element. It is accessed from the Node dialogue,
by adding a capacitor element or double clicking on an already created capacitor element.

Appearance
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Controls

ID

This is the automatically assigned and unique ID number of the capacitor element.

Node

This is the ID number of the node that the capacitor is attached to.

Phasing

Element phasing. This should be compatible with the phasing of the lines supplying the parent node.

Size

The nominal size of the capacitor bank per phase. This value represents the capacitive power of the
banks with the parent node at nominal voltage. The actual power will vary depending on voltage.

Control Type

How the capacitor is controlled. It is can be one of the following:

Fixed - Capacitor is always on.
Time Controlled - Turns on at a given hour (e.g. On Limit = 12). Turns off later at the specified time
(e.g. Off Limit = 18).
VAr Controlled - Turns on when the line VArs are too high (e.g. On Limit = 500). Turns off when the
VArs are too low (e.g. Off Limit = 100).
Power Factor Controlled - Turns on when power factor too low (e.g. On Limit = .95). Turns off
when the power factor is too high (e.g. Off Limit = .99)
Voltage Controlled - Turns on when the voltage is too low (.e.g. On Limit = .94). Turns off when the
voltage is too high (.e.g. Off Limit = 1.04)
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On and Off Limits

The values of the control variables at which point the capacitor bank is turned on and off (see Control
Type above).

4.4.1.2 Distribution Transformer Dialogue

Description

This dialogue is used for entering data for a distribution transformer element. It is accessed from the
Node dialogue, by adding a distribution transformer element or double clicking on an already created
distribution transformer element.

Appearance

Controls

ID

This is the automatically assigned and unique ID number of the distribution transformer element.

Node

This is the ID number of the node that the distribution transformer is attached to.

Phasing

Element phasing. This should be compatible with the phasing of the lines supplying the parent node
and with any loads attached to the same node.

Tap Position

The tap position in per unit.  A value of 1 is the nominal tap position.  A value greater than 1 boosts
the secondary voltage, and a value of less than 1 reduces the secondary voltage.
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Type

Use this list to select to type of transformer. The drop down box shows a complete list of all available
transformer reference data. Use the Find button to more easily find a specific type of transformer via
the Find Transformer dialogue. The type of transformer you pick must have the correct high voltage
and phasing type (i.e. you cannot put a 3-phase transformer on a single phase line) or you will receive
errors when you try to run an analysis.

Connection

This allows you to specify the connection of the transformer. In most cases the connection will be the
same as specified in the Transformer Reference Data dialogue. However, if you want to represent 3
single-phase transformers connected as a 3-phase transformer, you can specify the 3-phase
connection here.

Address

This text field can store the physical address of an asset for later use and for matching with GIS.

Area

If a distribution system is broken into one or more areas, this field can be used to track which area a
distribution transformer is in.

Owner

The owner of an asset can be indicated in this text field. This is useful if an upstream distributor's
assets need to be modeled.

4.4.1.3 Load Element Dialogue

Description

This dialogue is used for entering data for a load element. It can be accessed from the Node dialogue,
by adding a load element or double clicking on an already created load element.

Appearance
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Controls

ID

This is the automatically assigned and unique ID number of the load element.

Node ID

This is the ID number of the node that the load is attached to.

Load Connection

Choose how the load is connected to the primary system. Usually this will be phase-ground for 4-wire
systems (with a neutral) and phase-phase for 3-wire systems (no neutral conductor).

Phasing

Element phasing. This should be compatible with the phasing of the lines supplying the parent node
and with any distribution transformer attached to the same node.

Load Category

The load category reference data that defines the characteristics and load curves associated with this
load.

Micro-Generation Element

This check box indicates that the load is actually a small generator. This can be used for small solar
sites, back up generators or distributed generation.

Unmetered Load

This check box is used to indicate that a load is not metered, such as streetlights. 
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Load Set Info

The load set data contains the actual load values and periods of load for this load element. For a
typical load that is active throughout the year, you would have one load set per season.

Use the Add button to add a new load set. Use the Edit button or double-click on a row to edit the
data. Use the Delete button to delete the currently selected load set. Adding or editing a load set
brings up the Load Set dialogue.

4.4.1.3.1  Simple Load Dialogue

Description

This dialogue is used for entering data for a load element. It can be accessed from the Node dialogue, by
adding a load element or double clicking on an already created load element.

Appearance

Controls

ID

This is the automatically assigned and unique ID number of the load element.

Node ID

This is the ID number of the node that the load is attached to.

Phasing

Element phasing. This should be compatible with the phasing of the lines supplying the parent node and
with any distribution transformer attached to the same node.

Load Connection

Choose how the load is connected to the primary system.
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Unmetered Load

This check box is used to indicate that a load is not metered, such as streetlights. 

Balanced Load

This indicates that the load on each phase is balanced, an only the three phase kW and kVAr need to be
entered. If this box is not checked off, you may enter the kW and kVAr per phase.

Voltage-Power

This drop-down determines how the load will consume power. There are several options, including a
custom option where the PV and QV can be entered per phase.

4.4.1.3.2  Load Set Dialogue

Description

The load set dialogue lets you enter load data for a particular period of the year. It is accessed from
the Load Element dialogue, by adding a set of load data or double clicking on an already created set of
load data.

Appearance

    

Controls

Season

Choose the season reference data item that defines the period this load is active for.

Load Unit

The unit of measurement of the load that the Loading measures. You can choose from:

Peak kVA - The average peak during the load period. Measured in kVA.
Peak kW - The average peak during the load period. Measured in kW.
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Peak Amps - The average peak during the load period. Measured in Amps.
kWh - The total energy measured in kWh used during the period specified by the Season. For
example, if the season  were summer (June, July August), the loading value would represent the
total kWh used during those 3 months.

Loading

The actual load values on each phase in units specified by Load Unit.

Show Individual Phases

If you have a two or three phase load you have the option of entering the entire load in one text box or
you can enter the load for each phase (picture). If you are entering a balanced load it's usually easier
to enter it as a single total value.

Scaling Factor

An additional scaling factor modifying the loading. This scaling factor can be used to temporarily
change the values of specific loads without losing the original loading values.

4.4.1.4 Meter Dialogue

Description

The boundary meter dialogue is used to enter data for a meter element. It is shown when you create a
new boundary meter from the Node dialogue or double clicking on an already created meter element.

Appearance

General Parameters Tab Controls

ID

This is the automatically assigned and unique ID number of the transformer element.

Node ID

This is the ID number of the node that the meter is attached to.
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TX ID

This is the ID number of the transformer that the meter is attached to.

Phasing

This is the phase of the meter, it is automatically derived from the transformer the meter is attached to.

Meter Info

This information is editable, and represents the customer's information.

4.4.1.5 Motor Generator Dialogue

Description

This dialogue is used for entering the data for a motor generator element. It is accessed from the
Node dialogue, by adding a motor generator element or double clicking on an already created motor
generator element.

Appearance
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Controls

ID

This is the automatically assigned and unique ID number of the motor/generator element.

Node ID

This is the ID number of the node that the motor generator is attached to.

Synchronous / Induction

Determines whether the element represents a synchronous machine or an induction machine. Most
motors are induction machines, and most large generators are synchronous.

Motor / Generator

Determines whether the element represents a 3-phase motor or a 3-phase generator.

Rated Size

Nominal power rating of the machine (kVA). Impedances are specified in p.u. on the rated size.

Zero Sequence Impedance

The zero sequence impedance in p.u. on rated kVA. This, in conjunction with the ground impedance,
affects the zero sequence infeed to a fault.

Negative Sequence Impedance

The negative sequence impedance of the machine in p.u. on rated kVA. This determines the negative
sequence infeed to a fault.

Subtransient Impedance

The subtransient impedance of the machine in p.u. on rated kVA. This determines the positive
sequence infeed to a fault.

Grounded

Check this box if the generator terminals are grounded.

Ground Impedance

The ground impedance if any in Ohms, if the generator is grounded.

Power

The actual power consumption of a motor or power output of a generator. Note that for a synchronous
machine, the voltage regulation will change the actual VAr output as described below. If you want to
specify an exact VAr output for a synchronous generator, set both voltage regulation VAr limits (Min
kVAr and Max kVAr) to the desired reactive power.

The following table describes the meaning of P and Q for different types of machines

Synchronous Machine Induction Machine

Motor Generator Motor Generator

P kW power
consumed

kW power generated kW power consumed at
nominal voltage. Constant
current at other voltages.

kW power generated
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Q Initial value for kVAr generated by
machine. Final value determined by
terminal voltage and Min kVAr and Max
kVAr limits.

kVAr used by induction machine at nominal voltage.
Constant impedance at other voltages.

 

Current Multiple

The multiple of the rated kVA that the motor uses at start up. This is used for Motor Starting analyses
to determine the maximum voltage drop. For motors without any kind of soft start this may be in the
range of 5-6. Different types of soft starting, such as starting capacitors or low-voltage starting can
significantly reduce this value.

Power Factor

The power factor of the motor during start up.  This is used for Motor Starting analyses to determine
the maximum voltage drop. For a motor without any type of soft start this may be as low as .15-.2 .

Voltage Regulation

For synchronous machines, these values specify the maximum range of VArs that the machine can
output in order to regulate the voltage at the output terminal of the generator. These values, combined
with the voltage at the terminal of the machine and the regulator setting will determine the actual VAr
output of a synchronous machine. The input value of Q is only the the starting value before the
analysis starts iterating.

Regulator Setting

The desired per unit value of the voltage at the terminal of the synchronous machine. DESS will
change the VAr output of the machine (within the allowed VAr limits) in order to maintain this voltage.
There is no deadband for generator voltage regulation.

4.4.1.6 Power Transformer Element Dialogue

Description

The power transformer dialogue is used to enter data for a power transformer element. It is shown
when you create a new power transformer using the Editing Tab and existing power transformers can
be edited from the Node dialogue of the HV node of the transformer.

Appearance
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General Parameters Tab Controls

Some of the settings in this dialogue only apply to 3-winding transformers. The term '3-winding
transformer' used below refers to a transformer with one HV primary winding and two secondary
windings which are both connected to LV systems.

ID

This is the automatically assigned and unique ID number of the transformer element.

Node ID

This is the HV node that the power transformer is attached to.

Phasing

The phasing of the transformer

Winding Connection
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The type of connection between the windings:

Wye-Wye
Wye-Delta + 30 - The most common type of YD
Wye-Delta - 30
Delta - Delta
Delta - Wye - 30 - The most common type of DY
Delta - Wye + 30
Wye - delta - Wye - Primary Y, Secondary Y with a D winding between them to reduce fault
currents. (extra impedance information)
Autotransformer - Single winding transformer
Autotransformer with Delta Tertiary (extra impedance information)
Single Phase

Nominal Size

The rated kVA of the transformer. Per Unit impedances are based on this rating.

Forced Cooling

Check this option for transformers which use forced cooling (mixtures of pumps, fans, etc) to allow the
transformer to carry a load greater than the Nominal Size

Maximum Size

This is the maximum rated kVA of the transformer with forced cooling. This is the size which is used to
determine the % Loading on the transformer during various analyses.

Primary Secondary Impedance

The main transformer impedance. For a 3-winding transformer the impedance between the high
voltage winding and the first of the secondary windings.

Primary Tertiary Impedance

The impedance between the high voltage and tertiary windings. This only applies to 3-winding
transformers or transformers with an intermediate tertiary winding (YDY or Autotransformer with D
tertiary).

Secondary Tertiary Impedance

The impedance between the secondary and tertiary windings. This only applies to 3-winding
transformers or transformers with an intermediate tertiary winding (YDY or Autotransformer with D
tertiary).

X0 to X1 Ratio

This ratio is used to represent the different in reactance between the zero sequence (X0) and the
positive sequence (X1). Normally this is 1.0. However, for some transformers there may be a
difference. For example, a value of .95 is sometimes used to represent the slightly lower reactance of
the zero sequence for DY and YD transformers.

Shunt Losses

The no-load transformer losses in kW/kVAr. These losses are independent of transformer loading.

Primary Grounded
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Check this box if the primary winding is grounded. Typically, Y windings attached to a 4-wire system
are generally grounded. Delta windings are not usually grounded although they can be using a zig-zag
grounding transformer.

Primary Neutral Impedance

Impedance of the primary winding grounding. Zero if solidly grounded.

Secondary Grounded

Check this box if the secondary winding is grounded. Typically, Y windings attached to a 4-wire system
are generally grounded. Delta windings are not usually grounded although they can be using a zig-zag
grounding transformer.

Secondary Neutral Impedance

Impedance of the secondary winding grounding. Zero if solidly grounded.

Tertiary Grounded

Impedance of the tertiary winding grounding. Zero if solidly grounded. This only applies to 3-winding
transformers.

Tertiary Grounding Impedance

Check this box if the secondary winding is grounded. Typically, Y windings attached to a 4-wire system
are generally grounded. Delta windings are not usually grounded although they can be using a zig-zag
grounding transformer. This setting only applies to a 3-winding transformer.
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Tap Settings Tab Controls

Tap on HV Winding

Check this if the transformer tap is on the HV winding. Uncheck if the tap is on the LV winding(s). You
cannot directly represent a transformer with taps on both the HV and LV side. To do this, use a power
transformer with an HV tap and add a regulator element next to the LV terminal.

Tap Position

The tap position. If you have an HV tap then a value greater than 1 will reduce the LV voltage and a
value less than 1 will boost the LV voltage. If you have the tap on the LV side then a tap position
greater than 1 will increase the LV voltage.

Tertiary Tap Position

If you have a 3-winding transformer with LV taps, this will let you change the tap on the tertiary
winding.



SmartMap140

© 2019 Essex Energy

Minimum Tap Position

The minimum tap position (used by the automatic voltage regulator to limit tap position travel)

Maximum Tap Position

The maximum tap position (used by the automatic voltage regulator to limit tap position travel)

Tap Step Size

The p.u. size of the tap step. If your tap steps are quoted as voltages you will need to convert them.
For example, taps on a 44kV winding of 44000V, 45100V, 46200V, 47300V would correspond to a
minimum tap of 1.0, and maximum tap of 1.075 and a tap step of .025 p.u.

Automatic Tap Changer

Check this box if the transformer has an automatic tap changer with voltage regulation.

Setting

The p.u. voltage setting on the secondary side of the transformer. The voltage regulator will try to
maintain this voltage by changing taps. For example, setting a value of 1.0 will cause the regulator to
try and maintain nominal voltage on the secondary.

Deadband

Automatic voltage regulator dead band. This represents the size of change that is required to trigger a
tap step change. No tap change will occur while the difference between the node voltage and the
Regulator Settings is less than the size of the deadband. Typically, the size of the deadband should be
larger than the tap step size, otherwise it may cause 'hunting' where the tap setting becomes unstable
and a load flow analysis cannot find a final solution.

Tertiary Winding is Regulated

If you have a 3-winding transformer and the voltage regulation is based on the voltage at the tertiary
winding, check this box. If the box is unchecked, it is assumed that voltage regulation on a 3-winding
transformer is based on the voltage at the secondary winding.

Line Drop Compensation

Check this box to make use of line drop compensation for voltage regulation. Line drop compensation
is a way to make the voltage regulator act as if it is regulating a point downstream of the regulator
where the voltage drop between the regulator and the desired control point is equal to the specified
values.

Real Voltage

The p.u. real voltage drop between the regulator location and the desired control location.

Reactive Voltage

The p.u. reactive voltage drop between the regulator location and the desired control location.

4.4.1.7 Protection Element Dialogue

Description

This dialogue is used for editing data for a protective element. This dialogue is accessed from the
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Node dialogue, by adding a protection element or double clicking on an already created protection
element.

Appearance

For relays and then for fuses:
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Hint:
Unlike most data dialogs, you can  change the size of the Protection data dialogue. Put your
mouse over the edge of the dialogue and drag. You can do this to make the graph bigger
and easier to see.

General Controls
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ID

This is the automatically assigned and unique ID number of the protection element.

Node

This is the ID number of the node that the Protection element is attached to.

Device Type

Shows a list of protection reference devices (fuses, relays, etc) defined in the reference data.

Fuse Settings

When a fuse is selected (as shown at right above), the following settings are available:

Current Modifier Multiple

Sets the current multiple override for this type of fuse. Normally set at 1.0 to represent standard fuse
operation. Can be set to less than 1.0 to represent the faster operation of a partially melted fuse.

Relay Settings

When a relay is selected (as shown at left above), the following settings are available:

Relay Elements

Shows one or more relay elements defined for this device.

Use the Add button (Yellow Plus) to add a new item and display options in the Relay Settings dialogue

Use the Edit button (Pencil), or double-click on an existing item to edit the item.

Use the Delete button(Red 'X') to delete the item.

4.4.1.7.1  Relay Setting Dialogue

Description

This dialogue lets you choose a settings group for a relay curve. It is accessed from the Protection
Element dialogue, by adding a relay setting (by clicking the yellow plus button) or by double clicking on
an already created relay setting.

Appearance
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Controls

Setting Type

The specific setting type. Settings for the same phase group and operation type are combined on time-
current graphs, so permanent settings for 51P and 50P would be combined, as would 51N and 50N

Operation Type

Lets you choose either normal permanent breaker settings or initial settings for reclose operations.

Curve Element

The type of curve to use for this condition. All curves available from the Protection Reference data are
shown in the list.

CT Ratio

CT stands for Current Transformer. This is the current transformer ratio to use for this relay setting.

Tap Setting

The tap setting of this curve. Larger values of tap setting shift the curve to the right, and vice versa.

Time Dial

The time dial setting of this curve. Generally, larger values of time dial shift the curve up, and vice
versa.
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4.4.1.8 Reactor Element Dialogue

Description

This dialogue is used for entering data for a reactor element. It is accessed from the Node dialogue,
by adding a reactor element or double clicking on an already created reactor element.

Appearance

Controls

ID

This is the automatically assigned and unique ID number of the reactor element.

Node

This is the ID number of the node that the reactor element is attached to.

Rating

The nominal rating of the reactor. Used for calculating impedance.

Positive Sequence Impedance

The positive sequence impedance of the series reactor in p.u. on rated kVA. The negative sequence
impedance is equal to this.

Zero Sequence Impedance

The zero sequence impedance of the reactor. This value can allow you to use the reactor as an
arbitrary unbalanced impedance on the system. In most cases this value should be the same as the
positive sequence impedance.

4.4.1.9 Regulator Element Dialogue

Description

This dialogue is used for entering data for a regulator element. It is accessed from the Node dialogue,
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by adding a regulator element or double clicking on an already created regulator element.

Appearance

Controls

ID

This is the automatically assigned and unique ID number of the regulator element.

Node ID

This is the ID number of the node that the regulator element is attached to.

Phasing

Element phasing. The phasing should be consistent with the phasing of the lines supplying the parent
node.

Rating

Regulator rating in kVA. Note that the rating of a regulator is usually much smaller than the power
being regulated.

Tap Position
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Regulator tap position in p.u. A tap position greater than 1 boosts the downstream voltage. A tap
position less than 1 bucks the voltage.

Minimum Tap Position

The minimum tap position in p.u. (affects automatic voltage regulation).

Maximum Tap Position

The maximum tap position in p.u. (affects automatic voltage regulation).

Tap Step Size

Size of each tap step in p.u.

Sequence Impedances

The sequence impedances of the regulator in p.u. on kVA rating. Typical regulator impedances are
very small and can be left as zero if desired.

Automatic Regulation

Check if the regulator tap should be automatically changed to maintain the desired downstream
voltage.

Regulator Setting

The desired p.u. voltage on the secondary side of the regulator.

Regulator Deadband

Automatic voltage regulator dead band. This represents the size of change that is required to trigger a
tap step change. No tap change will occur while the difference between the node voltage and the
Regulator Settings is less than the size of the deadband.

Line Drop Compensation

Check this box to make use of line drop compensation for voltage regulation. Line drop compensation
is a way to make the voltage regulator act as if it is regulating a point downstream of the regulator
where the voltage drop between the regulator and the desired control point is equal to the specified
values.

Real Voltage

The p.u. real voltage drop between the regulator location and the desired control location.

Reactive Voltage

The p.u. reactive voltage drop between the regulator location and the desired control location.

4.4.1.10 Source Element Dialogue

Description

This dialogue is used for entering data for a source element. It is accessed from the Node dialogue, by
adding a source element or double clicking on an already created source element.

Appearance
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Controls

ID

This is the automatically assigned and unique ID number of the source element.

Node

This is the ID number of the node that the source element is attached to.

Voltage

Actual voltage supplied from the source in volts. This will typically be different than the nominal voltage
of the layer containing the source node.

Angle

Source angle with respect to the arbitrary zero degrees. You would use a non-zero source angle if you
had two or more sources with a measurable difference in supply voltage angle. This would allow you
to model the effect of closing a switch between the two regions supplied from the different sources.
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Impedances

The sequence impedances of the source, representing the impedance of the transmission system,
measured in p.u. on 100 MVA. Typically, the positive sequence and negative sequence impedances are
identical.

The maximum impedance values give the lowest fault current levels on the system and the minimum
impedances give the largest fault current levels in the short circuit analysis.

If you have fault levels at the source or impedances on a different base you can calculate the required
impedances in p.u. at 100 MVA. See Converting Source Impedances.

4.4.1.11 Switch Element Dialogue

Description

This dialogue is used for entering data for a switch element. It can be accessed from the Node
dialogue, by adding a switch element or double clicking on an already created switch element.

Appearance

Controls

ID

This is the automatically assigned and unique ID number of the switch element.

Node ID

This is the ID number of the node that the switch is attached to.

Phasing

The phasing of the switch element represents the phases that can be switched. If you include extra
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phases which are not present in adjacent lines they will be ignored.

Area

If a distribution system is broken into one or more areas, this field can be used to track which area a
switch is in.

Owner

The owner of an asset can be indicated in this text field. This is useful if an upstream distributor's
assets need to be modeled.

Switch Status

Specify the status of the switch. Normally you would choose either Open or Closed. However, you can
simulate partial switching by choosing which phases of the switch are open.

4.4.2 Reference Data Dialogues

Information regarding properties and editing for reference data is available for each type of data:

Conductor dialogue
Transformer Reference dialogue
Week Type dialogue
Season dialogue
Load Component dialogue
Load Category dialogue
Protection Type dialogue

4.4.2.1 Create Reference Dialogue

Description

This dialogue is used for creating new conductor data and transformer data. It is accessed from the
Analysis tab, under References > Create References.

Appearance
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Controls

ID

The unique ID of this reference data item. Automatically assigned.

Description

User description of the conductor. This description appears whenever the user needs to select a
conductor, such as in the line dialogue.

4.4.2.2 Conductor Data Dialogue

Description

This dialogue is used for editing conductor data. It is accessed from the Conductors section of the
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Reference docking window either by adding a new reference or double clicking on a reference which
was already created. This data is used from the Line dialogue.

Appearance

Controls

ID

The unique ID of this reference data item. Automatically assigned.

Description

User description of the conductor. This description appears whenever the user needs to select a
conductor, such as in the line dialogue.
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Material

The conductor material. Choose from:

Unknown
Copper - solid or stranded copper conductor
Aluminum - aluminum or aluminum alloy conductor
ACSR - aluminum core steel reinforced conductor
Steel - steel stranded or solid connection (busbar)

Nominal Voltage

The nominal phase-phase voltage of the layer where this type of conductor will be used. This is not
necessarily the same as the rated voltage of a cable. For example, if you had a cable that is rated at
15kV but is being used at 13.8kV, you would enter 13800 here.

Overhead Line / Underground Cable

Choose whether this represents an overhead conductor bundle or an underground cable.

Cross Section

Cross-sectional area of the phase conductor.

Note:
The data for description, material, nominal voltage, overhead/underground and cross-
section is only used for descriptive purposes and for purposes of showing themes and
performing queries. These data items have no actual effect on analysis calculations.

Positive Sequence Impedance

Zero Sequence Impedance

The positive and sequence impedance of the conductor bundle or cable in ohms/km. These values
implicitly include the effects of conductor size, neutral size and conductor spacing. For single-phase
lines the zero sequence impedance should equal the positive sequence impedance.

Charging Capacitance

The kVAr equivalent of the capacitance per km per phase. This effect is more prevalent at higher
voltages (proportional to the square of the voltage).

Damage Curve

This allows you to enter the damage curve for the conductor. It will be used during protection
coordination.

Max Insulation Temp.

The maximum temperature that the insulation on a conductor can withstand. This will be used during 
protection coordination.

Initial Operating Temp.

The initial temperature of the conductor for analysis purposes.

Ratings (Hot, Cold, Emergency)

The rated cable ampacities at hot (40C) and cold weather (-10C) conditions. The emergency ratings
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are the ratings allowed for short durations (one-two hours).

If you choose different ratings for hot and cold then the line loading (% of rated capacity) in the
analysis results will make use of the different ratings. For example, consider a line with a hot rating of
300A and a cold rating of 400A. If the line was carrying 150A at a 40C ambient temperature, the
loading would be 50%. If it was carrying 150A at -10C, the loading would only be 37.5%.

4.4.2.2.1  Find Conductor Dialogue

Description

This dialogue is used to help select a particular conductor. It is called from the Line Data dialogue (and
from some of the utilities).

Appearance

Controls

Criteria

Use the different criteria to select characteristics of the conductor you want to find. For each criteria
(nominal voltage, location, material), you can choose a specific value in order to reduce the size of the
list of matching items.

Matching Items

This list shows the types of conductor which match the specified criteria. Once you have selected one
of these items in the list you can click OK to choose that item.
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OK

Chooses the selected item. OK is only enabled when you have make a selection from the Matching
Items list.

4.4.2.3 Transformer Reference Data Dialogue

Description

This dialogue is used for editing distribution transformer reference data. It is accessed from the
Transformers section of the Reference docking window either by adding a new reference or double
clicking on a reference which was already created. This data is used from the Distribution Transformer
Element dialogue.

Appearance

Controls
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ID

The unique ID of this reference data item. Automatically assigned.

Description

User description of the transformer type. This description appears whenever the user needs to select a
transformer, such as in the distribution transformer dialogue.

Winding Connection

The connection between the high and low voltage windings. For YD and DY transformers the most
common connections are listed first (Wye-Delta +30 and Delta-Wye -30) The degree angle refers to
the angle of the secondary voltage relative to the angle of the primary voltage.

You should select the actual connection for a single transformer here. If you want to represent 3
single-phase transformers connected as a 3-phase transformer, select a Single Phase connection
here, and specify the 3-phase connection in the distribution transformer dialogue.

Size

The size of the transformer in kVA. This is used to calculate impedances which are input as p.u. on
transformer size.

Mounting

The location of the transformer. Not used for analysis purposes but can be useful for queries and node
style themes. Choices are:

Unknown
Pad - mounted at grade, usually on a concrete pad
Pole - mounted on a pole, usually supplied by overhead lines
Vault - mounted below grade
Submersible - a submersible transformer, usually below grade

Fuse

This drop down allows you to select the fuse type which will be protecting the transformer. This will be
used during protection coordination.

Damage Curve

This drop down allows you to select the damage curve for the transformer. This will be used during 
protection coordination.

Nominal 3 Phase Voltages

The high voltage is the nominal phase-phase voltage of the layer where this transformer will be used.
The low voltage is the nominal phase-phase voltage of the transformer secondary.

Hint:
Voltages in DESS are always input as phase-phase values, even if the equipment being
described is only being used on single-phase areas of the system.

Shunt Losses

The no-load losses for the transformer. This losses are independent of the transformer loading.

Tap on HV Winding
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Check if the tap is on the HV winding, uncheck if on the LV winding.

Total Impedance

The short circuit impedance between the primary and secondary windings, in p.u. on transformer size.

High-Tertiary Impedance

The impedance between the high voltage and tertiary windings. This only applies to transformers with
an intermediate tertiary winding (YDY or Autotransformer w/ D tertiary).

Low-Tertiary Impedance

The impedance between the low voltage and tertiary windings. This only applies to transformers with
an intermediate tertiary winding (YDY or Autotransformer w/ D tertiary).

HV Neutral Grounded

Check this box if the HV winding is grounded. Typically, Y windings attached to a 4-wire system are
generally grounded. Delta windings are not usually grounded although they can be using a zig-zag
grounding transformer.

HV Neutral Impedance

Impedance of the HV winding grounding. Zero if solidly grounded.

LV Neutral Grounded

Check this box if the LV winding is grounded. Typically, Y windings attached to a 4-wire system are
generally grounded. Delta windings are not usually grounded although they can be using a zig-zag
grounding transformer.

LV Neutral Impedance

Impedance of the LV winding grounding. Zero if solidly grounded.

4.4.2.3.1  Find Transformer Dialog

Description

This dialogue is used to help select a particular distribution transformer type. It is called from the 
Distribution Element dialogue (and from some of the utilities).

Appearance
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Controls

Criteria

Use the different criteria to select characteristics of the distribution transfomer you want to find. For
each criteria (high voltage, size, winding and low voltage), you can choose a specific value in order to
reduce the size of the list of matching items.

Matching Items

This list shows the types of transformer which match the specified criteria. Once you have selected
one of these items in the list you can click OK to choose that item.

OK

Chooses the selected item. OK is only enabled when you have make a selection from the Matching
Items list.

4.4.2.4 Protection Type Reference Data Dialogue

Description

This dialogue is used for editing protection reference data items. It is accessed from the Protection
Types section of the Reference docking window either by adding a new reference or double clicking on
a reference which was already created. The protection element dialogue allows you to select an item
of this type.

Appearance (for Fuses, Relays, Reclosers and damage
curves)
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Controls

ID

Unique ID of the reference data item. Automatically assigned.

Description

User description of the type of protective device.

Fuse / Relay / Recloser / Transformer Damage Curve / Conductor Damage Curve

Choose the type of device to model.

A fuse lets you model a single curve with melt and clear curves. When you create a new fuse you only
have to option to override the  current scaling.



Reference Guide 161

© 2019 Essex Energy

A relay, reclosure or damage curve lets you model a number of curve elements, each of which can
contain a set of curves, or an equation defining a set of curves, such that the curve element response
to time dial setting can be modeled. When you create a protection element defined as a relay you can
pick which of the curve elements (e.g. inverse, instantaneous) to use, and can set time dial, CT ratio
and tap setting.

Melt Curve

For fuses, this brings up the Time Current Curve Points dialogue so you can enter the fuse melt curve.
This is the lower curve defined for fuses which represents the time-current for which the fuse will start
to melt.

Clear Curve

For fuses, this brings up the Time Current Curve Points dialogue so you can enter the fuse clear curve.
This is the upper curve for fuses which represents the time-current for which the fuse finishes melting
and opens.

Device Curve Elements

This list shows the currently defined curve elements for a relay type of protection. Use the Equation
button to define a new curve element defined by an equation (often used to model electronic relays)
via the Equation Based Relay Element dialogue. Use the Digitized button to define a new curve element
defined by a set of digitized curves (often used to model electromechanical relays) via the Digitized
Relay Element Data dialogue. Use the Edit and Delete buttons to remove selected curve elements.

Graph

The time-current graph shows any curves defined for this type of protection. If there are multiple
curves (for a relay), the currently selected item is shown in red and the others in black.

4.4.2.4.1  Time Current Curve Points Dialogue

Description

This dialogue is used to manually enter the points that define a time current curve. It is accessed from
the Protection Type Reference Data dialogue for fuses, and from the Digitized Relay Element Data
dialogue for relays.

Appearance
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Controls

Point List

This list shows the time, current points that define the curve displayed in the graph. You can edit these
points directly in the list. You can also cut and paste items directly into the list. Use the Format Data
button to format data as shown above such that each point is on its own line with the current and time
separated by a comma.

To cut and paste data into the list it is only necessary to have a list of points arranged in order of
current1, time1, current2, time2, etc... The values can be separated by either commas or white space
(space, tab, new line). You will find that you can cut and paste data directly from spreadsheets
arranged with a column of current values followed by a column of time values.

For example, if you had a text file containing the following values:

curr1 time1 curr2 time2 curr3 time3 curr4 time4

if you paste it into the list and click the Format Data button, it would appear as:

curr1,time1

curr2,time2

curr3,time3
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curr4,time4

Graph

Shows the graph defined by the points in the list. As the data changes the curve will automatically be
updated.

4.4.2.4.2  Digitized Relay Element Data Dialogue

Description

This dialogue lets you edit a relay curve element defined by a set of individual digitized time-current
curves. It is called from the Protection Type Reference Data dialogue for relays and calls the Time
Current Curve Points dialogue.

Appearance
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Controls

Name

The name of this curve element within a relay or recloser.

Error

The percent error band around an input value. For example, if you specify 10%, the time values shown
on the graph will be +/- 10% of the nominal input value. If the value is 0%, the curves shown on the
graph will be a simple line with no area.

Time Dial Range

You can specify whether the time dial values are continuous or limited to specific values. For example
if you input two curves for Time Dial = 1 and Time dialogue = 5 and specified a continuous range, the 
protection element settings would allow you to choose a time dial such that 1 <= time dial <= 5. If you
choose specified values of 1,2,3,4,5 then in the protection element settings you could only choose one
of these 5 time dial values.

Curves

This list shows all the curves defined in this set of curves. The currently selected curve is shown in
red. Adding a new curve or editing the existing curve brings up the Time Current Curve Points
dialogue.

4.4.2.4.3  Equation Based Relay Element Data Dialogue

Description

This dialogue is used to enter data for a relay curve element that is defined by a mathematical
equation (instead of just digitized points). It is accessed from the Protection Type Reference Data
dialogue.

Appearance
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Controls

Name

The name of this curve element.

Equation

Enter the equation that defines the curve. It is of the form time = f(current, time dial). Use 'i' for
current and 'td' for time dial as variable names.

Time Dial Range

You can specify whether the time dial values are continuous or limited to specific values. For example
if you input two curves for Time Dial = 1 and Time dialogue = 5 and specified a continuous range, the 
protection element settings would allow you to choose a time dial such that 1 <= time dial <= 5. If you
choose specified values of 1,2,3,4,5 then in the protection element settings you could only choose one
of these 5 time dial values.
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Error

The percent error band around an input value. For example, if you specify 10%, the time values shown
on the graph will be +/- 10% of the nominal input value. If the value is 0%, the curves shown on the
graph will be a simple line with no area.

4.4.2.5 Week Type Reference Data Dialogue

Description

This dialogue is used for editing week type reference data items, which form part of the data for load
modeling. It is accessed from the Week Types section of the Reference docking window. This data is
used in the Load Category dialogue and sub-dialogs.

Appearance

Controls

ID

Unique ID of the reference data item. Automatically assigned.

Description

User description of the portion of a week.

Days

Select which days are associated with this part of a week.



Reference Guide 167

© 2019 Essex Energy

4.4.2.6 Season Type Reference Data Dialog

Description

This dialogue is used for editing season type reference data items, which form part of the data for
load modeling. It is accessed from the Season Types section of the Reference Docking Window. This
data is used in the Load Element dialogue and the Load Category dialogue and sub-dialogues.

Appearance

Controls

ID

Unique ID of the reference data item. Automatically assigned.

Description

User description of the portion of a year.

Months

Select which months are associated with this part of a week.

Night Temperature

The average night temperature during this time of year. When load categories are set to be scaled
according to temperature, the scaling factor is computed based on the difference between the ambient
temperature and this temperature. Night temperatures are in effect from 9PM to 10AM.

Day Temperature

The average day temperature during this time of year. When load categories are set to be scaled
according to temperature, the scaling factor is computed based on the difference between the ambient
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temperature and this temperature. Day temperatures are in effect from 10AM to 9PM.

4.4.2.7 Load Component Reference Data Dialogue

Description

This dialogue is used for editing load component reference data items, which form part of the data for
load modeling. It is accessed from the Load Components section of the Reference docking window.
Load components are used in the Load Component Data dialogue, which is part of the Load Category
dialogue.

Appearance

Controls

ID

Unique ID of the reference data item. Automatically assigned.

Description
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User description of the load component.

PV Factor

The relationship between voltage and real power for this type of load. The actual power produced is
the nominal power times the p.u. voltage raised to this factor:

                               

A value of 0 means that the power is independent of voltage (constant power). A value of 1 means
power is proportional to voltage (constant current), and a value of 2 means power varies with the
square of the voltage (constant impedance).

QV Factor

The relationship between voltage and reactive power for this type of load. The actual power produced
is the nominal power times the p.u. voltage raised to this factor:

                               

A value of 0 means that the power is independent of voltage (constant power). A value of 1 means
power is proportional to voltage (constant current), and a value of 2 means power varies with the
square of the voltage (constant impedance).

Power Factor

The power factor of the load (lagging). There is no way to specify a component with a leading power
factor.

Motor Factor

The proportion of the load composed of motors. This affects re-energization after an outage (cold load
pickup) because motors draw an especially large load during the first few seconds of start up.

Reenergization Factor

The proportion of the load energized during re-energization. For some loads such as heating and air
conditioning this value will be greater than 1.0 due to a loss of load diversity during an outage. For
other loads, such as certain industrial load, the value will be less than 1.0 as loads will not be
automatically applied during re-energization but will be manually started later.

Graph

The graph shows the load variation over a 24-hour period. Note that the graph should be normalized
so that the peak is always 1.0 (top of the graph). You can edit the graph values by using the Hour and
Value controls or you can use the mouse to drag the top of each bar.

Hour

The hour of the day, ranging from 0 (12 AM midnight) to 23 (11 PM).

Value

The value of the current bar (shown in graph and listed in Hour) as a value between 0 (no load) and 1
(peak).
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4.4.2.8 Load Category Reference Data Dialogue

Description

This dialogue is used for editing load category reference data items, which form part of the data for
load modeling. It is accessed from the Load Categories section of the Reference Docking Window.
The load element dialogue allows you to select the load category for a specific load.

Appearance

Controls
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ID

Unique ID of the reference data item. Automatically assigned.

Description

User description of the load category.

Load Curves

Edit the set of curves which define how the load varies over a given 24 hour period. You can enter a
separate curve for any combination of season type and week type defined. You must enter data that
exactly covers an entire year.

Use the add button to add data for a new period and use the delete button to delete the currently
selected data. You can edit a set of data by clicking on the period of the year containing the data to
modify or selecting the period from the list and clicking the edit button.

Curve data and the period for each curve is edited using the Load Curve Data dialogue.

Load Components (Optional)

Use this control to edit sets of components that define subcomponents of the load which are applicable
to different periods of the year. You do not need to enter load components, they can be left empty if
you don't have any information for subcomponents of the load category.

Use the add button to add data for a new period and use the delete button to delete the currently
selected data. You can edit a set of data by clicking on the period of the year containing the data to
modify or selecting the period from the list and clicking the edit button.

Load components and the period they apply for is edited using the Load Component Data dialogue.

Load Characteristics

This control lets you define load characteristics for a given period. Load characteristics include
parameters like power factor, load response to voltage and re-energization details. You must enter
data that covers the entire year. This can be a single item which applies for the whole year or multiple
items so that different data (such as power factor) applies for different periods of the year.

Use the add button to add data for a new period and use the delete button to delete the currently
selected data. You can edit a set of data by clicking on the period of the year containing the data to
modify or selecting the period from the list and clicking the edit button.

Load characteristic data and the period it applies to is edited using the Load Characteristic Info
dialogue.

4.4.2.8.1  Load Curve Data Dialogue

Description

This dialogue is used to edit 24-hour load curves. It is accessed from the Load Category dialogue and
help define load category reference data items.

Appearance
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Controls

Season

The part of the year that this curve applies to.

Week

The part of the week that this curve applies to.

Relative Scaling

The size of the peak for this curve relative to the size of the peak for other curves. For example, if
weekend loads are substantially smaller than weekday loads, then you might have a weekday curve
with a scaling factor of 1 and a weekend curve with a scaling factor of 0.75.

Has Reactive Curves

Check this box if you want to define both real and reactive curves for the load. If you do define both
real and reactive curves, the relationship between the two curves will override any settings for power
factor elsewhere in the load category data.

Real Curve

The 24 hour curve for real power. The curve is normalized so it should have a peak value of 1.0

Reactive Curve

This graph represents the 24 hour curve for reactive power. You can use this definition to model
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changing power factor over a 24-hour period. Positive values represent lagging or inductive reactive
load (normally the case), and negative values represent leading or capacitive reactive power. The
combination of the real and reactive curves define the power factor during the specified period.

Bar

The hour currently selected in the appropriate graph.

Current Value

The value of the currently selected bar.

4.4.2.8.2  Load Component Data Dialogue

Description

This dialogue is used to edit load components sets. It is accessed from the Load Category dialogue and
helps to define load category reference data items.

Appearance

Controls



SmartMap174

© 2019 Essex Energy

Season

The part of the year this data applies to.

Week

The part of the week that this data applies to.

Scaled Components

A list of load components currently part of this set of data along with the scaling factor. The resultant
curve shown on the graph is the load component graph multiplied by the scaling factor.

Add

Add a new type of component to this set.

Edit

Bring up the Load Component dialogue for editing the data for the currently selected item. You can
also double-click on a row of the list bring up the dialogue.

Delete

Delete the currently selected component from this set.

Edit Scaling

Edit the scaling factor for the currently selected component. Push the Update button to set the value.

Graph

The graph shows each individual scaled load component in blue, and the total of all the scaled load
components is shown as a red line. To be valid, the total of the load components should be less than
any of load curves that exist for the same period.

4.4.2.8.3  Characteristic Info Dialogue

Description

This dialogue is used to edit load characteristics. It is accessed from the Load Category dialogue and
help define load category reference data items.

Appearance
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Controls

Season

The part of the year this data applies to.

Week

The part of the week that this data applies to.

Power Factor

The default power factor (lagging) for the load category.

If load components have been defined for this category, they will have their own power factor
information and this value will only apply to that portion of the load not covered by components.

Furthermore, if load curves for this category have both real and reactive curves defined, this value is
ignored completely. The ratio of real to reactive curve values will determine the power factor. Using
real and reactive curves is also the only way to define a load with a leading power factor.

PV Factor

The default PV factor for this load.

If load components have been defined for this category, they will have their own PV values and this
value will only apply to that portion of the load not covered by components.

The relationship between voltage and real power for this type of load. The actual power produced is
the nominal power times the p.u. voltage raised to this factor:

                               

A value of 0 means that the power is independent of voltage (constant power). A value of 1 means
power is proportional to voltage (constant current), and a value of 2 means power varies with the
square of the voltage (constant impedance).

QV Factor
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The default QV factor for this load.

If load components have been defined for this category, they will have their own QV values and this
value will only apply to that portion of the load not covered by components.

The relationship between voltage and reactive power for this type of load. The actual power produced
is the nominal power times the p.u. voltage raised to this factor:

                               

A value of 0 means that the power is independent of voltage (constant power). A value of 1 means
power is proportional to voltage (constant current), and a value of 2 means power varies with the
square of the voltage (constant impedance).

Reenergization Factor

The proportion of the load energized during re-energization. For some loads such as heating and air
conditioning this value will be greater than 1.0 due to a loss of load diversity during an outage. For
other loads, such as certain industrial load, the value will be less than 1.0 as loads will not be
automatically applied during re-energization but will be manually started later.

Motor Factor

The proportion of the load composed of motors. This affects re-energization after an outage (cold load
pickup) because motors draw an especially large load during the first few seconds of start up.

Day Factor

This factor determines how much the temperature affects the load. A positive factor will increase the
load as the analysis temperature exceeds the season temperature. The day factor affects the period of
9AM to 10PM.

                               

The load scaling is equal to the exponential of the factor multiplied by the temperature difference in
Celsius. The graph below shows the resultant scaling factors for four different factors for temperature
differences between 0 and 30C.
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Night Factor

This factor determines how much the temperature affects the nighttime load between the hours of
10PM to 9AM. The factor calculations and scaling relationships are the same as for Day Factor.

4.4.3 Editing Dialogues

The following dialogues are associated with commands on the Editing Tab in DESS which update the
state or contents of the model.

Editing Dialogues:

Change Phasing dialogue
Move Between Layers dialogue
Find Asset dialogue
Set Feeder Names dialogue
Affine Transform Map dialogue
Affine Translate System dialogue

Trace Options Dialogues:
Custom Trace dialogue

Query Dialogues:
Show Loops dialogue
Custom Query dialogue
Query Property dialogue

Modules Dialogues:
Import GIS dialogue
Switching Order Dialogue
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4.4.3.1 Change Phasing Dialogue

Description

This tool lets you change the phasing on a set of nodes and lines. Select the nodes and lines you want
and then use this dialogue to change the phasing of the lines and any elements on the nodes. The
most common use of this tool is to select a single-phase spur and change it to another phase as part
of a phase balancing study. This dialogue is shown from the Editing > Change Phasing command.

Note that you cannot undo this operation so it's important to confirm your actions, and/or save your
work before doing this.

Appearance

Controls

Existing Phasing

This list gives you detailed information on the existing phasing of the selected lines and elements on
the selected nodes. Use this information to confirm the phasing of the items you will be changing and
ensure that you have not inadvertently selected extra or wrong items.

New Phasing

Select the new phasing for lines and elements.
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4.4.3.2 Move Between Layers Dialogue

Description

This tool allows you to move a group of selected nodes and lines from one electrical layer to another.
You might want to do this to correct import errors or as part of a simulation for upgrading the voltage
for part of a network. After moving the items you may want to change references for conductors and
transformers using the  Change References tool.

You can use this tool by selecting the group of connected nodes and lines you want to move and then
choosing the Move Between Layers command from the Editing tab.

Appearance

Controls

Items to move

This shows the number of currently selected nodes and lines which will be moved to a new electrical
layer.

Current layer of items

This shows the current electrical layer(s) of the selected nodes and lines.

Orphan Selected Lines

This shows the number of selected lines which will be deleted by this operation. If a selected line has
an end node which is not part of the selection it cannot be moved and will be deleted.

Orphan Unselected Lines

This shows the number of non-selected lines which will be deleted by this operation. If an unselected
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line has an end node which is part of the selection it will be deleted in order to prevent problems with 
connectivity.

New layer

Select the layer you want to move the group of nodes and lines to.

OK

Click OK to perform the move operation. This process cannot be reversed with the Undo command.

4.4.3.3 Find Asset Dialogue

Description
This dialogue help you to find a specific node (or nodes) on the distribution system. You can find a
node in four different ways as described below (either by ID, by Name/Description, or from a list). You
can access this dialogue from the Editing tab, or by using Ctrl+F. Other dialogues will sometimes use
this dialogue to find an asset.

Appearance

Controls

Search

This drop-down will filter the results by the type of node selected. All asset types are available, and
each asset type may have different columns if a different column type is relevant. Click GO to apply the
drop-down selection.

Filter By

This is a text box which will filter the results of all visible columns by the text entered.

Columns
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This control allows you to choose which columns you can see in the view. By selecting and deselecting
check-boxes you can add or remove columns.

Filter Column

The funnel icon next to the column name will open a special filter which will be applied to that column
only. It can filter by almost any criteria.

OK

This will close the Find Asset window and move the model to center on the asset. You can also
double-click to achieve the same result. Note that the program will not change the zoom level.

4.4.3.4 Set Feeder Names Dialogue

Description
This tool allows you to name selected lines or all lines with the name of a feeder. The tool is very useful
for quickly checking what feeder a line belongs to. It can also be set to automatically update the line
names automatically after a switch change. If more than one feeder is powering a line, both feeder
names will be assigned to the line.

You can use this tool by selecting the group of connected nodes and lines you want to update or simply
opening the Set Feeder Names command from Extra Tools in the Editing tab.

Appearance
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Controls

Set Names for Currently Selected Lines

This shows the number of currently selected lines which will be renamed.

Line Name

This text box allows you to enter what the set of lines will be named.

Set Feeder Names for Entire System

This allows you to re-name all of the lines in the system, whether you currently have some selected or
not.

Automatically Do This

This enables the Set Feeder Names to run each time a switch is changed. Changing a switch position
could potentially change which feeder a line is on, so setting this automatically would ensure that the
feeder line names are always correct.

Node Attribute

This allows you to choose which field, node name or node description, will determine that a node is a
feeder.

Prefix

If a node's name or description, depending on which is selected above, starts with the prefix in the text
box it will be considered a feeder. Lines downstream will be named with the text which comes after the
prefix. For example, with the prefix WM and a node named WM3M9, all lines would be named 3M9.

OK

Click OK to perform the move operation. If you have checked off Automatically Do This, the command will
run on its own from now on.

4.4.3.5 Affine Transform Map Dialogue

Description
This tool allows you to shift and rotate the model. After a GIS import, or changing from XY to Latitude
and Longitude, the model may not be positioned exactly as it should. 

You can use this tool by opening the Affine Transform Map command from Extra Tools in the Editing
tab.

Appearance
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Controls

Current DESS Coordinate

Enter the current XY or latitude and longitude coordinates into these text boxes.

New Coordinate

Enter the updated coordinates which correspond to the current coordinates which were just entered into
these text boxes.

Add New

This adds the current and new set of coordinates to a list which the program uses as reference points to
shift the model. At least three sets of points must be entered before the command can be executed.

Automatically Do This

This enables the Set Feeder Names to run each time a switch is changed. Changing a switch position
could potentially change which feeder a line is on, so setting this automatically would ensure that the
feeder line names are always correct.

Set

This allows you to update the values of a previously entered point set with the current values in the text
boxes.
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Delete

This will delete whichever point set is currently selected.

OK

Click OK to perform the move operation. Note that depending on model size, this operation could take
some time.

4.4.3.6 Affine Translate System Dialogue

Description
This tool allows you to change a model from XY to latitude and longitude. 

You can use this tool by opening the Affine Translate System command from Extra Tools in the
Editing tab.

Appearance
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Controls

Load System

This will open a browse window which will allow you to choose a XY model to translate.

Center Coordinates

The center coordinates for the XY system will be automatically populated. Enter the corresponding center
latitude and longitude coordinates.

Preview
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This will do a preliminary translation. The model and a map will appear in the preview window.

Left Click on Map

Left clicking will allow you to click and drag the model layer and move it from one point to another.

Right Click on Map

Right clicking will allow you to click and drag the map layer and move it from one point to another.

Middle Click on Map

Middle clicking will allow you to click and drag the model and map layer and move it from one point to
another.

Save

Click Save to perform the final translation and save it to a new file.

4.4.3.7 Custom Trace Dialogue

Description

This dialogue lets you specify options when doing a custom trace on the DESS map. It is accessed
from the Editing tab. You must select one or more nodes or lines before choosing a trace.

If you select more than one node they must be related so that one of the nodes is downstream of all
others or upstream of all others. You will then be able to trace the nodes and lines between the
selected nodes. For example you could trace downstream from one of the selected nodes until you
came to the other selected nodes at which point the trace would stop.

Connectivity through closed loops can be ambiguous.

Appearance

Controls

Trace Direction
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Select whether to trace upstream or downstream (depends on nodes selected).

Select

Choose whether to select just nodes, just lines, or to select both nodes and lines (default).

Trace All Layers

Check to trace through different voltage layers. By default the trace stops at any power transformers
and doesn't continue onto other electrical layers.

Phasing

Select which phasing to trace. For example if you chose 'a', only the first phase would be traced. Any
single-phase lines with 'b' or 'c' phasing would not be selected.

4.4.3.8 Custom Query Dialogue

Description

This dialogue is used to select nodes or lines on the map according to the characteristics of the nodes,
lines or elements on nodes. This is a very powerful tool for selection and lets you identify specific types
of system data that you may be interested in. It is accessed from the Query menu on the Editing tab.

Appearance
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Controls

Select

Choose whether you want to select nodes or lines.

Select From

You can select items from either the entire system, the currently active layer (as shown on the
toolbar), or items which are already selected on the map. The last option lets you combine selections.
For example, you could use a downstream trace to select a feeder and then use this tool to select all
nodes containing a particular type of transformer on that feeder.

Properties To Match

This tree view is the heart of the custom selection ability. Starting with a node object (or line), you add
conditions which you want to specify. You do this by right-clicking on the tree item. This will bring up a
menu listing properties of the specified object, and in the case of nodes will show types of elements
which you want to exist on a node. Click on a menu item to add that condition by setting the property
in the Edit Property dialogue. The following examples give some ideas of what you can do with this
dialogue.

Select all single-phase lines longer than 100m in length:
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Select all 50kVA underground transformers:

Select nodes that have a residential loads with a 3-phase transformer:

Add Delete Edit

The add button brings up the pop-up menu as shown (same as right-clicking on an item in the tree).
The Edit and Delete buttons let you edit or delete an existing selected item. Properties for the item are
shown in the Edit Property dialogue.

Select

Close the dialogue and perform the specified selection. Once you have selected the nodes or lines you
can view a list of selected items on the Select docking window.

4.4.3.8.1  Edit Property Dialogue

Description

This dialogue lets you specify a condition relating to the properties for a DESS object such as a node,
line, element or reference data item. It is accessed by adding or editing a property on the Custom
Query dialogue.
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Appearance

Controls

Property Name

The name of the property you are setting a condition for.

Text Property Controls

For text items the test condition can be one of:

Contains Text (Case Sensitive) - property value must contain exact text value
Contains Text (Case Insensitive) - property must contain value but capitalization is ignored
Does Not Contain Text (Case Insensitive) - property must not contain specified text (capitalization
ignored)

List Property Controls

Some properties have a fixed range of values (such as phasing or conductor material type). For these
items the property condition can be either:

Equal To - You can select one or more items from the list. The value must equal one of these.
Not Equal To - You can select one or more items from the list. The value must not equal one of
these.

Boolean Property Controls
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For boolean type properties, you can select whether the value for the object should be True of False.

Numeric Property Controls

If the object property is numeric, you can set a condition which compares the property value to the
specified value in a number of ways:

Equal To - Object property value must exactly equal the specified value.
Not Equal To - Property value not not equal specified value.
Greater Than - Property value must be greater than the specified value.
Less Than - Property value must be less than the specified value.
Greater Than or Equal To - Property value must be greater than or equal to specified value.
Less Than or Equal To - Property value must be less than or equal to specified value.

 

4.4.3.9 Query Property Dialogue

Description

This dialogue lets you query or change a group of objects for a particular property. Typical uses
include:

query a group of lines to find the total conductor length

modify the load unit for a group of LoadSet objects

 

Warning:
Be careful when using this to change values. Not only can you not undo the changes which
are made, but those changes can be very bad for your system. It is suggested that you have
a backup before changing a large amount of values.

 

This dialogue is accessed from the Query > Query Property command on the Editing tab. Typical
output for a query is shown below. Please note that if you are modifying a set of property values, the
operation cannot be Undone.
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Appearance

Controls

Items to Query or Edit

Select whether to query/edit all items or just items associated with currently selected nodes and/or
lines.
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Object Type

The type of object to query or edit. Choose the type of object you want to query a property of. If you
choose a type of reference data (like 'Conductor' or 'Transformer Reference', the objects included in
the query will be those associated with the nodes or lines selected in Items to Query.

Object Property

The property to edit or query. Only simple properties (text, numbers, lists) can be edited. You cannot
edit properties which are objects.

Operation

What operation to perform. The options are as follows:

Query - query existing values. For numerical values this will provide the max, min, average and sum.
For other types of property, it will give you a list of values used and the number of times each is used.

Set New Value - Edit the property value by settings a new value.

Multiply Current Value - Multiply the existing value by a specified value. E.g multiply line lengths by
1.1 to increase line lengths by 10%. This option only applies to numerical properties.

Add to Current Value - Add a fixed value to the existing property values. E.g. add .01 to all
transformer impedances. This option only applies to numerical properties.

Value

Where this property is being modified, this input holds either the new value, the multiple or the
addition value. This input does not appear for queries.

4.4.3.10 Show Loops Dialogue

Description

This dialogue shows you all of the loops currently in your system. Using this dialogue you can see
exactly what loops exist and what nodes and lines the loops are composed of.

Appearance
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Controls

Update Map View

This command toggles whether or not the map view will change to show you the optimum view of the
selected loop. If this is toggled on, when you click on any loop the map view will adjust so that the loop
is centered. All the lines and nodes which comprise the loop will be selected.

Show Loops

This command closes the window and selects all of the nodes and lines of all the current loops in the
system. This also resizes your map view so that you can see all of the loops in the system at once.

 

Hint:
Note that the list constantly refreshes itself, and you can change nodes and lines on the
map view while this dialogue is open.

4.4.3.11 Import GIS Dialogue

Description
This tool will allow you to import data from an ESRI database into the model. This can be very useful for
building new models from existing GIS connectivity.

You can use this tool by opening the Import ESRI GIS command from Modules in the Editing tab.
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Appearance

Controls

Database path

This will open a browse window which will allow you to choose a database to import.

Dump Connectivity to File

The will create an export file of the connectivity from the database.

Lookup File Path

This will open a browse window which will allow you to choose a lookup file. The lookup file will
determine how data in the database is interpreted. For help, please contact Essex Energy.

OK

OK will begin the import. Note that this may take some time depending on the size of the database.

4.4.3.12 Switching Order Dialogue

Description
This tool will allow you to view the impacts and changes from changing switch positions. This can be very
useful for contingency planning, creating forms, and switching during an outage. The first switch can
either be a currently selected switch or chosen from a list.

You can use this tool by opening the Switching Order command from Modules in the Editing tab.

Appearance
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Controls

From List

This will open new dialogue which will allow you to filter and search for a switch.

Close/Open Switch

This button will close or open the currently selected switch. It will be logged in the Switch Change
Summary box, with all of its impacts.

Grey Out Single Phase

This will grey out single phase impacts.

Undo Last Change

This will remove the last switching operation from the Switch Change Summary.

Accept Switching

This will implement the switching changes in the current model.

Print Form

You can choose either a PC17A or PC17B form which will be automatically filled in with all of the
information from the switching changes and print it for reference.

4.4.3.12.1  Sw itching Order From List Dialogue

Description

This dialogue lets you filter and select a specific switch for operation. It is accessed by clicking From List
on the Switching Order Dialogue.

Appearance
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Controls

Show Switches Related to Last Operation

The switches in the list will be filtered to ones which are upstream or downstream from the last operated
switch which can either restore disconnected nodes or break a created loop.

Closed or Open Switches

Dictates whether switches in the list should be normally open or normally closed.

Voltage

Allows you to select the voltage layer a switch must be on to be filtered in the list.

Feeder

Selects switches only on the specified feeder. Note that the Set Feeder Names command must be run
before this filter will work.

Switch Type
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Allows you to filter by type of switch, if set up in the model.

Only Show 3-Phase Switches

Clicking this check-box will eliminate all single phase switches from the list.

Filter

Allows you to enter part or all of a switch name to shrink the returned list of switches.

Switch Selection

After finding a switch to operate, click on its name and then click Done. The switch will be opened in the
Switching Order Dialogue as the next switch to operate.

4.4.4 Analysis Dialogs

The following dialogs are associated with various analysis, loads and references in DESS which are on
the Analysis Tab:

Analysis Dialogues

Arc Flash dialogue

Capacitor Optimization dialogue

Load Flow dialogue

Load Loss dialogue

General Short Circuit dialogue

Motor Starting dialogue

Open Point Optimization dialogue

Phase Balancing dialogue

Protection Coordination dialogue

SCADA Load Flow dialogue

Specific Short Circuit dialogue

Reports Dialogues

Meter Data dialogue

Views Dialogues

Node Style dialogue

Line Style dialogue

Label Style dialogue
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Loads Dialogues:

Import Loads dialogue

Create Loads dialogue

Load Scaling dialogue

SCADA Measurement Data dialogue

Data Dialogues:

Simplify Data dialogue

Reset Line Properties dialogue

Copy Substation Info dialogue

Copy Conductor Info dialogue

Create Node Data dialogue

Reference Dialogues:

Change References dialogue

Create References dialogue

Import References dialogue

Organize References dialogue

Results

Save Result dialogue

4.4.4.1 Arc Flash Dialogue

Description
This tool calculates the arc flash hazard for a specific node or nodes in the system.

You can use this tool by selecting the group of connected nodes and lines you want to update or simply
opening the Arc Flash command from More in the Analysis tab.

Appearance
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Controls

Get Data from Current System

This allows you to choose which node(s) you would like to perform analysis on. It launches the Get
Protection Data dialogue.

All text boxes and information will be automatically entered from the system if a node is chosen through
the Get Protection Data dialogue. You may change any values, or enter everything manually if you choose.

Empirical/Theoretical

Choosing either empirical or theoretical will decide which equations and parameters are used. For more
information see IEEE 1584.
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Calculate

Click calculate to perform the analysis.

4.4.4.1.1  Get Protection Data Dialogue

Description
This tool calculates the data for an arc flash hazard calculation for a specific node or nodes in the system.

You can use this tool by selecting Get Data in the Arc Flash Dialogue.

Appearance

Controls

Choose

Choose loads the Find Asset window. It will allow you to search and find whichever node you wish to
analyze.

Remove

Removes selected nodes from the analysis list.

Get Data for Nodes

This will run a short circuit analysis and gather protection data for all listed nodes.
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Save Data

Save data will return all data for all nodes to the Arc Flash dialogue.

4.4.4.2 Capacitor Optimization Dialogue

Description
This tool calculates the optimal size and placement for capacitor banks in the system.

You can use this tool by opening the Capacitor Optimization command from More in the Analysis tab.

Appearance

Controls

Bank Size

This allows you to control how large the capacitor banks can be.

Maximum Number of Banks

This command will tell the program the maximum number of capacitor banks it can place throughout the
system.

Analysis Period

This will choose whether the capacitor banks should be placed for optimal performance year-round or for
a specific time frame. 
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Bank Location

Allows you to perform the capacitor analysis on either a selection or the full model.

4.4.4.3 Load Flow Dialogue

Description
This tool calculates the current and voltages in the system using the current configuration and loads.

You can use this tool by opening the Load Flow command in the Analysis tab.

Appearance

Controls

Full System/Selected Nodes

Allows you to perform the analysis on either a selection or the full model.

Hour

Determines the hour which the analysis will be performed at. This is important for the load elements, as
most won't have a constant loading profile.

Day

Determines the week type reference which the analysis will be performed at. This is important for the
load elements, as most won't have a constant loading profile.
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Season

Determines the season type reference which the analysis will be performed at. This is important for the
load elements, as most won't have a constant loading profile.

Scaling Factor

Determines the scaling factor applied to all loads in the system.

Next

Next will bring you to the Run Analysis window, where you may proceed with the analysis or choose back
to update a parameter.

4.4.4.4 Load Loss Dialogue

Description
You can use this tool by opening the Load Loss command from More in the Analysis tab.

Appearance

Controls

Full System/Selected Nodes

Allows you to perform the analysis on either a selection or the full model.

Hour
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Determines the hour which the analysis will be performed at. This is important for the load elements, as
most won't have a constant loading profile.

Day

Determines the week type reference which the analysis will be performed at. This is important for the
load elements, as most won't have a constant loading profile.

Season

Determines the season type reference which the analysis will be performed at. This is important for the
load elements, as most won't have a constant loading profile.

Scaling Factor

Determines the scaling factor applied to all loads in the system.

Next

Next will bring you to the Analysis Start Node window, where you may proceed with the analysis or
choose back to update a parameter.

Node

This chooses which node will be analyzed. Clicking the "..." button will launch the Find Asset window to
ease finding a specific asset for analysis. You must choose a node where a load could be added.

Next

Next will bring you to the Run Analysis window, where you may proceed with the analysis or choose back
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to update a parameter.

4.4.4.5 General Short Circuit Dialogue

Description
This tool calculates the fault currents and voltages in the system using the current configuration and
loads.

You can use this tool by opening the General Short Circuit command in the Analysis tab.

Appearance

Controls

Full System/Selected Nodes

Allows you to perform the analysis on either a selection or the full model.

Use IEC 60909 Options

Determines if the IEC correction factors will be used in the analysis.

Include motors and generators

Determines if motors and generators will be used in the minimum fault level analysis.

Next

Next will bring you to the Voltage Factors window, where you may proceed with the analysis or choose
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back to update a parameter.

Maximum and Minimum Voltage

Determines the maximum and minimum voltage for the analysis.

Next

Next will bring you to the Run Analysis window, where you may proceed with the analysis or choose back
to update a parameter.

4.4.4.6 Motor Starting Dialogue

Description
You can use this tool by opening the Motor Starting command from More in the Analysis tab.

Appearance
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Controls

Full System/Selected Nodes

Allows you to perform the analysis on either a selection or the full model.

Hour

Determines the hour which the analysis will be performed at. This is important for the load elements, as
most won't have a constant loading profile.

Day

Determines the week type reference which the analysis will be performed at. This is important for the
load elements, as most won't have a constant loading profile.

Season

Determines the season type reference which the analysis will be performed at. This is important for the
load elements, as most won't have a constant loading profile.

Scaling Factor

Determines the scaling factor applied to all loads in the system.

Next

Next will bring you to the Motor Starting Parameters window, where you may proceed with the analysis
or choose back to update a parameter.
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Select

Clicking on a check-box chooses which motors will be analyzed.

Next

Next will bring you to the Run Analysis window, where you may proceed with the analysis or choose back
to update a parameter.

4.4.4.7 Open Point Optimization Dialogue

Description
You can use this tool by opening the Open Point Optimization command from More in the Analysis tab.

Appearance
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Controls

Full System/Selected Nodes

Allows you to perform the analysis on either a selection or the full model.

Hour

Determines the hour which the analysis will be performed at. This is important for the load elements, as
most won't have a constant loading profile.

Day

Determines the week type reference which the analysis will be performed at. This is important for the
load elements, as most won't have a constant loading profile.

Season

Determines the season type reference which the analysis will be performed at. This is important for the
load elements, as most won't have a constant loading profile.

Scaling Factor

Determines the scaling factor applied to all loads in the system.

Next

Next will bring you to the Motor Starting Parameters window, where you may proceed with the analysis
or choose back to update a parameter.
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Hill Climbing/Simulated Annealing Algorithm

Clicking on a radio button will determine which kind of algorithm will be used to solve for the optimal
open point locations.

Only Use Existing Switch Locations

Checking off this box will prevent the algorithm from suggesting new switch locations.

Maximum Overload

This will determine the maximum loading the algorithm will place on a line or transformer.

Next

Next will bring you to the Fixed Switches window, where you may proceed with the analysis or choose
back to update a parameter.



SmartMap212

© 2019 Essex Energy

Select

Clicking on a check-box chooses which switches cannot be changed during the algorithm.

Next

Next will bring you to the Run Analysis window, where you may proceed with the analysis or choose back
to update a parameter.

4.4.4.8 Phase Balancing Dialogue

Description
You can use this tool by opening the Phase Balancing command from More in the Analysis tab.

Appearance
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Controls

Full System/Selected Nodes

Allows you to perform the analysis on either a selection or the full model.

Hour

Determines the hour which the analysis will be performed at. This is important for the load elements, as
most won't have a constant loading profile.

Day

Determines the week type reference which the analysis will be performed at. This is important for the
load elements, as most won't have a constant loading profile.

Season

Determines the season type reference which the analysis will be performed at. This is important for the
load elements, as most won't have a constant loading profile.

Scaling Factor

Determines the scaling factor applied to all loads in the system.

Next

Next will bring you to the Phase Balancing Parameters window, where you may proceed with the analysis
or choose back to update a parameter.
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Maximum Number of Changes

This limits the number of changes the algorithm is allowed to make to the model.

Full System/Selected Nodes

Allows you to perform the analysis on either a selection or the full model.

Allow Open Point Cross Phasing

Allows the algorithm to have two different phases on each side of an open switch.

Next

Next will bring you to the Run Analysis window, where you may proceed with the analysis or choose back
to update a parameter.

4.4.4.9 Protection Coordination Dialogue

Description

This dialogue is used to view the protection coordination for a particular node in the system. All
devices on or upstream of the selected node are shown. This dialogue is accessed from the Analysis >
Protection Coordination command.

Appearance
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Mouse Usage

Move Mouse

As you move the mouse, the coordinates of the mouse location on the graph will be shown on the
status bar. If you have selected a device curve (see Click), the coordinates of the edge of the selected
curve will be shown. 

Click

Click on a curve to select it (and see the coordinates of the curve edge).

Double-Click
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Double-click on a curve to edit the properties of the device associated with that curve.

Menu Commands

Save Image

This lets you save the current graph to a graphics file. Formats include PNG, JPG, BMP, TIFF, and GIF.

Edit

Opens the edit properties of the device associated with that curve.

Drop-downs

The dropdowns choose which reclosure curves to show on the graph.

Scale

Opens a dialogue which allows you to control the time and current axis scales.

Currents

Allows you to add a current range colour box to visually define the protection coordination current
limits.

4.4.4.10 SCADA Load Flow Dialogue

Description
You can use this tool by opening the SCADA Load Flow command from More in the Analysis tab.

Appearance

4.4.4.11 Specific Short Circuit Dialogue

Description
This tool calculates the fault currents and voltages in the system using the current configuration and
loads.

You can use this tool by opening the Specific Short Circuit command from More in the Analysis tab.

Appearance
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Controls

Full System/Selected Nodes

In specific short circuit, you must perform the analysis on a selected node. The node can either be
selected before the analysis starts, or selected later.

Use IEC 60909 Options

Determines if the IEC correction factors will be used in the analysis.

Include motors and generators

Determines if motors and generators will be used in the minimum fault level analysis.

Next

Next will bring you to the Single Fault Analysis window, where you may proceed with the analysis or
choose back to update a parameter.
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Node

Determines the node selected for the analysis. If a node was selected before the analysis began, its
details will be automatically filled in. If a different node should be selected, click the "..." button to bring
up the Find Asset window.

Type of Fault

Determines what type of fault is being analyzed, options will depend on whether the node selected is
single or three phase.

Fault Phasing

Determines the phase of the fault. If the node selected is a single phase, it will automatically be defaulted
to that phase.

Resistance

Determines the resistance of the fault, with 0 being a bolted fault.

Next

Next will bring you to the Run Analysis window, where you may proceed with the analysis or choose back
to update a parameter.
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4.4.4.12 Meter Data Dialogue

Description
This tool gives all relevant data about meters in the system.

You can use this tool by opening the Meter Data Report command in the Analysis tab.

Appearance

Controls

Columns

This allows you to control which columns are shown in the report. Choose by selecting or deselecting the
check-box.

Filter

Clicking the funnel icon in the column headers will bring up a drop-down which will allow you to filter any
column by an criteria.

Export to CSV

This will export the current report contents to a CSV file. 

4.4.4.13 Node Style Dialogue

Description

This dialogue lets you specify the appearance of nodes in the default theme (the appearance when no
results or other custom themes are being displayed). Using the dialogue, you can set a series of rules
defining a particular type of node and the associated appearance. It is accessed from the Settings
menu in the Analysis tab.



SmartMap220

© 2019 Essex Energy

Appearance

Controls

Node Style Rules

The currently defined set of node rules. The details of a rule is shown at right in the Properties Tree.

Up Down

Use the Up and Down buttons to change the order of the rules. When a theme is evaluated for a
specific node, the first matching rule will be selected and all others will be ignored. For this reason,
more specific rules (e.g. 50kVA Distribution Transformer) should be higher up in the list than more
general rules (e.g. Distribution Transformer).

Add Delete

Use the Add button to add new empty rules, and the Delete button to remove unwanted rules.

Properties Tree

This tree view is the heart of the custom rule ability. Starting with a node object, you add conditions
which you want to specify. You do this by right-clicking on the tree item. This will bring up a menu
listing properties of the specified object, and in the case of nodes will show types of elements which
you want to exist on a node. Click on a menu item to add that condition by setting the property in the 
Edit Property dialogue

Add Delete Edit
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The add button brings up the pop-up menu as shown (same as right-clicking on an item in the tree).
The Edit and Delete buttons let you edit or delete an existing selected item. Properties for the item are
shown in the Edit Property dialogue.

Style

The Change... button brings up the following Point Style dialogue where you can set the actual
appearance of a specific rule.

Font Name

The name of the font containing the symbol you want to use. DESS comes with a font called DESSSym
that contains a number of common distribution system symbols. You can also use standard symbol
fonts such as Symbols and Wingdings, or any other font installed on your machine. All of the default
symbols shown are in the font provided; DESSSym.

Symbol

Pick the specific symbol you want from the set provided by the font.

Size

The size of the font in points.

Color

The color of the font. You can only use single-color symbols in DESS.

Sample Style

This box shows the currently selected style as it will appear on the map in DESS.

4.4.4.14 Line Style Dialogue

Description

This dialogue lets you specify the appearance of lines in the default theme (the appearance when no
results or other custom themes are being displayed). Using the dialogue, you can set a series of rules
defining the characteristics of a particular type of line and the associated appearance. It is accessed
from the Themes menu.

Appearance
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Controls

Line Style Rules

The currently defined set of line rules. The details of the rule characteristics is shown at right in the
Properties Tree.

Up Down

Use the Up and Down buttons to change the order of the rules. When a theme is evaluated for a
specific line, the first matching rule will be selected and all others will be ignored. For this reason,
more specific rules (e.g. 27kV Single Phase Underground Line) should be higher up in the list than
more general rules (e.g. Single Phase Line).

Add Delete

Use the Add button to add new empty rules, and the Delete button to remove unwanted rules.

Properties Tree

This tree view is the heart of the custom rule ability. Starting with a line object, you add conditions
which you want to specify. You do this by right-clicking on the tree item. This will bring up a menu
listing properties of the specified object. Click on a menu item to add that condition by setting the
property in the Edit Property dialogue

Add Delete Edit

The Add button brings up the pop-up menu as shown (same as right-clicking on an item in the tree).
The Edit and Delete buttons let you edit or delete an existing selected item. Properties for the item
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are shown in the Edit Property dialogue.

Style

The Change... button brings up the following Line Style dialogue where you can set the actual
appearance of a  line for a specific rule.

Style

The style of the line (e.g. solid, dashed, dotted, etc).

Width

The width of the line in pixels.

Color

The color of the line. Lines can only have a single color.

Sample Style

The line style as it will appear on the DESS map.

4.4.4.15 Label Style Dialogue

Description

This dialogue lets you specify the appearance of labels in the default theme (the appearance when no
results or other custom themes are being displayed). Using the dialogue, you can set a series of rules
defining the characteristics of a particular type of label and its associated appearance. It is accessed
from the Themes menu.

Appearance
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Controls

Label Style Rules

The currently defined set of label rules. The details of the rule characteristics is shown at right in the
Properties Tree.

Up & Down

Use the Up and Down buttons to change the order of the rules. When a theme is evaluated for a
specific line, the first matching rule will be selected and all others will be ignored. For this reason,
more specific rules (e.g. 27kV Single Phase Underground Line) should be higher up in the list than
more general rules (e.g. DESS node).

Add & Delete

Use the Add button to add new empty rules, and the Delete button to remove unwanted rules.

Properties Tree

This tree view is the heart of the custom rule ability. Starting with a line object, you add conditions
which you want to specify. You do this by right-clicking on the tree item. This will bring up a menu
listing properties of the specified object. Click on a menu item to add that condition by setting the
property in the Edit Property dialogue

Add & Delete & Edit



Reference Guide 225

© 2019 Essex Energy

The Add button brings up the pop-up menu as shown (same as right-clicking on an item in the tree).
The Edit and Delete buttons let you edit or delete an existing selected item. Properties for the item
are shown in the Edit Property dialogue.

Label Text

This contains the rules for the appearance of a particular label.

Left List Box

This box contains the list of all possible labels to add to a particular style. There is no restriction to
how many of these you can add. Note that 'New Line' is not an actual label, but is used for formatting.

Right List Box

This box contains all of the labels that are currently added to the currently selected style.

Sample

This shows an example of how all of the labels will appear on the map view. This uses the titles of
each label as opposed to sample text however.

Left and Right Arrows

These arrows direct the addition and removal of labels. left arrow removes the label selected on the
right, while the right arrow adds the label selected on the left.

4.4.4.16 Import Load Dialogue

Description

This dialogue is used to define how to import load element data from an external database or tabular
data file by defining the meaning of each column in the import data you can determine how the data
will be imported. This dialogue is accessed from Analysis > Loads > Import Load. Loads can be
imported from the following types of data: MS Access database, MS Excel spreadsheet, comma
separated value (CSV) text file, and DBase IV database file.

Appearance
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Controls

Load Data Fields

This list is the heart of the load import configuration process.

The Field column shows all fields in the database or file being imported.

The Data Type column shows what type of data the field contains. Initially all fields will be set to
None

the Details column shows details of the match for the particular field.

Data Type

When a row of the Load Data Fields is selected, use this control to specify the contents of the import
field. The possible choices are:
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None - the field does not contain any data relevant to load import

Link - the field is used to link a row of the load import data to a specific node in DESS. You can link by
node ID, name or description. Linking the external data to a matching node Name is the most common
way to match data. You must define exactly one field as a Link field.

Load - the field contains actual load data. For a load field you must define the period which the load
represents. For example you may have four fields which each represent a season or there may be a
single field containing load data representing the entire year. You must define one or more Load fields.

Unit - the field contains values which define different load units for different rows of data. For
example, if you have data which defines some loads as kWh and others as kVA peak, then you can
specify which field defines the unit, and specify how the different values match up with the load units
in DESS. You can define zero or one fields of this type. If you do not define a Unit field, all imported
loads will use the Default Load Unit. If you do define a Unit field, the Default Load Unit will not be
used and will be grayed out.

Category - the field contains values which define different load categories for different rows of data.
For example, the import data may contain a field which contains information for customer types or
industry codes. These can be mapped to load categories defined in DESS. You can define zero or one
fields of this type. If you do not define a Category field, all imported loads will use the Default Load
Category. If you do define a Category field, the Default Load Category will not be used and will be
grayed out.

Existing Loads

This section defines how existing system loads are treated. You can do one of the following:

Delete all loads in system - All loads throughout the system will be removed prior to importing new
loads, even if no new loads will be created during import.

Delete existing load data on nodes where new data is imported - A list of nodes where load data will
be imported is created, and all loads on these nodes is deleted prior to import. Other nodes are not
affected.

Keep all existing system load data - No load elements are deleted prior to import. New loads will be
added to nodes in addition to any existing load elements.

Default Load Unit

This defines the unit of loads to be imported. If you have defined one of the import fields as a Unit field
then this value is not used.

Default Load Category

This defines the category of loads to be imported. If you have defined one of the import fields as a
Category field then this value is not used.

OK

When you click OK the load data will be imported. In some cases there may be mismatches between
the import data and system loads. After the import you will be prompted to display a report for the
import, which will show in detail the following conditions:

- Loads in the import data for which no matching system node could be found.

- Loads that could not be added to a node because the load would conflict with other elements (such
as switches or generators, etc) on the node.
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- Nodes that contain distribution transformers or had loads prior to the import for which no new load
was imported.

4.4.4.17 Create Loads Dialogue

Description

This tool is used to create loads on nodes where there are already distribution transformer elements.
The new loads will be based on the size and phasing of the distribution transformer. You have the
option of deleting any existing loads and you can choose which seasons to create the new loads for.
This dialogue is accessed from Analysis > Loads > Create Loads menu.

After creating loads using this tool you may need to do further scaling of load values. You can use the 
Load Scaling tool to do this.

This tool can be successfully used in conjunction with the Import Load dialogue for situations where
imported data has omissions. First use the Import Load dialogue to import kWh data where known. If
there are still transformers that have no load assigned, use this tool to create default loads for these
situations. It's helpful to use a new load category (e.g. 'Unknown Category') for these cases so they
can be scaled independently using the Load Scaling dialogue.

Appearance
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Controls

Statistics

The top section describes how many nodes are currently selected in DESS, and of these, how many
nodes contain distribution transformer elements, and of the transformers, how many do not have any
associated loads. Loads will only be created on nodes that already have transformers.

Delete existing loads

If there are already existing load elements on the nodes you have selected containing transformers,
then you have the option of deleting these loads. If you choose not to delete the loads, new load
elements will be added in addition to the existing loads.

Create new loads on
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You can choose to create new loads on all selected transformers, or only those that do not already
have have loads on the same node.

Load Category

Choose the category for the new loads. All new loads will use this category

Initial Load %

Choose the size of the new load relative to the nominal transformer size. All new loads will be created
with this value for peak kVA. Note that you can use the Load Scaling tool subsequently to modify the
initial value.

Seasons

Check the seasons for which you want load sets to be created in the load element data. Typically the
new load should cover a complete year. In the example above you would choose either Year by itself,
or check the four seasonal items and leave Year unchecked.

4.4.4.18 Load Scaling Dialogue

Description

This tool lets you change the magnitude of the load on a group of selected nodes. To use it, first select
all nodes you want to scale (using any of the selection tools), then choose Analysis > Loads > Load
Scaling. A dialogue will be displayed which will guide you through the steps of determining which loads
to scale and how to scale them.

Appearance
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Choose Loads Step

Selected Nodes

Choose this option to scale loads on only those nodes that are currently selected. The number of
selected nodes is shown in the description. If no nodes are currently selected this option is disabled
and you can only scale loads for the entire system.

Entire System

Choose this option to scale loads on the entire system.

 

 

Load Types Step

Scale Simple Loads

Check this option to scale any simple loads in the collection of nodes specified in the previous step.
The number of simple loads available to be scaled is shown.

Scale Detailed Loads

Check this option to scale any detailed loads in the collection of nodes specified in the previous step.
The number of detailed loads available to be scaled is shown.

Load Categories / All Categories

Choose which load categories you want to apply scaling to among the specified detailed loads. Only
those categories which are in use among the specified loads are shown in the list. To scale all loads
regardless of category, check the All Categories box below the list.

Load Seasons / All Seasons

Each load set in a detailed load element specifies a season for which that load applies. Choose which
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load seasons you want to apply scaling to among the specified detailed loads. Only those seasons
which are in use among the specified loads are shown in the list. To scale all loads regardless of
season, check the All Seasons box below the list.

  

Type of Scaling Step

Change Scaling Factor

Each load set in a detailed load element has a field for load scaling. This is a factor which can be used
to modify a load without actually changing the data for the load magnitude. This can be useful for
applying temporary load scaling. (for example, temporarily setting the scaling factor of a set of loads
to 0 effectively removes those loads from the system).

Change Load Values

This option lets you change the actual load magnitudes which are defined for a load. Once these are
changed it may not be easy or practical to reset them to their original values so this option should be
used with care.
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Set Scaling Factor Step

This step is only shown if Change Scaling Factor is chosen in the previous step.

Replace existing scaling factor

This lets you set the new factor. All affected loads will be set to the specified value regardless of their
current value.

Multiply existing scaling factor

This option takes the existing values for scaling factors and modifies then by multiplying by the
specified value. The Existing Values and New Values show the effects on the load scaling factors of
the loads to be scaled.

Value

This value is either the new value of the load scaling factor or the amount by which to multiply the load
scaling factor, depending on which option is chosen.
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Scale Load Values Step

This step is only shown if Change Load Values is selected in the Type of Scaling step, or for simple
loads which do not contain a scaling factor.

Multiply existing load values by

Use these three fields to specify how much to scale each phase of the existing loads by.
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Summary Step

The summary step shows the choices selected in each of the previous steps and the number of loads
which will be affected. Please confirm that you are scaling the desired loads by the desired amount as
you cannot Undo this operation.

4.4.4.19 Edit SCADA Measurement

Description

This dialogue is used to enter and edit measurement data which is used for the SCADA load flow
analysis. This consists of an XML file which contains a set of coincident SCADA measurement values.

You can create an manage multiple XML files which represent measurements taken under different
situations. For example, you could create different sets of data for measurements taken at different
times, or different sets for different system configurations.

Appearance
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Measurement Data Controls

Data File

Use this box to enter the path to the file containing the set of measurements you want to store. You
will be prompted for this file when you run a SCADA load flow. Use the "..." button to search for a file.
By default this file will be the last file where SCADA information was edited or for which a SCADA load
flow was run.

Load Data

After selecting a file name, click this button to load the values into the Measurement Data list.

Measurement Data

This list shows all the measurement items currently defined.

Add, Edit, Delete

Use these buttons to add, edit or delete items from the Measurement Data list. Adding or editing items
will bring up the Measurement Item dialogue as shown.

Clear All

Clear all defined data

Save Data

Use this button to save data before exiting the dialogue.

Done

Close the dialogue. If you have not yet saved any changes, you will be warned before leaving the
dialogue.
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Measurement Item Controls

Measurement Node

Choose the node ID for the system location where the measurement has been taken.

Selected Nodes

This button brings up a list of currently selected nodes. You can select a set of nodes (e.g. the
breakers at a substation) before editing your data. This list makes it faster to choose the nodes you
want.

Find Node

This brings up the standard Find Node dialogue, so you can search for nodes by ID, name, list or from
a map.

Units

Choose the measurement units. You can choose from Amps, kW and kVAr, kVA, or kW and power
factor.

A, B, C

Enter the actual measurement values at the selected location.

4.4.4.20 Change References Dialogue

Description

This tool lets you make group changes to all the reference data items associated with selected nodes
and/or lines. You can use it to do a number of common tasks like reconductoring a set of lines, or
changing the load categories for a group of selected nodes.

This tool is used by selecting a group of nodes and/or lines using any of the selection tools and then
choosing Analysis > References > Change References

Appearance
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Controls

Reference List

This list shows all possible types of reference data that you can change through this tool. Clicking on a
different type of data updates the other lists as described below.

Items Being Used, Replacement Items List

This list shows all reference data items of the selected type which were found in the currently selected
nodes and lines. If you select an item in this list and then choose an item from available items, the
Replacement Items part of the list is updated to show the change. You can select replacements for any
number of reference data items and for any type of reference data.

Available Items List

This list shows all reference data defined in the current DESS system of the specified type.

OK

When you click OK, the currently selected nodes and/or lines will be updated to reflect the replacement
choices you made in the center list. Due to the nature of these changes you cannot reverse this change
using the Undo command.
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4.4.4.21 Create References Dialogue

Description

This tool lets you make reference data items for overhead lines and transformers. 

This tool is used by selecting a group of nodes and/or lines using any of the selection tools and then
choosing Analysis > References > Change References

Appearance

Controls - Overhead Lines

Phase List

This list shows all possible phase combinations. Select the appropriate number of phases for the bundle.

Orientation

This list shows all position combinations for the cables. Selecting the Neutral Cable box will determine if
there is a neutral line in the bundle.

Cable Spacing
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This is the distance between each cable. In triangular orientation it is the distance between adjacent
vertices.

Height Above Ground

This determines the height from the ground to the lowest cable in the bundle.

Phasing Conductor

This list shows all reference data defined for cables. It will determine the conductor for the phase cables.

Neutral Conductor

This list shows all reference data defined for cables. It will determine the conductor for the neutral cable,
which can be different for reduced neutral returns.

3 Phase Voltage

Determines the three phase voltage of the reference list.

Add to List

This will add the current configuration to the list of references to be created.

Remove from List

This will remove the currently selected item from the list of references to be created.

OK

When you click OK, the list of references will be created.
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Controls - Transformers

Winding

This list shows all possible combinations. Select the appropriate combination for the transformer.

Mounting

This list shows all mounting types defined in the model. 

LV

This defines the low side three phase voltage for the transformer.

HV

This defines the high side three phase voltage for the transformer.

Size

This is the size of the transformer in kVA.

Add Item
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This will add the current configuration to the list of references to be created.

Remove Item

This will remove the currently selected item from the list of references to be created.

OK

When you click OK, the list of references will be created.

4.4.4.22 Import References Dialogue

Description

This tool lets you import reference data items (such as transformers, conductors, etc.) and node and
line styles from another system so you don't have to recreate this data in the current system. This tool
is available from Analysis > References > Import References menu. Use this dialogue by 1) selecting
the file you want to import from (either a standard file or a user-selected file) and then 2) choosing
the items you want to import.

Appearance
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Controls

DESS standard reference data files Radio Button

Select this radio button if you want to select data from the standard data files provided when you
install DESS. Typically these contain standard protection data.

Standard Files Drop Down List

If you have selected to import from the standard reference data files then you can choose the file
you want from this list.

User-selected system file Radio Button

Select this button if you want to import items from other DESS systems which can be located
anywhere on your computer. Following this selection click the Path Button to choose the file.

Path Button

Click on this button to bring up an Open File dialogue where you can select the file to import reference
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data items from.

Reference Data Item Tree View

Once you have selected a file, this tree shows a list of all reference data items contained in the file.
Click on items to place check marks next to the items you want to import into the current system.
Clicking on one of the root items (for a particular type of reference) will check all items of that type.

Import Items Button

Click this button to accept the selections and import the check data. Due to the nature of the changes
this operation cannot be reversed using Undo. Note that if you import an item which is identical to an
item already in your current system (same name) then you will be asked whether to skip it or whether
to create a duplicate with the same name, but with a new ID.

4.4.4.23 Organize References Dialogue

Description

This dialogue is used for organizing reference order. It is accessed from the Analysis tab, under
References > Organize References.

Appearance
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Controls

Reference Type

The type of reference which will be organized.

Sort

Sort gives you the option of having the program order the references for you. You can choose what
criteria to organize by, and then whether it should be ascending or descending. Sort fields are evaluated
in order, from first to fourth.
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Manually Changing the Order

To manually choose which order references should be in, select the reference you wish to move and then
use the up/down buttons to the right of the window.

Renumber

After changing the order of the references, they will keep their original reference IDs. To re-number the
references to reflect the new sort order click Renumber.

4.4.4.24 Simplify Data Dialogue

Description

This tool will remove excess points and lines from the model. 

This tool is used by choosing Analysis > Data > Simplify Data

Appearance
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Controls

Remove Empty Spurs

This will allow you to choose whether empty lines shorter than the defined length should be deleted from
the system.

Eliminate Transformer Spurs

This will allow you to choose whether a transformer may be moved to the next closest line if it is the only
element on a spur that would otherwise be eliminated.

Remove Extra Nodes

This will allow you to choose whether nodes which join two lines with identical phasing and conductors
can be eliminated. Note that if there is a bend or curve in the line at the eliminated node, the shape of
the line will be preserved.

Simplify Lines

This will allow you to choose whether line vertices should be removed from the system if the vertices are
closer than 1m.

OK

When you click OK, the selected actions will be carried out. Note that this cannot be undone using the
UNDO command.
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4.4.4.25 Set Line Properties Dialogue

Description

This tool will allow you to update defined conductor types to match adjacent lines. 

This tool is used by choosing Analysis > Data > Reset Line Properties.

Appearance

Controls

Line Types to Change

This list will show all line types in the system or from the selected line items. Choosing a line type will
determine which type of line will change.

Properties to Update

This will allow you to choose whether the conductor type, phasing, or both should be changed in the .

Restrictions

This will allow you to choose the extent of the updates, whether on the complete system or on a
selection. It will also allow you to determine the maximum length of conductor to be updated.
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OK

When you click OK, the lines which meet the criteria will be updated to match adjacent lines. Note that
this cannot be undone using the UNDO command.

4.4.4.26 Copy Source and Power Transformer Info Dialogue

Description

This tool will allow you to copy source and power transformer data from another model. 

This tool is used by choosing Analysis > Data > Copy Substation Info.

Appearance

Controls

Data File

Use this box to enter the path to the file containing the source and power transformer data you want to
copy. Use the "..." button to search for a file. 

Copy

This will allow you to choose whether sources, power transformers, or both will be copied from the
selected file into the current model. 

OK

When you click OK, the data selected will be copied and matched into the current model. Note that this
cannot be undone using the UNDO command.

4.4.4.27 Copy Conductor Data from Similar System Info Dialogue

Description

This tool will allow you to copy conductor data from another model for currently selected lines. 

This tool is used by choosing Analysis > Data > Copy Conductor Info.
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Appearance

Controls

Data File

Use this box to enter the path to the file containing the conductor data you want to copy. Use the "..."
button to search for a file. 

Copy

This will allow you to choose whether type of conductor, phasing, or both will be copied from the selected
file to the currently selected lines in the open model. 

OK

When you click OK, the data selected will be copied and matched into the current model. Note that this
cannot be undone using the UNDO command.

4.4.4.28 Create Node Data Dialogue

Description

This tool will allow you to create node data in the current model using an external database. The external
database must be in Access, Excel, CSV, or DBase IV format.

This tool is used by choosing Analysis > Data > Create Node Data.

Appearance
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Controls

Data File

Use this box to enter the path to the file containing the node data you want to copy. Use the "..." button to
search for a file. 

Choose Table

This will allow you to choose which data table you would like to create node data from. 

OK

When you click OK, the data table selected will be copied and matched into the current model. Note that
this cannot be undone using the UNDO command.

4.4.4.29 Save Result Dialogue

Description

This dialogue helps you specify the specific data and format for outputting the results of an analysis. It
is accessed from Analysis > Save Result.

Appearance
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Controls

Choose Export Format

You can choose to export the results data in a number of formats:

XML data - XML is a structured text format which is often used for interchange between different
types of software or web applications.

Comma Separated Text (CSV) - this is a text format where fields are separated by commas. This
format can be imported into most databases and some spreadsheets.

Tab Separated Text - this is a text format where fields are separated by TAB values. This format is
good for importing into spreadsheets such as MS Excel, either by file or by pasting from the Clipboard.

HTML Web Page - this format outputs the data as an HTML table which can be viewed using a
standard web browser.

Here are some common situations and suggested methods for saving:

Open in a database - save the result data to a CSV file and then import into the database

Open in a spreadsheet - copy the data to the clipboard as Tab Separated Text and paste into
spreadsheet

View - save as an HTML file and drag and drop onto your web browser

Choose Export Data

You must choose which data to export. Every type of analysis will produce different sets of data. See
the details for the individual analyses for more details.
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Save to File

Save the exported data to a file. You will be prompted for the file name when you click the OK button.

Copy to Clipboard

The data will be copied to the Windows Clipboard. You can then Paste the data into another
application. Different applications require information to be copied to the clipboard in different formats
so you may have to experiment with the different formats to find which works for your specific needs.

All / Currently Selected

If the data you are saving includes is for node or line data you can choose to save a subset of the
result data defined by the currently selected nodes or lines. This lets you only export data for a specific
area (e.g. a feeder or subdivision). These options are disabled for other types of data (not nodes or
lines)

4.4.5 Other Dialogues

Details for entering data and setting properties for a number of general dialogs in DESS is available as
follows:

Globe Dialogues

Options dialogue

File Dialogues

System Properties dialogue
Set View dialogue
Save Map dialogue

Docking Window Dialogues

Electrical Layer dialogue
Background Layer dialogue
Node Visibility dialogue

Miscellaneous Dialogues
Node dialogue
Line dialogue

4.4.5.1 Options Dialogue

Description

This dialogue lets the user set options for using DESS. These options are not specific to a particular
system or set of data. This dialogue is accessed from the Globe > Options menu.

Appearance
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Controls

Option Page Tree

The tree view shows all the different option pages for DESS arranged according to function. Click on a
page to show the specific options you can set on the right side of the dialogue. Headings that don't
have associated settings are shown in gray.

Set To Default

Set the options shown on the current options page back to their default values.

Options

The right side of the dialogue shows a specific set of options. The specific controls will vary according
to the type of options being set.

4.4.5.2 System Properties Dialogue

Description

This dialogue is used for editing basic system properties and viewing statistics for the system. Use the 
File > System Properties command to access it.

Appearance
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Controls

Phasing Labels

The phasing labels determine how the 3 different phases in a 3-phase system are displayed
throughout DESS. For example, many utilities call the phases rwb (for red, white, blue), or ryb (for
red, yellow, blue).

Map coordinates

The map coordinate determines how to interpret map coordinates used in DESS electrical layers and
in background maps. Most coordinate systems use either latitude, longitude or a normalized X,Y grid
using either Meters, Feet or Yards are units. For example, if your maps use UTM NAD 27 (Universal
Transverse Mercator, North American Datum 1927), then you are using a normalized X,Y grid
measured in meters.

The map coordinate is not used to set the display unit for distances in DESS. It is only used to interpret
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the data.

Statistics

The statistics pane of the System Properties show the number of items of each type in the electrical
system. It includes all electrical layers. The Physical Size displays the maximum extent of the electrical
layers (not the background layers).

4.4.5.3 Set View Dialogue

Description

This dialogue lets you reset the map view to a specific center point and zoom. You can also use the
other navigation tools, such as Zoom In, Zoom Out, Drag and scrolling with the mouse wheel to do
this. This dialogue is accessed from File > View > Set View.

Appearance

Controls

X

The x position (horizontal position or longitude) of the location you want to center the map on.

Y

The y position (vertical position or latitude) of the location you want to center the map on.

Zoom Width

The width of the map section you want to display in the map window. This will be in units of map
width as set in the System Properties dialogue.

4.4.5.4 Save Map Dialogue

Description
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This dialogue is used to save a picture of the map to a graphics file. You can control which part of the
map is output, along with the size and format of the output file. It is accessed from the File > Export >
Save Map to File command. The map can be saved in JPG, GIF, PNG, BMP and TIFF formats.

Appearance

Controls

Coordinates of Map

By default the four coordinates display the current map view. However, you can modify these if you
want to output a specific part of the map (e.g. if you want to create a series of map 'tiles').

Output File Size

You can determine the size of the output file. Note that the aspect ratio of the output is determined by
the selected coordinates, so changing the width of the output will automatically change the height, and
vice versa.

Note that symbols and line sizes are shown in constant pixel sizes. This means that the relative size of
symbols will be smaller on large output sizes, and symbols will be relatively larger (and more
crowded) on small output sizes.

Show Preview

This fills the preview window so you can confirm the shape and location of the output.

Save...

Click this button to choose the type and name of the output graphics file. Options include PNG, JPG,
GIF, TIFF and BMP file formats. PNG is a good choice for screen output because it produces a small
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size of file but is not lossy.

4.4.5.5 Electrical Layer Properties Dialogue

Description

This dialogue is used for editing electrical layer properties. To access this dialogue open the layer
docking window and double-click on the layer you want to modify, or right click on the layer you want
and click Edit Layer Properties.

Appearance

Controls

ID

The ID of the layer. Automatically assigned.

Layer Type

The configuration of the network for this layer. Options are:

Three Wire System - Represents a true 3-wire configuration with no neutral conductor and no
grounding except at substations. Loads are typically applied phase-phase on this type of network.
Four Wire System - Represents an electrical configuration with 3 phase conductors plus a neutral
conductor, or a configuration with 3 phase conductors plus multi-point grounding.

Nominal Voltage

The nominal or name-plate voltage level of this layer. The actual supply voltage is set by the source
element.

Visibility

There are three settings for the visibility:

On - layer is always visible
Off - layer is never visible
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Zoom - layer is visible when the map zoom is within the desired range. This is sometimes called a
de-clutter feature.

Choose Off or Zoom to prevent the display of layers you are not currently interested in viewing.

Minimum Zoom

The minimum width of the map display (in meters) at which you want the map to be displayed.
Typically set to 0 so that the layer is always displayed when zoomed in closely. Visibility must be set to
Zoom to use this setting.

Maximum Zoom

The maximum width of the map display (in meters) at which you want the map to be displayed.
Typically set to a fraction of the entire system width so that the layer is not displayed when zoomed
out to display everything.

Selectable

Check this box if you want to be able to select items on this layer with the mouse. It is turned on by
default for electrical layers.

Transparency

You can choose from a continuous range from solid to invisible. Setting non-critical layers to be
partially transparent can help make key information greatly stand out.

4.4.5.6 Background Layer Properties Dialogue

Description

This dialogue is used for editing background layer properties. To access this dialogue open the layer
docking window and double-click on the layer you want to modify, or right click on the layer you want
and click Edit Layer Properties.

Appearance

Controls
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Path

The path of the background layer map file. Click on the ... button to browse for the map file. You can
enter files in .TAB, .DXF, or .SHP format as background layers.

Visibility

There are three settings for the visibility:

On - layer is always visible
Off - layer is never visible
Zoom - layer is visible when the map zoom is within the desired range. This is sometimes called a
de-clutter feature.

Choose Off or Zoom to prevent the display of layers you are not currently interested in viewing.

Minimum Zoom

The minimum width of the map display (in meters) at which you want the map to be displayed.
Typically set to 0 so that the layer is always displayed when zoomed in closely. Visibility must be set to
Zoom to use this setting.

Maximum Zoom

The maximum width of the map display (in meters) at which you want the map to be displayed.
Typically set to a fraction of the entire system width so that the layer is not displayed when zoomed
out to display everything.

Selectable

Check this box if you want to be able to select items on this layer with the mouse. It is turned off by
default on background layers.

Transparency

You can choose from a continuous range from solid to invisible. Setting non-critical layers to be
partially transparent can help make other key information stand out.

4.4.5.6.1  Open Street Map Background Layer

This dialogue is used for editing updating Open Street Map properties. To access this dialogue open the
layer docking window and right click on Background Layers.

Appearance
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Controls

Use OpenStreetMap as Background

The check-box will enable the open street map background tiles.

Visibility

You can choose from a continuous range from solid to invisible. Setting non-critical layers to be partially
transparent can help make other key information stand out.

Maximum Visible Layer

The maximum width of the map display (in meters) at which you want the map to be displayed. Typically
set to a fraction of the entire system width so that the layer is not displayed when zoomed out to display
everything.

Begin/Cancel Download

Storing the background tiles greatly aids in map loading times. Downloading the tiles will ensure that the
map loads quickly as the program doesn't need to wait for a tile to download before showing it on the
map.

Clear Cache

While using Open Street Maps, if the tiles have not been downloaded, the program will store tiles it had
to fetch from the web service in a cache. It does this to prevent re-downloading the same things as well
as speed up loading the map by using local tiles rather than fetching tiles each time.
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4.4.5.7 Node Visibility Dialogue

Description

This dialogue lets you specify the visibility of specific nodes in the default theme (the appearance when
no results or other custom themes are being displayed). It is accessed from the Node Types menu in the 
Layer Docking Window.

Appearance

Controls

Node Style Rules

The currently defined set of node rules. The details of a rule is shown at right in the Properties Tree.
Note that to change the appearance of the node, you must update the node style rules.

Up Down

Use the Up and Down buttons to change the order of the rules. When a theme is evaluated for a specific
node, the first matching rule will be selected and all others will be ignored. In the above situation, if a
switch contains "el" in the name, it will be set to a different zoom level than other switches.

Add Delete

Use the Add button to add new empty rules, and the Delete button to remove unwanted rules.

Properties Tree

This tree view is the heart of the custom rule ability. Starting with a node object, you add conditions
which you want to specify. You do this by right-clicking on the tree item. This will bring up a menu listing
properties of the specified object, and in the case of nodes will show types of elements which you want
to exist on a node. Click on a menu item to add that condition by setting the property in the Edit Property
dialogue.

Add Delete Edit

The add button brings up the pop-up menu as shown (same as right-clicking on an item in the tree). The
Edit and Delete buttons let you edit or delete an existing selected item. Properties for the item are shown
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in the Edit Property dialogue.

Visibility

This will determine if the node will be always on, always off, or if it must be within a specific zoom level
to be viewed. The visibility setting (on, off or zoom) can be changed by right-clicking on the rule in the
docking window.

4.4.5.8 Node Dialogue

Description

This dialogue is used to edit data for nodes and is also used to add, edit and delete elements on a
node. You can access this dialogue by double-clicking on a node on the DESS map.

Appearance
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Controls

ID

The unique ID of the node. Automatically assigned.

Layer

The electrical layer this node is attached to. New nodes are automatically created on the active layer.

Name

A primary description of this node. This field is often used to identify the node from the element data it
contains (e.g. "TX456" if it contains a distribution transformer with this name, or "S81" if it contained a
switch with this designation).

Description

Secondary descriptive information about the node. Common uses for this include a street address, or
an external description of data this node was imported from (e.g. GIS point ID).

Attached Elements

This list shows which elements are attached to this node. Double-click on an item to edit it.

Add

Add a new element. Clicking this button brings up a menu showing all elements. Elements which
cannot be added to this node (because other conflicting types of element already exist on the node)
are grayed out.

Edit

Edits the element data for the currently selected element.

Delete

Deletes the currently selected element.

Connected Lines

Shows the lines attached to this node. This information can be helpful for diagnosing problems with
phasing where the connectivity may not be working as desired.

4.4.5.9 Line Dialogue

Description

This dialogue is used to edit data for a line branch connected between two nodes. You can access this
data by double-clicking on a line on the map or from the Node dialogue.

Appearance
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Controls

ID

The unique ID of the line. This is assigned automatically.

Node 1

The node at the start of the line.

Node 2

The node at the end of the line. The order of Node 1 and Node 2 are unimportant for connectivity.

Name

User assigned name of the branch if desired.

Phasing

The phasing of the line.

Conductor

The type of conductor for this section of line. Use the button to bring up the Find Conductor dialogue.
This makes it easier to find a specific type.

Length

The length of the line section. By default this is populated with the length as measured on the map.
You can override it if you are creating a schematic (non-geographically accurate) map, or if you want
to represent the extra length associated with lines that have a vertical component (i.e. up a pole).
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Area

The name of the distribution area which the line is a part of.

Owner

The owner of the line, especially useful if the upstream distributor's assets need to be modeled.
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